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ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 

TEMA l. ANALISIS DEL SISTEMA 

1.1 Antecedentes 

Es común, al hablar de la comunicación, señalar el vertlgmoso e im
presionante progreso logrado en las pocas décadas de su existencia. El 
contexto en el que se ha desarrollado el software está fuertemente ligado a 
las cuatro décadas de evolución de los sistemas informáticos. Un mejor 
rendimiento del hardware, un tamaño más pequeño y un costo más bajo, han 
dado lugar a sistemas informáticos más sofisticados. 

La figura 1 describe la evolución del software dentro del contexto de las 
áreas de aplicación de los sistemas basados en computadoras.Durante los 
primeros años el hardware (fig la} era de propósito general, por otra parte 
el software se diseñaba a medida para cada aplicación y tenía una 
distribución relativamente pequeña. 

La mayoría del software se desarrollaba y utilizaba por la misma persona u 
organización, debido a este entorno personalizado del software, el diseño 
era un proceso implícito, ejecutado en la cabeza de alguien y, la 
documentación no existía normalmente. 

Los pnmeros anos La segunda era 
• Onentacton por lotes • MultJ·usuarLo 
• Oistnbucton hmttada • Tiempo-real 
• Software a meé11da • Bases de datos 

• ProduccLon ae software 

La tercera era 
• S1!uemas atsmbutdos 
• "lntehgenc:a'' empouada 
• Hardware t.Je ba¡o coste 
• Jmp'acto en el consumL· 
dor 

La cuarta era 
• s,stemas upenos 
• Maqumas de lA 
• Arquitecturas paralelas 

e a) ( b) (e) ( d) 

~u/4u4J)))JIIIrffill,ll~>777777:""", 
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, 

La segunda era de la evolución de los sistemas de computadoras (fig lb) se 
extiende desde la mitad de la década de los 60 hasta finales de los 70. La 
multiprogramación, los sistemas multiusuarios, introdujeron nuevos concep
tos de interacción hombre-máquina.Las técnicas interactivas abrieron un 
nuevo mundo de aplicaciones, los sistemas podían reconocer, analizar y 
transformar datos de múltiples fuentes, controlando así los proceso Y 
produciendo salidas en milisegundos en vez de minutos. 
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TEMA l. ANALISIS DEL SISTEMA 

La tercera era (fig le) de la evolución de los sistemas de computadoras 
comenzó a mediados de los 70. El sistema distribuido (en este caso com
putadoras múltiples, cada una ejecutando funciones concurrentes y 
comunicándose con alguna otra) incremento notablemente la complejidad 
de los sistemas informáticos. 

Redes de área local y global, comunicaciones digitales de alto ancho de 
banda,la llegada y amplio uso de los microprocesadores y computadoras 
personales, supusieron una fuerte presión sobre los desarrolladores de 
software. 

La cuarta era (fig Id) en software de computadoras ha comenzando. Las 
técnicas de la cuarta generación para el desarrollo de software están cam
biando la forma en que algunos segmentos de la comunidad informática 
construye los programas de computadora. Los sistemas expertos y el 
software de inteligencia artificial se han trasladado finalmente del 
laboratorio a aplicaciones prácticas, en un amplio rango de problemas del 
mundo real. 

Es así como el software se ha convertido en el elemento clave de la 
evolución de los sistemas y productos informáticos. 

1.2 DEFINICION DE SISTEMAS Y CARACTERISTICAS. 

La palabra sistema es posiblemente el término más sobreutilizado y del que 
más se ha abusado en el léxico técnico. Hablamos de sistemas políticos y 
educativos, sistemas bancarios y de ferrocarril. La palabra no dice poco. 

Podemos definir un sistema como un conjunto u ordenación de elementos 
organizados para llevar a cabo algún método, procedimiento o control 
mediante el procesamiento de información. 

Dependiendo a la forma en la que se analizan los sistemas se tienen dos tipos 
de sistemas : 

-Abierto: En este, caso se deja al libre albedrío de la persona encargada. 

- Cerrado : Se delimitan fronteras a partir de las cuales se trabajará, de tal 
forma que aquello que se encuentre fuera de las fronteras no afectará al 
sistema. 

Conforme al comportamiento que presentan los sistemas se tiene la 
clasificación siguiente : 

- Determinístico: El comportamiento que presenta el sistema es siempre el 
mismo. 
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TEMA l. ANALISIS DEL SISTEMA 

- Equifinalidad : En este caso sea cual sea el estado inicial del s1scema 
siempre se llegará a un estado final único. 

- Homeostático : Para este caso los sistemas que se tienen siempre se están 
retroalimentando. 

- Teológico Este comportamiento se observa en todos los sistemas 
porque mantiene un proceso y persigue un objetivo. 

1.3 CICLOS DE VIDA 

Los procedimientos de la ingeniería del software son la cola que pega a los 
métodos y herramientas y facilita un desarrollo racional y oportuno del 
software de computadora. Los procedimientos definen la secuencia en la que 
se aplican los métodos, las entregas (documentos, informes, formas,etc.) 
que se requieren, los controles que ayudan a asegurar la calidad y coordinar 
los cambios y las guías que facilitan a los gestores del software establecer 
su desarrollo. 

El ciclo de vida es aquel que requiere un enfoque sistemático, secuencial, 
del desarrollo del software que comienza en el nivel del sistema y progresa 
a través de·sus diversas fases. 

Cada ciclo de vida tiene las fases siguientes : 

ANALISIS PRELIMINAR 

DEFINICION PLANIFICACION 

ANALISIS DE REQUERIMIENTOS 

ANALISIS DE ESPECIFICACION 1 " 

DESARROLLO DISEÑO ., ' .. ,., . 

CONSTRUCCION , 

CORRECTIVO 

MANTENIMIENTO ADAPTATIVO 

AUMENTATIVO 
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ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 
TEMA I. ANALISIS DEL SISTEMA 
LECTURA: FASES DEL CICLO DE VIDA. 
El proceso de desarrollo del software contiene tres fases genéricas 
independientemente del paradigma de ingenier1a elegido. Las tres 
fases, definición, desarrollo y mantenimiento, se encuentran en 
todos los desarrollos de software, independientemente del área de 
aplicación, tamaño del proyecto o complejidad. 
La fase de definición se enfoca sobre el qué. Esto es, durante la 
definición, el que desarrolla el software intenta identificar qué 
información ha de ser procesada, qué función y rendimie:1to se 
desea, qué ligaduras de diseño existen y qué criterlos de 
validación se necesitan para definir un sistema correcto. Por 
tanto, han de identificarse los requerimientos claves del sistema 
y del software. Aunque los métodos aplicados durante la fase de 
definición variarán dependiendo del paradigma ie ingenieria del 
software aplicado, de alguna forma se prodc;cirán tres pasos 
especificas: 
Análisis del_~is'tema. El análisis del sistema define el papel de 
cada elemento de un sistema informático, asignando finalmente el 
papel que jugará el software. 
Planificación del proyecto. Una vez que está asignado el ámbito del 
software, se asignan los recursos, se estiman los costes y se 
definen las tareas y planificación del trabajo. 
Análisis de requerimientos. El ámbito definido para el software de 
la dirección, pero antes de comenzar a trabajar, es necesario 
disponer de una información detallada del dominio de la información 
y de la función del software. 
La fase de desarrollo se enfoca sobre el cómo. Esto es, durante el 
desarrollo, el que desarrolla el software intenta descubrir cómo 
han de diseñarse las estructuras de datos y arquitectura del 
software, cómo han de implementarse los detalles procedimentales, 
cómo ha de trasladarse el diseño a un lenguaje de programación y 
cómo ha de realizarse la prueba. Los métodos aplicados durante la 
fase de desarrollo variarán dependiendo del paradigma de ingenieria 
del software aplicado. Sin embargo, de alguna forma se producirán 
tres pasos concretos: · 
Diseño del software. El diseño traslada los requerimientos del 
software a un conjunto de representaciones (algunas gráficas, otras 
tabulares o basadas en lenguajes) que describen la estructura de 
datos, arquitectura y procedimiento algor1tmico. 
Codificación. Las representaciones del diseño deben trasladarse a 
un lenguaje arti"ficial, que da como resultados unas instrucciones 
ejecutables por la computadora. El paso de la codificación ejecuta 
esta traslación. 
Prueba del software. Una vez que el software se ha implementado en 
una forma ejecutable por la máquina, debe ser probado para 
descubrir los defectos que puedan existir en la función, lógica e 
implementación. 
La fase de mantenimiento se enfoca sobre el cambio que va asociado 
con una, corrección de errores, adaptaciones requeridas por la 
evolución del entorno del software y modificaciones debidas a los 
cambios de los requerimientos del cliente para reforzar o aumentar 
el sistema. La fase de mantenimiento replica los pasos de las fases 



de definición ¡ desarrollo, pero er. el contexto del software 
existente. Durante la fase de manter. ~miento se encuentran tres 
tipos de cambios: 
Corrección. Incluso con las mejores accividades para garantizar la 
calidad, es probable que el cliente descubra defectos en el 
software. El mantenimiento correctivo cambia el software para 
corregir los defectos. 
Adaptación. Con el paso del tiempo es probable que cambie el 
entorno original (por ejemplo, CPU, sistema operativo, periféricos) 
para el cual se desarrolló el software. El mantenimiento adaptativo 
se traduce en modificación del software para acomodarlo a los 
cambios de su entorno externo. 
Aumento. Conforme se utiliza el 
reconocer& funciones adicionales 
añadirlas. 

software, el 
que podria 

cliente/usuario 
ser beneficioso 

Las fases y pasos relacionados descritos en esta visión genérica de 
la ingenieria del software, se complementan con varias actividades 
protectoras. Las revisiones se realizan durante cada paso para 
asegurar que se mantiene la calidad. La documentación se desarrolla 
y controla para asegurar que toda la información sobre el sistema 
y software estar&n disponibles para un uso posterior. El control de 
los cambios se instituye de forma que los cambios puedan ser 
mejorados y registrados. 
El método en cada caso puede variar de un paradigma a otro, pero el 
enfoque global que exige la definición, desarrollo ·/ mantenimiento 
permanece invariable. Se puede realizar con disciplina y métodos 
bien definidos o de forma completamente desordenada. Pero habr& que 
realizarlos de alguna forma. 

' 



TEMA 2. ANALISIS DE REQUERIMIENTOS 

TEMA 2. ANALISIS DE REQUERIMIENTOS 

Subtema 2.1 Fundamentos del Análisis de requerimientos 

Para realizar bien el desarrollo de software es esencial realizar una 
especificación completa de los requerimientos del mismo. 

Es importante realizar una especificación completa de los requerimientos 
del software, la tarea de análisis de requerimientos es un proceso de des
cubrimiento y refinamiento, de ah! la importancia de una buena 
especificación. 

El papel del desarrollador de software y del cliente es un papel activo, el 
cliente intenta reformular su concepto de la función y comportamiento de 
los programas en detalles concretos, el que desarrolla el software actúa 
como interrogador, consultor y el que resuelve los problemas. 

El analista. 

El analista ejecu~a o coordina cada una de las tareas asociadas con el anál:sis 
de los requerimientos de software. 

El analista debe-exhibir los siguientes rasgos de cirácter: 

- Habilidad para comprender conceptos abstractos, reorganizarlos en 
divisiones lógicas y sintetizar "soluciones" basadas en cada división. 

- Habilidad para entresacar hechos importantes de fuentes conflictivas o 
confusas. 

- Habilidad para comprender entornos de usuario/cliente. 

- Habilidad para aplicar elementos hardware y/o software a entornos de 
usuario/clie :He. 

- Habilidad par comunicarse bien en forma escrita y verbal. 

Los individuos que se paran excesivamente en los detalles con frecuencia 
pierden de vista el objetivo global de los programas. Los requerimientos del 
software deben ser descubiertos de una manera "descendente"; las funciones 
importantes, interfaces e información deben comprenderse completamente 
antes de que se especifiquen los detalles de las capas sucesivas. 

Los problemas subyacentes al análisis de requerimientos son atribuibles a 
muchas causas: 
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TEMA 2. ANALISIS DE REQUERIMIENTOS 

- Pobre comunicación : Esto hace difícil la adquisición de la información.· 

- Técnicas y herramientas inadecuadas : Esto produce especificaciones in
adecuadas o imprecisas. 

- Tendencia a acortar el análisis de requerimientos : Conduce a un análisis 
inestable. 

-Un fallo en considerar alternativas antes de que se especifique el software. 

Principios del análisis. 

Cada método de análisis tiene una untca notación y punto de vista. Sin 
embargo, todos los métodos de análisis están relacionados por un conjunto 
de principios fundamentales : 

l. El dominio de la información. · ;{ como el dominio funcional de un 
problema debe ser representado y • ... nprendido. 

2. El problema debe subdividirse en forma que se descubran los detalles de 
una manera progresiva (o jerárquica). 

3. Deben desarrollarse las representaciones lógicas y físicas del sistema. 

Haciendo referencia un poco al dominio de la información. Todas las 
aplicaciones del software pueden colectivamente llamarse procesamiento de 
datos. Este término contiene la clave de lo que entendemos por re
querimientos del software. El software se construye para procesar datos, 
pero transformar datos de; una forma a otra; esto es, para aceptar entrada, 
manipularla de alguna forma y producir una salida. 

Vayamos ahora a la construcción de prototipos del software 

En algunos casos es posible aplicar los principios de análisis fundamental y 
derivar a una especificación en papel del software desde el cual pueda 
desarrollarse un di,seño. En otras situaciones, se va a una recolección de los 
requerimientos, se aplican los principios de análisis y se construye un 
modelo de software, llamado prototipo, según las apreciaciones del cliente 
y del que lo desarrolla. Finalmente, hay circunstancias que requieren la 
construcción de un prototipo al comienzo del análisis, puesto que el modelo 
es el único medio mediante el cual los requerimientos pueden ser derivados 
efectivamente. 

Perfil de las especificaciones de los Requerimientos del Software. 
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TEMA 2. ANALISIS DE REQUERIMIENTOS 

La especificación de requerimientos de software se produce en la 
culminación de la tarea de análisis. La función y comportamiento asignados 
al software como parte de la ingenieria de sistemas se refina estableciendo 
una descripción completa de la información, una descripción funcional 
detalla, una indicación de los requerimientos de rendimiento y las ligaduras 
de diseño, unos criterios de validación apropiados y otros datos pertinentes 
a los requerimientos. 

Subtema 2.2 Métodos de Análisis de Requerimientos. 

Las metodologías de análisis de requerimientos combinan procedimientos 
sistemáticos con una notación única para analizar los dominios de 
información y funcionalidad de un problema de software. En· esencia, los 
métodos de análisis de requerimientos del software, facilitan al ingeniero 
de software aplicar principios de análisis fundamentales, dentro del contex
to de un método bien definido. 

Todos los métodos pueden ser evaluados en el contexto de las siguientes 
características comunes : 

1 ) mecanismos para el análisis del dominio de la información 

2 ) método de representación funcional 

3 ) definición de interfaces 

4 ) mecanismos para subdividir el problema 

5 ) soporte de la abstracción 

6 :: representación de las visiones físicas y lógicas 

La mayoría de los métodos de análisis permiten al analista evaluar la repre
sentación física de un problema antes de derivar a la solución lógica. 

Métodos de análisjs orientados al flujo de datos. 

Salida, 

Enll'lld .. SalleS&, 

Flujo de lnfonnación. 
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TEMA 2. ANALISIS DE REQUERIMIENTOS 

(fig 5.1) Una técnica para representar el flujo de información a través del 
sistema basado en computadora lo podemos ver en esta figura. La función 
global del sistema se representa como una transformación sencilla de la 
información, representada en la figura como una burbuja. Una o más 
entradas, representadas como flechas con etiquetas, conducen la 
transformación para producir la información de salida. 

Un diagrama de flujo de datos (DFD), es una técnica gráfica que describe el 
flujo de información y las transformaciones que se aplican a los datos, 
conforme se mueven de la entrada a la salida. 

2 

Almacén da datos 

(fig 5.2) La forma básica de un DFD lo podemos ver en esta figura. El DFD 
puede usarse para representar un sistema o software a cualquier nivel de 
abstracción. Además pueden particionarse en niveles que representan flujo 
incremental de información y detalle funcional. 

D 
o 
r-'\ 

Entidad externa: 

Proceso: 

Flujo de datos: 

Una fuente da entradas al sistema. 
o tuanta da salidas del sistema 

Ejecuta alguna transtormadón 
de sus datos de entrada, produciendo 
sus datos de salida 

Se usa para conectar los procesos 
entre si, a las fuentes o a los sumideros; 
la cabeza da las techas indica 
la direeción de transferencia de los datos . 

Almacén da datos: Un depósito da datos; la cabeza 
da las flechas indica lea entradas 
y salidas al almacen 

(fig 5.3) La simbología de un DFD la podemos ver en esta figura. Se utiliza 
un rectángulo pará representar una entidad externa, esto es, un elemento 
del sistema (por ejemplo una persona). Un círculo representa un proceso o 
transformación que se aplica a los datos y que los cambia de alguna forma. 
Una flecha representa uno o más elementos de datos. Todas las flechas de 
un diagrama de flujo de datos deben estar etiquetadas. Una doble línea 
representa un almacenamiento de datos (información almacenada que es 
usada por el programa). Debido a la excepcional simplicidad de la 
simbología del DFD es una de las razones por las que las técnicas de análisis 
orientadas al flujo de datos son tan ampliamente usadas. 

DECFI - 7 - CECAFI 



TEMA 2. ANALISIS DE REQUERIMIENTOS 

Métodos orientados a la estructura de datos. 

Puesto que el dominio de la información para un problema de software 
comprende el flujo de datos, el contenido de datos y la estructura de datos. 
Los métodos de análisis orientados a la estructura de datos representan los 
requerimientos del software enfocándose hacia la estructura de datos en vez 
de al flujos de datos. Aunque cada método orientado a la estructura de datos 
tiene un enfoque y notación distinta, todos tienen algunas características en 
común como son: 

Primero, todos asisten al analista en la identificación de los objetos de 
información clave (también llamados entidades) y operaciones (también 
llamadas acciones o procesos) 

Segundo, todos suponen que la estructura de la información es jerárquica 

Tercero, todos requieren que la estructura de datos se represente usando la 
secuo:ncia, selección y repetición. (vistas anteriormente) 

y cuarto, todos dan un conjunto de pasos para transformar una estructura de 
datos. jerárquica en una estructura de programa. 

Dentro de los métodos orientados a la estructura de datos, el desarrollo de 
sistemas estructurados de datos (OSEO), también llamado metodología de 
Warnier-Orr, se basa en el trabajo sobre análisis del dominio de 
información, realizado por J. D. Warnier. Warnier desarrollo una notación 
para representar la jerarquía de la información usando las tres construc
ciones : 

1 ) Secuencia 

2 ) Selección 

3 ) Repetición 

El diagrama de 'JVarnier facilita al analista representar jerarquías de 
información de una manera compacta. Se analiza el dominio de la 
información y representa la naturaleza jerárquica de la salida. 

El método, comprende todos los atributos del dominio de información: 
flujo, contenido y estructura de datos. Para ilustrar la notación y dar una 
visión general del método de análisis. 
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TEMA 2. ANALISIS DE REQUERIMIENTOS 

Requerimientos de las bases de datos 

El término de base de datos actualmente se ha convertido en uno de los 
muchos tópicos del campo de las computadoras. Podemos definir una base 
de datos como una colección de información organizada de forma que 
facilita el acceso, análisis y creación de informes. 

El análisis de requerimientos para una base de datos incorpora las mismas 
tareas que el análisis de requerimientos del software. Es necesario un con
tacto estrecho con el cliente; es esencial la identificación de las funciones 
e interfaces; se requiere la especificación del flujo, estructura y 
asociatividad de la información y debe desarrollarse un documento formal 
de los requerimientos. 

, 
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TEMA II. ANALISIS DE REQUERIMIENTOS 
LECTURA: AREAS DEL ANALISIS DE REQUERIMIENTOS. 
El análisis de r-equerimientos puede dividirse en cuatro áreas: 

1) reconocimiento del problema. 
2) evaluación y s1ntesis 
3) especificación y 
4) revisión 

Inicialmente, el analista estudia la especificación del sistema (si 
existe) y el Plan del Proyecto. Es importante comprender el 
contexto del sistema y revisar el ámbito de los programas que se 
uso para generar las estimaciones de la planificación. 
Posteriormente, debe establecerse la comunicación necesaria para el 
análisis, de forma que se asegure el reconocimiento del problema. 
El analista debe establecer contacto con el equipo técnico y de 
gestión del usuario/cliente y con la empresa que vaya a desarrollar 
el software. El gestor del programa puede servir como coordinador 
para facilitar el establecimiento de los caminos de comunicación. 
El objetivo del analista es reconocer los elementos básicos del 
programa tal como lo p~rcibe el usuario/cliente. 
La evaluación del probléma· ·y la s1ntesis de la solución es la 
siguiente área principal de trabajo del análisis. El analista debe 
evaluar el flujo y estructura de la información, refinar en detalle 
todas las funciones del programa en detalle, establecer las 
caracter1sticas de la interface del sistema y descubrir las 
ligaduras del diseño. Cada una de las tareas sirven para describir 
el problema de forma que pueda sintetizarse un enfoque o solución 
global. · · 
Por ejemplo, un importante suministrador de materiales de 
fontaner1a necesita un sistema de control de inventario. El 
analista encuentra que los problemas con el sistema manual actual 
incluyen: 
1) imposibilidad de obtener rápidamente el estado de una 
componente. 
2) dos o tres ~1as de tiempo medio para actualizar un archivo de 
tarjetas y 
3) múltiples reórdenes del mismo vendedor debido a que no hay forma 
de asociar vendedores como componentes, etc. Una vez que se han 
identificado los problemas, el analista determina qué información 
va a ser producida por el nuevo sistema y qué datos se le 
suministrarán al sistema. Por ejemplo, el cliente desea un informe 
diario que indique los elementos que se han tomado del inventario 
y cuántos elementos similares permanecen. el cliente indica que los 
empleados del inventario registrarán el nümero de identificación de 
cada pieza cuando dejen el área de inventario. 
Hasta la evaluación de los problemas actuales y de la información 
deseada (entrada y salida) , el analista comienza por sintetizar una 
o más soluciones. Un sistema basado en un terminal en 11nea 
resolverá varios problemas, pero parece que se va a necesitar un 
sistema de gestión de base de datos, pero ¿está justificada la 
necesidad de asociacividad el usuario/cliente? El proceso de 
evaluación y s1ntesis continúa hasta que el analista y el cliente 
creen que el software puede ser especificado adecuadamente para la 
fase de desarrollo. 
En una etapa no es posible hacer una especificación detallada. El 
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client·e puede no estar seguro de precisar bien lo que quiere. El 
que desarrolla el software puede no estar seguro de que un enfoque 
concreto sea apropiado para realizar la función y comportamiento 
deseado. Por éstas razones puede presentarse un enfoque 
alternativo, llamado construcción de prototipos, para el·análisis 
de requerimientos.( Se tratará la construcción de prototipos más 
adelante) . 
Las tareas asociadas con el análisis y especificación existen para 
dar una representación del programa que pueda ser revisada y 
aprobada por el cliente. En un mundo ideal el cliente desarrolla 
una Especificación de Requerimientos del Software completamente por 
si mismo. Esto se presenta raramente en el mundo real. En el caso 
mejor, la especificación se desarrolla conjuntamente entre el 
cliente y el técnico. 
Una vez que se hayan descrito las funciones básicas, 
comportamiento, interface a información, se especifican los 
criterios de validación para demostrar una comprensión de una 
correcta implementación de los programas. Estos criterios sirven 
como base para hacer la prueba durante el desarrollo de los 
programas. Para definir las caracter1sticas y atributos del 
software se escribe una especificación de requerimientos formal. 
Además, para los casos en los que se desarrolle un prototipo se 
realiza un Manual de Usuario Preliminar. 
Puede parecer innecesario desarrollar un manual de usuario en una 
etapa tan temprana del proceso de desarrollo. Pero de hecho, este 
borrador de manual de usuario fuerza al analista a tomar el punto 
de vista del usuario del software. El manual permite al 
usuario/cliente revisar el software desde una perspectiva de 
ingenier1a humana y frecuentemente produce el comentario: "La idea 
es correcta, pero ésta no es la forma en que pensé que se podr1a 
hacer esto". Es mejor descubrir tales comentarios lo más 
tempranamente posible en el proceso. 
Los documentos del análisis de requerimientos (especificación y 
manual de usuario) sirven como base para una revisión conducida por 
el cliente y el técnico. La revisión de los requerimientos casi 
siempre produce modificaciones en la función, comportamiento, 
representación de la información, ligaduras o criterios de 
validación. Además, se realiza una nueva apreciación del Plan del 
Proyecto Software para determinar si las primeras estimaciones 
siguen siendo válidas después del conocimiento adicional obtenido 
durante el análisis. 

' 
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LECTURA: ANALISIS ORIENTADO kL OBJETO. 
El diseño orientado al objeto (000), como otras metodolog1as de 
diseño orientadas a la información, crea una representación del 
dominio del problema en el mundo real y lo transforma en un dominio 
de solución que es software. A diferencia de otros métodos , el ooo 
da como resultado un diseño que interconexiona los objetos de 
datos (elementos de datos) y las operaciones de procesamiento, de 
forma que modulariza la información y el procesamiento en vez de 
sólo el procesamiento. 
La naturaleza única del diseño orientado al objeto est~ ligada a su 
habilidad para construir, bas~ndose entres conceptos importantes de 
diseño del software: abstracción, ocultación de la información y 
modularidad. Todos los métodos de diseño buscan la creación de 
software que exhiba estas caracter1sticas fundamentales, pero sólo 
ooo da un mecanismo que facilita al diseñador adquirir los tres sin 
complejidad o compromiso. 
Origenes del diseño orientado al objeto. 
Los objetivos y las operaciones no son un nuevo concepto de 
programación, pero s1 lo es el diseño orientado al objeto. En los 
primeros d1as de la computación, los lenguajes ensambladores 
facilitaban a los programadores la utilización de las instrucciones 
máquina (operadores) para manipular los elementos de datos 
(operandos). El nivel de abstracción que se aplicaba al dominio de 
la solución era muy bajo. 
Conforme aparecieron los lenguajes de programación de alto nivel 
(por ejemplo Fortran, algol, cobol, etc) los objetos y operaciones 
del espacio de problemas del mundo real pod1an ser modelados 
mediante datos y estructuras de control predefinidas, que estaban 
disponibles como partes del lenguaje de alto nivel. En general, el 
diseño de software se enfocaba sobre la representación del detalle 
procedimental usando el lenguaje de programación elegido. Los 
conceptos de diseño, tales como refinamientos sucesivos de una 
función, modularidad procedimental y, posteriormente, programación 
estructurada, fueron introducidos entonces. 
Durante los años 1970, se intrudujeron conceptos tales como 
abstracción y ocultación de la información y, emergieron métodos de 
diseño conducidos por los datos, pero los que desarrollaban 
software aún se encontraban sobre el proceso y su representación. 
Al mismo tiempo, los lenguajes de alto nivel modernos (por ejemplo 
Pascal) introdujeron una variedad mucho más rica de tipos y 
estructuras de datos. 
Aunque los lenguajes de alto nivel convencionales (lenguajes a 
partir de Fortran y algol) evolucionaron durante los años 1960 y 
1970, los investigadores estaban trabajando mucho sobre una nueva 
clase de lenguaje de simulación de prototipos, tales como Simula Y 
Smalltalk. En estos lenguajes, la abstracción de datos tenia una 
gran importacia y los problemas del mundo real se representaban 
mediante un conjunto de objetos de datos, a los cuales se les 
añadia el correspondiente conjunto de operaciones. El uso de estos 
lenguajes era radicalmente diferente del uso de los lenguajes más 
convencionales. 
El método del diseño orientado al objeto ha emergido durante los 
últimos 17 años. Los primeros trabajos en diseño de software 
pusieron la base estableciendo la importancia de la abstracción, 
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ocultación de ~a información y de la modularidad en la calidad del 
software. En algunos aspectos, los métodos de diseño orientados a 
estructuras de datos tales como Desarrollo de Sistemas 
Estructurados de Datos (OSEO) y Desarrollo de Sistema de Jackson 
(DSJ) , pueden verse como orientados al objeto. 
Durante los años 1980 la rApida evolución de los lenguajes de 
programación Smalltalk y Ada causaron un creciente interés en DOO. 
En las primeras discusiones sobre el método para conseguir un 
diseño orientado al objeto. Abbott mostró "c6mo el anAlisis de 
sentencias en lenguaje natural del problema y sus solución, pueden 
usarse como guia para desarrollar la parte visible de un paquete 
útil (un paquete útil que tenga los datos y procedimientos que 
operan sobre ellos) y el algoritmo particular para un problema 
dado". Booch extendió el trabajo de Abbott y ayudó a popularizar el 
concepto de diseño orientado al objeto. Hoy el DOO se estA usando 
en aplicaciones de diseño de software que van desde animaciones de 
gráficos por computadora a las telecomunicaciones. 
Conceptos del diseño orientado al objeto. 
Como otros métodos de diseño, el 000 introduce un nuevo con junto 
de terminologia, notación y procedimientos para la derivación de un 
diseño del software. 
La función del software es relacionada cuando una estructura de 
datos (de distintos niveles de complejidad) es manipulada mediante 
uno o más procesos, de acuerdo con un procedimiento definido 
mediante un algoritmo estAtico y órdenes dinAmicas. Para conseguir 
un diseño orientado al objeto, se debe establecer un mecanismo 
para: 

1) la representación de la estructura de datos, 
2) La especificación del proceso y 
3) El procedimiento de llamada. 

Un objeto es una componente del mundo real que se transforma en el 
dominio del software. En el contexto de un sistema basado en 
computadora, un objeto es normalmente un procedimiento o consumidor 
de información o un elemento de información. Por ejemplo, objetos 
t1picos pueden ser: mAquinas, órdenes, archivos, visualizaciones, 
conmutadores, señales, cadenas alfanuméricas o cualquier otra 
persona, lugar o cosa. Cuando un objeto se transforma en una 
realización software, consta de una estructura de datos privada y 
procesos, llamados operaciones o métodos, que pueden transformar 
legitimamente la estructura de datos. Las operaciones contienen el 
control y las construcciones procedimentales que pueden ser 
llamadas mediante un mensaje una petición al objeto para que 
ejecute una de 'sus operaciones. La realización software de un 
objeto se muestra en la figura (fig 
9. 1) • 
Refiriéndose a la figura, un objeto del mundo real (un diccionario) 
se transforma en una realización software para un sistema basado en 
computadora. La realización software de un diccionario exhibe una 
estructura de datos privada y las operaciones relativas a ella. La 
estructura de datos puede tomar la forma descrita mediante 
diagramas de Warnier-Orr de la figura (fig 9.2). Las entradas del 
diccionario estAn compuestas de palabras, una guia de pronunciación 
y una o mAs definiciones . .Un dibujo o diagrama puede estar también 
contenido dentro de una entrada. El diccionario de objetos también 
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contiene un conjunto de operaciones que 
elementos de la estructura de datos. La parte 
es la estructura de datos y el conjunto de 
estructura de datos. 

puede procesar los 
privada de un objeto 
operaciones para la 

Un objeto tiene también una parte compartida '1:'~9 es su interfaz. 
Los mensajes se mueven a través de la interfaz y especifican qué 
operaciones del objeto se desean, pero no cómo se va a realizar la 
operación. El objeto que recibe un mensaje determina cómo se 
implementa la operación solicitada. 
Definiendo un objeto con una parte privada y dando mensajes para 
llamar al procesamiento adecuado, se consigue la ocultación de la 
información; esto es, los detalles de la implementación están 
ocultos a todos los elementos del programa exteriores al objeto. 
Los objetivos y sus operaciones dan una modularidad inherente; esto 
es, los elementos del software (datos y procesos) se agrupan junto 
con los mecanismos de interfaces bien definidos. 
De esta forma se tiene que el análisis orientado al objeto puede 
describirse de la siguiente forma: 
1. El software asignado (o el sistema entero) se describe usando 

una estrategia informal. La estrategia no es más que una 
descripción en lenguaje natural de la solución del problema 
que hay que resolver, mediante el software representado a un 
nivel consistente de detalle. La estrategia informal puede ser 
establecida en- forma de párrafos sencillos, gramaticalmente 
correctos. 

2 . 

3 • 

4 . 

5. 

Los objetivos se determinan subrayando cada nombre o cláusula 
nominal e introduciéndolo en una tabla sencilla. Deben 
anotarse los sinónimos. Si se requiere que el objeto se 
implemente como una solución, entonces es parte del espacio de 
solución; en otros casos, si un objeto es necesario sólo para 
describir una solución, es parte del espacio del problema. 
Los atributos de los objetos se identifican subrayando todos 
los adjetivos y luego asociándolos con sus objetos respectivos 
(nombres). 
Las operaciones se determinan subrayando todos los verbos, 
frases verbales -Y predicados (una frase verbal indica un test 
condicional) y relacionando cada operación con el objeto 
apropiado. 
Los atributos de las operaciones se identifican subrayando 
todos los adverbios y luego asociándolos con sus operaciones 
respectivas (verbos). 

Para ilustrar el método de análisis orientado al objeto, considere 
al siguiente texto: 

El software SCCT recibirfl la información de entrada de un 
lector de código de barras a intervalos de tiempo que estén de 
acuerdo con la velocidad de la cinta transportadora. Los datos 
del código de barras se decodificarAn en un formato de 
identificación de caia. El software examinará una base de 
datos de unas 1000 entradas para determinar la posición del 
cubo apropiado para la ~ que actualmente estfl en el lector 
(estación de clasificación! . SE usará una lista FIFO para 
tomar nota de las posiciones de envio de cada caja conforme se 
mueve por la estación de clasificación. 
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El software SCCT recibirá también entrada de un tacómetro de 
pulsos que se usará para sincronizar la señal de control con 
el mecanismo de envio. Basándose en el número de pulsos que se 
generarán entre la estación de clasificación y el envio, el 
software producirá una señal de control a la estación de envio 
indicando la posición correspondiente de la caja ... 

Analizando un poco el texto anterior muchos de los nombres 
subrayados indican que residen en el espacio del problema y n o son 
necesarios para la implementación del programa. Otros nombres, 
tales como datos del código de barra, posición del cubo y señal de 
control, residen en el espacio de la solución e introducen en la 
tabla de objetos y operaciones. Siguiendo el procedimiento de 
análisis orientado al objeto, se subrayan a continuación todos lo 
adjetivos y se colocan en la tabla como se muestra en ella. 
Cuando uno de los objetivos representa un elemento de información 
que debe ser procesado por el programa. Para determinar las 
funciones de procesamiento, debemos aislar todas las operaciones. 
Por lo que siguiendo el procedimiento de análisis: 

El software SCCT recibirá \la información de entrada de un 
lector de código de barras a intervalos de tiempo conforme a 
la velocidad de la cinta transportadora. Los datos del código 
de barras se decodificarán en un formato de identificación de 
caja. El software examinará una base de datos de unas 1000 
entradas para determinar la posición apropiada del cubo para 
la caja que actualmente está en el lector (estación de 
clasificación). Se usará una lista FIFO para tomar nota de las 
posiciones de envio de cada caja conforme se mueve por la 
estación de clasificación. 
El software SCCT recibirá también entrada de un tacómetro de 
pulsos que se usará para sincronizar la señal de control con 
el mecanismo de envio. Basándose en el número de pulsos que se 
generarán entre la estación de ordenación envio, el software 
producirá una señal de control a la estación de envio 
indicando la posición correspondiente de la caja ... 
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Objeto 

Datos 
Posición 
Señal 
Entrada 
Lista 
Posiciones 
Intervalos 
Formato 
Base de datos 
Pulsos 

TABLA 
OBJETOS Y OPERACIONES 

Atributo 

Código de caja 
Caja 
Control 
Tac. pulso 
FIFO 
Env1o 
Tiempo 
Id. caja 
1000 entradas 
Tac. 

Operación correspondiente 

Decodificador 
Determinar 
Sincronizar, producir 
Recibir 
Tomar nota 
Tomar nota 
Conformar 
Decodificar 
Examinar 
Generado 

Algunas de las operaciones anotadas pertenecen al espacio de 
solución (por ejemplo recibir, buscar, producir) mientras que otras 
son parte del espacio del problema (por ejemplo sincroniza). Las 
operaciones del espacio de solución se añaden a la tabla de objetos 
y operaciones. 

, 
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LECTURA: CONSTRUCCION DE PROTOTIPOS. 
El análisis debe ser conducido independientemente del paradigma de 
ingenieria de software aplicado. Sin embargo, la forma que ese 
análisis tomará puede variar. En algunos casos es posible aplicar 
los principios de análisis fundamental y derivar a una 
especificación en papel del software desde el cual pueda 
desarrollarse un diseño. En otras situaciones, se va a una 
recolección de los requerimientos, se aplican los principios de 
análisis y se construye un modelo de software, llamado un 
prototipo, según las apreciaciones del cliente y del que lo 
desarrolla. Finalmente, hay circunstancias que requieren la 
construcción de un prototipo al comienzo del análisis, puesto que 
el modelo es el único medio mediante el que los requerimientos 
pueden ser derivados efectivamente. 
El modelo entonces se transforma en una producción de software. En 
muchos casos (aunque no todos), la construcción de un prototipo, 
acoplado posiblemente con métodos de análisis sistemáticos, es una 
forma efectiva de ingenieria del software. 
Todos los proyectos de ingenieria del softwat:e_.comienzan con una 
petición del cliente. La petición puede estar en la forma de una 
memoria que describe un problema, un informe que define un conjunto 
de objetivos comerciales o del producto, una Petición de Propuesta 
formal de una agencia o compañia exterior, o una Especificación del 
Sistema que ha asignado una función y comportamiento al software, 
como un elemento de un sistema basado en computadora. Suponiendo 
que existe una petición para un programa de una de las formas para 
construir un prototipo del software se aplican los siguientes 
pasos: 
PASO 1. Evaluar la petición del software y determinar si el 
programa a desarrollar es un buen candidato para construir un 
prototipo. No todos los programas son adecuados para la 
construcción de prototipos. Varios factores de candidatura de 
construcción de prototipos pueden ser definidos: área de 
aplicación, complejidad, de la aplicación, caracteristicas del 
cliente y caracteristicas del proyecto. 
Debido a que el cliente debe interaccionar con el prototipo en los 
últimos pasos, es esencial que: 4 

1) El cliente participe en la evaluación y refinamiento del 
prototipo. 
2) El cliente sea capaz de tomar decisiones de requerimientos 
de una forma oportuna. 

Finalmente, la naturaleza del proyecto de desarrollo tendrá una 
fuerte influenciá en la eficacia del prototipo. 
PASO 2. Dado un proyecto candidato aceptable, el analista 
desarrolla una representación abreviada de los requerimientos. 
Antes de que pueda comenzar la construcción de un prototipo, el 
analista debe representar los dominios funcionales y de información 
del programa·y desarrollar un método razonable de partición. 
PASO J. Después de que se haya revisado la representación de los 
requerimientos, se crea un conjunto de especificaciones de diseño 
abreviadas para el prototipo. El diseño debe ocurrir antes de que 
comience la construcción del prototipo. Sin embargo, el diseño de 
un prototipo se enfoca normalmente hacia la arquitectura a nivel 
superior y a los aspectos de diseño de datos, en vez de hacia el 
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diseño procedimental detallado. 
PASO 4. El software del prototipo se crea, prueba y refina. 
Idealmente, los bloques de construcción de software preexistentes 
se utilizan para crear el prototipo de una forma rápida. Debido a 
que tales bloques construidos raramente existen. Alternativamente, 
pueden usarse herramientas de construcción de prototipos 
especializadas para asistir al analista/diseñador en la 
representación del diseño y traducirlo a una forma ejecutable. 
Si la implementación de un prototipo que funcione es impracticable, 
el escenario de construcción de prototipos puede aün aplicarse. 
Para las aplicaciones interactivas con el hombre, es posible 
frecuentemente crear un prototipo en papel que describa la 
interacción hombre-máquina (preguntas, presentaciones, decisiones, 
etc.) usando una serie de hojas de historia. Cada hoja de historia 
conciene una representación de una imagen de la pantalla con texto, 
que describe la interacción entre la máquina y el usuario. El 
cliente revisa las horas de historia, obteniendo una perspectiva de 
usuario de la operación del software. 
PASO 5. Una vez que el prototipo ha sido probado, se presenta al 
cliente, el cual "conduce la prueba" de la aplicación y sugiere 
modificaciones. Este paso es el nücleo del método de construcción 
de prototipo. Es .aqui donde el cliente puede examinar una 
representación implementada de los requerimientos del programa, 
sugerir modificaciones que harán al programa cumplir mejor las 
necesidades reales. 
PASO 6. Los pasos 4 y 5 se repiten iterativamente hasta que todos 
los requerimientos estén formalizados o hasta que el prototipo haya 
evolucionado hacia un sistema de producción. El paradigma de 
construcción del prototipo puede ser conducido con uno o dos 
objetivos en mente: 

1) el propósito del prototipo es establecer un conjunto de 
requerimientos formales que pueden luego ser traducidos en la 
producción de programas .mediante el uso de métodos y técnicas 
de ingenieria de programación, o 
2) el propósito de la construcción del prototipo es 
suministrar un continuo que pueda conducir al desarrollo 
evolutivo de la producción del software. Ambos métodos tienen 
sus méritos y ambos crean problemas. 

Métodos y herramientas para la construcción de prototipos. 
Para que la construcci6n de prototipos de software sea efectivo, un 
prototipo debe desarrollar rápidamente, de forma que el cliente 
pueda comprobar los resultados y recomendar cambios. Para conseguir 
una construcci6n ··rápida de prototipo, existen tres clases genéricas 
de métodos y herramientas: Técnicas de la cuarta generación, 
componentes de software reusables, especificaci6n formal y entornos 
de construcci6n de prototipo. 
TECNICAS DE LA CUARTA GENERACION. Las técnicas de la cuarta 
generaci6n (4GT) comprenden un amplio repertorio de lenguajes de 
informes y preguntas de base de datos, generadores de programas Y 
aplicaciones y otros lenguajes no procedimentales de muy alto 
nivel. Debido a que las 4GT facilitan al ingeniero de programación 
general, código ejecutable rápidamente, son ideales para la 
construcción rápida de prototipos. Desafortunadamente, el dominio 
de aplicación de las 4GT está actualmente limitado a sistemas de 
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información comerciales. 

COMPONENTES DE SOFTWARE REUSABLES. Otro método para la construcción 
rápida de prototipos es ensamblar, en vez de construir, el 
prototipo usando un conjunto de componentes software existente. Una 
componente software puede ser una estructura de datos (o base de 
datos) o una componente arquitectónica software (por ejemplo un 
programa o una componente procedimental (es decir, un módulo). En 
cada caso, la componente software debe ser diseñada en forma que 
facilite el ser reusada sin conocer los detalles de su 
funcionamiento interno. Debe observarse que un producto software 
existente puede ser usado como un prototipo para un "nuevo, 
mejorado" producto competitivo. De alguna forma, esto es una forma 
de reusabilidad para la construcción de prototipos de software. 
ESPECIFICACION FORMAL Y ENTORNOS PARA LA CONSTRUCCION DE 
PROTOTIPOS. Se han desarrollado varios lenguajes de especificación 
formal para reemplazar las técnicas de especificación en lenguaje 
natural. Hoy, los desarrolladores de estos le~;uajes formales están 
en el proceso de desarrollar entornos interactivos que: 

1) facilite al analista crear interactivamente una 
especificación basada en el lenguaje de un sistema o software; 
2) llame a herramientas automáticas que traduzcan las 
especificaciones basadas en lenguajes en código ejecutable y 
3) faciliten al cliente utilizar el código ejecutable del 

·prototipo para refinar los requerimientos formales. 
La forma de especificar tiene mucho que ver con la calidad de la 
solución. Los ingenieros de software que se han esforzado en 
trabajar con especificaciones incompletas, inconsistentes o ma 1 
establecidas han experimentado la frustación y confusión que 
invariantemente se produce. Las consecuencias se padecen en la 
calidad, oportunidad y completitud del software resultante. 
Las técnicas de análisis pueden conducir a una especificacion en 
papel que contenga las descripciones gráficas y el lenguaje natural 
de los requerimientos del software. La construcción de prototipos 
conduce a una especificación ejecutable, esto es, el prototipo 
sirve como una representación de los requerimientos. Los lenguajes 
de especificación formal conducen a representaciones formales de 
los requerimientos que pueden ser verificados o analizados. 

1 q 



LECTURA: BASES DE DATOS. 
Un sistema de base de datos. 
Se puede definir un sistema de base de datos como un sistema de 
mantenimiento de registros, basado en computadoras, es decir, un 
sistema que de manera general registra y mantiene información de 
importancia para la organización donde el sistema opera. 
Un sistema de base de datos tiene cuatro componentes principales: 
datos, hardware, software y usuarios. 

Datos 
Se refieren a los valores registrados dentro de la base de datos. 
Es importante distinguir entre "datos" e información" ya que no 
siempre significan lo mismo. Un dato, simplemente es un valor 
(número, letras, ... ) mientras que la información es el significado 
de esos valores según el sentido que les dé el usuario. Los datos 
se dividen en una o más bases de datos, pero didácticamente es 
válido suponer que existe una sola base de datos. 

Hardware 
Se compone de los volúmenes de almacenamiento secundario (discos, 
tambores), ... ) donde se encuentra la base de datos junto con 
dispositivos asociados (unidades de control, canales, ... ). 

Software 
Es un sistema de administración de bases de datos o DBMS y existe 
entre el usuario y la base de datos f1sica. Este DBMS maneja todas 
las solicitudes de acceso a la base de datos y protege a los 

.usuarios contra los detalles a nivel hardware apoyando las 
operaciones del usuario. 

Usuarios 
Se pueden considerar diversos tipos de usuarios. 
Existe el usuario programador de aplicaciones quien escribe 
programas de aplicación que utilicen bases de datos. Dichos 
programas recuperan información, crean información, suprimen o 
cambian información, y en general operan con los datos de todas las 
maneras posibles. · 
El usuario final es quien accesa la base de datos desde una 
terminal. Dicho acceso lo realiza a través de un lenguaje de 
consulta con el cual puede realizar todas las funciones de 
recuperación, creación, modificación y supresión de la información 
coc.t.enida en la'base de datos. 
El usuario administrador de Bases de Datos o DBA es quien organiza 
el sistema para un desempeño adecuado y le hace los ajustes 
necesarios al cambiar los requerimientos. 

ObjetLvos de los sistemas de bases de datos 
El objetivo primordial de un sistema de base 
proporcionar a la empresa un control centralizado 
Dicho control trae consigo diversas ventajas: 

Control de la Redundancia. 

de datos es 
de sus da tos. 

Se evita que cada aplicación tenga sus propios archivos 

.. 



(Redundancia=Información repetida) . La Redundáncia pr?picia un 
desperdicio del espacio de almacenamiento. En ocas~ones, la 
redundancia no se elimina totalmente (por rabones técnicas o 
comerciales) sin embargo se controla y el sistema debe 
responsabilizarse de propagar las actualizaciones que se le hagan 
a los datos. 

Evitar Inconsistencias. 
Cuando en un sistema de bases de datos, existe redundancia, hay 
duplicidad de datos. Esta duplicidad puede originar que en 
determinado momento una actualización no se propague correctamente 
y se dé la inconsistencia de datos. En este momento, la información 
no será totalmente confiable, ya que, datos repetidos no son 
concordantes y la base de datos es inconsistente. con lo anterior, 
se puede decir que la inconsistencia se puede evitar si se controla 
la redundancia. 

Datos Compartidos. 
se pueden tener aplicaciones que compartan los datos de la base de 
datos, e incluso, aplicaciones que operen con los mismos datos 
almacenados. Con ellos, nuevas aplicaciones pueden realizarse sin 
tener que crear nuevos almacenamientos. 

Seguridad. 
Al tener el DBA completa jurisdicción de los datos se asegura que 
el único medio de accesar la base de datos sea a través de los 
canales establecidos, y que se definan controles de autorización 
que se aplican cada vez que se intenta el acceso a datos sensibles 
(aquellos datos cuyo valor es importante y que solo puede ser 
cambiado bajo condiciones muy particulares). 

Integridad. 
Se garantiza que los datos de la base 
es, no se presenta inconsistencia 
representan la misma cosa. 

Independencia de los datos. 

de datos son exactos, esto 
entre dos entradas que 

Para evitar que las aplicaciones dependan de la manera como los 
datos se organizan en el almacenamiento secundario y la manera como 
se accesan no sea dependiente de la aplicación. Cuando no existe 
independencia de datos es imposible cambiar la estructu~"l. de 
almacenamiento o la estrategia de acceso sin afectar la aplica~ión. 

' 
Modelos de Bases de Datos. 
El modelo de datos es un grupo de herramientas conceptuales para 
describir datos, sus relaciones, su semántica y sus limitantes. 
En general, los modelos de datos se pueden dividir en tres grupos: 
Modelos lógicos basados en objetos 
su caracteristica principal es que permiten estructuras flexibles 
y permiten especificar claramente las limitantes de los datos. 
Existen más de treinta modelos distintos de este tipo entre los 
cuales están el Binario, Semántico de Datos, Entidad-Relación, etc. 
El modelo Entidad-Relación es el más representativo de los modelos 
lógicos basados en objetos. Dicho modelo, se basa en un conjunto de 



objetos básicos llamados entidades y de las relaciones entre estos 
objetos. Se manejan conceptos como Entidad y atributos. 
Una Entidad es un objeto, persona, animal o cosa de interés para la 
comunidad de usuarios acerca de la cual es sistema de bases de 
datos debe mantener, correlacionar o desplegar información. Un 
atributo es una caracteristica o cualidad de una entidad, debe ser 
de interés y estar dentro del alcance del sistema. 
Lo que distingue a una entidad de otra es el conjunto de atributos 
que la describen. Por ejemplo los atributos nombre y dirección 
describen a un usuario especifico en una biblioteca. 
Varias entidades pueden relacionarse entre si mediante una relación 
o asociación, por ejemplo, la relación Libro-Autor asocia a un 
libro con cada uno de los autores que tiene (as1 pues, es posible 
tener un conjunto de entidades y un conjunto de relaciones, los 
cuales están constituidos por todas las entidades y todas las 
relaciones respectivamente). 

La estructura lógica general de una base de datos puede expresarse 
gráficamente por medio de un diagrama Entidad-Relación. 
Modelos Lógicos Basados en Registros 
A diferencia de los modelos de datos basados en objetos, estos 
especifican tanto la estructura lógica general de la base de datos 
como una descripción en un nivel mas alto de la implantación. Estos 
modelos, no permiten especificar en forma clara las limitantes de 
los datos. Los modelos de este tipo con mayor aceptación son: 
Modelo Relacional 
Modelo en el que los datos se representan por medio de una serie de 
tablas, cada una de las cuales tiene varias columnas con nombres 
únicos (atributos). Cada renglón de las tablas es llamado Registro 
o tupla; entonces, un registro representa un elemento de la tabla 
con diversos atributos. 
La cardinalidad de una tabla queda definida como el número de 
registros (renglones) que tiene; y el orden de la tabla queda 
definido como el número de columnas o atributos de la misma. 

Por ejemplo en la tab~a B: 

Tabla A Tabla B 
nombre calle ciudad número número cuota 

Hugo Central México 113 113 12 
Paco Azafrán Puebla 129 129 130 
Luis Sur Guadalajara 317 317 19 
Pedro Norte' Monterrey 113 
Pedro Norte Monterrey 317 

se tiene tres tuplas o registros y dos columnas o atributos, por lo 
tanto la tabla tiene orden 2 y cardinalidad 3. 

Modelos de Red. 
Los datos en el modelo de Red se representan por medio de conjuntos 
de registros (en el sentido de la palabra en Pascal o PL/1) y las 
relaciones entre los datos se representan con ligas, que pueden 
considerarse como apuntadores. Los registros de la base de datos se 
organizan en forma de conjuntos de gráficas arbitrarias. La 



siguiente figura es un ejemplo de una base de datos de red. 

Central México 

Azafrán Puebla 

Sur Guadalajara 

Norte Monterrey 

Modelos F1sicos de los Datos 
Sirven para describir los datos en un nivel más bajo. A 'iferencia 
de los modelos 16gicos de los datos, son muy pocos l. ; modelos 
f1sicos utilizados. Los más conocidos son: 
El modelo unificador. 
La memoria de cuadros. 

, 



TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE. 

TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE. 

En los primeros días de la informática, el coste del software representaba 
un pequeño porcentaje del coste total del sistema informático, basado en 
computadora. Un error considerable en las estimaciones del coste del 
software tenía relativamente poco impacto. Hoy en día, el software es el 
elemento más caro en muchos sistemas informáticos. Un gran error en la 
estimación del costo puede marcar la diferencia entre beneficios y pérdidas. 
Sobrepasar el coste puede ser desastroso para el equipo de desarrollo. La 
estimación del proyecto de software puede transformarse de un oscuro arte 
en una serie de pasos sistemáticos que proporcionen estimaciones con un 
grado de riesgo aceptable. 

Para realizar estimaciones seguras de coste y esfuerzo surge un número de 
opciones posibles: 

l. Retrasar la estimación más adelante en el proyecto. 

2. Utilizar "técnicas de descomposición" relativamente simples para generar 
las estimaciones del proyecto de software. 

3. Desarrollar un modelo empírico para el coste y el esfuerzo del software. 

4. Adquirir una o más herramientas automáticas de estimación. 

Desafortunadamente, la primera opción, aunque atractiva, no es práctica: 
las estimaciones del coste deber ser proporcionadas "de antemano". Sin 
embargo, debemos reconocer que cuanto más tiempo esperamos, más cosas 
sabemos y, cuanto más sabemos, menor es la probabilidad de cometer serios 
errores en nuestras estimaciones. 

Las tres opciones restantes son aproximaciones viables para la estimación 
del proyecto de software. Idealmente, las técnicas señaladas para cada 
opción deben ser aplicadas en conjunto, cada una usada para comprobar las 
otras. Las técnicas de descomposición utilizan una aproximación de "divide 
y vencerás" para la estimación del proyecto de software. 

Los seres humanos han desarrollado una aproximación natural a la 
resolución de problemas: si el problema a resolver es demasiado com
plicado, tendemos a subdividirlo hasta encontrar problemas manejables. 
Entonces resolvemos cada uno individualmente y esperamos que las 
soluciones puedan ser combinadas para responder al problema original. 

La estimación del proyecto de software es una forma de resolución de 
proyectos y, en la mayoría de los casos, el problema a resolver es demasiado 
complejo para considerarlo como una sola pieza. Por esta razón, descom-
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TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE. 

ponemos el problema, re-caracterizándolo como un conjunto de pequeños 
problemas esperando que sean más manejables. 

Estimaciones LDC y PF. 

La medición es fundamental para cualquier disciplina de ingeniería del 
software no es una excepción. 

Las métricas del software se refieren a un amplio rango de medidas para el 
software de computadoras. Dentro del contexto de la planificación del 
proyecto de software. Se considera al uso de líneas de código (LDC) como 
medidas clave. Los defensores de la medida LDC afirman que la LDC es un 
"artefacto" de todos los proyectos de desarrollo de software que puede ser 
fácilmente calculado, que muchos modelos de estimación del software exis
tentes utilizan LDC o KLDC (miles de líneas de código) como clave de 
entrada y que ya existe un amplio conjunto de datos y de literatura basada 
en LDC. 

Las métricas del software orientadas a la función son medidas indirectas del 
software y del proceso por el cual se desarrolla. Más que calcular las LDC, 
las métricas orientadas a la función se centran en la "funcionalidad" o 
"utilidad" del programa. 

Los puntos de función son obtenidos utilizando una relación emptr1ca 
basada en medidas contables del dominio de información del software y 
valoraciones subjetivas de la complejidad del software. La medida del punto 
de función fue diseñada originalmente para a !icaria en las licaciones de 
sistemas de información comerciales. 

Elemento del dominia Cuenta PF 
de 1nfonnae~on 

, 

Numero de 
enuadal de usuario 

3 

4 

3 

7 

5 

4 

5 

4 

10 

7 

PF = cuema por el tact:Of de ponderseión 

6 

7 

6 

15 

10 

(fig. 3.9). Los puntos de función son calcula rellenando la tabla que se 
muestra en la figura. Se determinan cinco características del dominio de la 
información y los cálculos aparecen indicados en la posición apropiada de 
la tabla. Los valores del dominio de la información están definidos de la 
siguiente manera: 
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TEMA 3. ESTIMACION DE COSTOS DEL SOFTWARE. 

Número de entradas de usuario: Se cuenta cada entrada de usuario que 
proporciona al software diferentes datos orientados a la aplicación. Las 
entradas deben ser distinguidas de las peticiones, que se contabilizan por 
separado. 

Número de salidas de usuario: Se cuenta cada salida de usuario que propor
ciona al usuario información orientada a la aplicación. En este contexto, la 
salida se refiere a informes, pantalla, mensajes de error, etc. Los elementos 
de datos individuales dentro de un informe no se cuentan por separado. 

Número de peticiones del usuario: Una petición está definida como una 
entrada interactiva que resulta en la generación de algún tipo de respuesta 
en forma de salida interactiva. Se cuenta cada petición distinta. 

Número de archivos: Se cuenta cada archivo maestro lógico o sea, una 
agrupación lógica de datos que puede ser una parte de una gran base de 
datos o un archivo independiente. 

Número de interfaces externas: Se cuentan todas las interfaces legibles por 
la máquina por ejemplo, archivos de datos en cinta o disco, que.son 
utilizados para transmitir información a otro sistema. 

Una vez obtenidos los datos mencionados, se deberá asociar un valor de 
complejidad a cada cuenta. Las organizaciones que utilizan métodos de -
puntos de función desarrollan criterios para determinar si una entrada 
determinada es simple, medida o compleja. 

Para calcular los puntos de función (PF) se utiliza la siguiente relación: 

PF = cuenta.total X [0.65 + 0.01 X SUM(Fi)] 

donde cuenta. total es la suma de todas las entradas obtenidas de la tabla. 
Los valores constantes de la ecuación anterior y los factores de ponderación 
aplicados a las cuentas de los dominios de información han sido deter
minados empíricamente. 

, 
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Tema 4. Fundamentos del Diseño de Software 

El diseño es el primer paso en la fase de desarrollo de cualquier sistema, se define como: "El 
proceso de aplicar distintas técnicas y principios con el propósito de definir un dispositivo, 
proceso o sistema con los suficientes detalles como para permitir su realización física". 

Hay que tener en cuenta que el objetivo del diseñador es producir un modelo de una entidad 
que será construida posteriormente. El proceso para el desarrollo de un modelo combina: 
intuición y criterios, es decir, se basa en la experiencia para construir entidades similares, 
principios que guían la forma en la que se desarrolla el modelo, criterios que facilitan discernir 
sobre la calidad y el proceso de representación del diseño final. 

Subtema 4.1 La fase de desarrollo y el diseño de sotlware 

U na vez establecidos los requerimientos del software, la fase de ~esarrollo comprende tres 
pasos distintos: 

l. Diseño 

2. Generación de código 

3. Prueba 

Cada paso transforma la información de tal forma que finalmente se obtiene un software para 
computadora válido. En este tema explicaremos el primer paso "diseño" y posteriormente se 
desarrollaron los siguientes. · 

El flujo de información que alimenta la etapa de diseño se ve en la figura anterior En esta se 
aprecia las entradas las cuales son: los requerimientos del programa, los requerimientos 
funcionales y de comportamiento. Usando alguna de las distintas metodologias de diseño se 
realiza el diseño de datos, el diseño arquitectónico y el diseño procedimental, que posterior
mente explicaremos. 

DECFI • 14. CECAFI 



Prueba 

, 

' y. 



Tema 4. Fundamentos del Diseño de Software 

Cabe hacer notar que el diseño J el lugar en donde se asienta la calidad del desarrollo del 
programa, nos da las representaciones del software que pueden establecerse para conseguir 
un producto con calidad. 

Subtema 4.2El proceso de diseño 

El diseño de programas es un proceso mediante el cual se traducen los requerimientos en una 
representación del software. 

Desde el punto de vista de una gestión de proyecto, el diseño del software se realiza en dos 
pasos: 

l.Diseño preliminar: que se refiere a la transformación de los requerimientos en datos y 
·arquitectura del software 

2. Diseño en detalle: que se enfoca hacia los refinamientos de la representación 
arquitectónica que conduce a una estructura de datos detallada y a representaciones 
algoritmicas del software. 

Hablaremos ahora acerca del diseño y calidad de software que es esencial para el logro de un 
buen producto. 

Diseño y calidad del software 

Para evaluar la calidad de una representación de diseño presentamos los siguientes criterios: 

Un diseño debe: 

- exhibir una organización jerárquica 
(que haga uso inteligente de control entre los elementos del software) 

- ser modular 
(esto es, el software debe estar particionado lógicamente en elementos que realicen fun
ciones y subfunciones especificas) 

- contener una r;presentación distinta y separada de los datos y los procedimientos. 

- conducir a módulos que muestren características funcionales independientes 

- derivarse usando un método repetitivo 
(que esté conducido por la información obtenida durante el análisis de requerimientos 
de software) 
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Tema 4. Fundamentos del Diseño de Software 

SuiJtema 4.3 Fundamentos del diseño 

Se ha mencionado ya la importancia que representa la elaboración de un buen diseño, para 
que esto se lleve a cabo de manera eficaz, vamos a tocar algunos aspectos fundamentales. 

El establecimiento de conceptos fundamentales en el diseño del software, se ha dado desde 
hace tres décadas, los cuales ayudan al ingeniero en software a responder a las siguientes 
preguntas: 

-Que criterios pueden usarse para subdividir el software en componente individuales? 

- Como se separan los detalles de una función o una estructura de datos de una repre
sentación concep;ual del software? 

-Existen criterios uniformes que definen la calidad técnica de un diseño de programas? 

Trataremos algunos de estos conceptos, sobre todo aquellos que respondan a las preguntas 
antes mencionadas. Comenzaremos con: 

Refinamiento: 

Es una temprana estrategia de diseño descendente propuesta por Niklaus Wirth, "En cada 
paso del refinamiento, una o varias instrucciones del programa dado se descomponen en más 
instrucciones detalladas. Esta descomposición sucesiva o refinamiento de especificaciones 
termina cuando todas las instrucciones están expresadas en términos del computador usado o 
lenguaje de programación". 

El refinamiento es realmente un proceso de elaboración. Se comienza con una declaración de 
la función (o descripción de la información) que se define en el nivel superior de abstracción, 
es decir, la declaración describe la función o información conceptualmente, pero no se da 
información sobre el funcionamiento interno de la función o la estructura interna de la 
información, el refinamiento hace que el diseñador amplié la declaración original, dando mas 
y mas detalles conforme se produzcan sucesivos refinamientos. 

Arquitectura de software 

Otro concepto es la arquitectura del software y esto alude a dos características importantes :n 
un programa: 

l. la estructura jerárquica de los componentes procedimentales (módulos) 

2. la estructura de datos 

La arquitectura de software se deriva mediante-un proceso de partición, que relaciona a los 
elementos de una solución del software, con partes de un problema real definido 
implícitamente durante el análisis de requerimientos. La evolución del software y la estructura 
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Tema 4. Fundamentos del Diseño de Software 

de datos comienza con una definición del problema. La solución ocurre cuando cada parte del 
problema se resuelve mediante uno o mas elementos de software, en la siguiente figura se 
muestra la representación de esta transición entre el análisis de requerimientos de software 
y el diseño. 

P, 
P, ~ GJ 

P, (' GJ P, 
P, 

5] ~ 
"Problema" e resolver vla software "Solución" software 

Estructura de un programa 

Un concepto mas es la estructura del programa que representa la organizaciónjerarquica de 
las componentes del programa (módulos) e implica una jerarquía de control. Para repre
sentarla se utilizan notaciones diferentes, siendo la mas común el diagrama de árbol, llamado 
diagrama de estructura. En la figura siguiente se muestra un diagrama de árbol,· con una 
profundidad y anchura que indican el numero de niveles de control y expansión global. Notese 
que el abanico de salida es una medida del numero de módulos que están directamente 
controlados por otros módulos, el abanico de entrada indica cuantos módulos controlan 
directamente a un modulo dado. 

Estructura de datos 

Siguiendo con los conceptos, uno mas es la representación de la relación lógica entre los 
elementos individuales de datos, conocidas como estructura de datos, la cual es muy impor
tante y dicta la organización, los métodos de acceso, grado de asociatividad y alternativas de 
procesamiento para la información. 

Algunas estructuras de Batos clásicas, se muestran en la figura. El elemento escalar representa 
un elemento simple de información direccionado mediante un identificador. El vector es un 
conjunto continuo de elementos escalares que pueden ser de una, dos o más dimensiones. La 
lista enlazada esta organizada con elementos escalares, no continuos y pueden ser procesados 
como una lista. Cada nodo o elemento, contiene una organización propia y uno o más 
apuntadores que indican la dirección de memoria del siguiente nodo de la lista. 
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Tema 4. Fundamentos del Diseño de Software 

Procedimientos de software 

El hablar de procedimiento de software, se er.:oca sobre los detalles de procesamiento de cada 
módulo individualmente. El procedimiento debe dar una especificación precisa del 
procesamiento, incluyendo secuencia de sucesos, puntos de decisiones exactos, operaciones 
repetitivas e incluso organización/estructura de datos. 

Existe una relación entre estructura y procedimiento, el procesamiento indicado por cada 
módulo debe incluir una referencia a todos los módulos subordinados del modulo que se 
describe. 

Modularidad 

Cuando se tiene un problema, para resolverlo, es más fácil dividirlo en partes manejables 
llamadas módulos, el modulo es un elemento con nombres y direcciones separadas, los cuales 
se integran para satisfacer los requerimientos del problema. 

Es posible deducir que si subdividimos el software indefinidamente, el esfuerza que se 
requiere para desarrollar será significativamente pequeño. Sin embargo, hay otros factores 
que hacen que esta conclusión no sea del todo aceptada. 

Abstracción 

Al considerar una solución modular a cualquier problema, se pueden formular muchos niveles 
de abstracción, la cual facilita al diseñador representar un objeto de datos a diferentes niveles 
de detalle y especificarlo en el contexto de las operaciones que se le aplican. En el nivel 
superior de abstracción, se establece la solución en términos amplios usando el lenguaje del 
entorno del problema, en los niveles inferiores se toma una orientación más procedimental y 
se establece la solución en forma que pueda implementarse directamente. 

Ocultamiento de la información 

Al especificarse o diseñarse los módulos se debe hacer de tal manera que ia información 
contenida dentro de un módulo sea inaccesible a otros módulos que no necesiten tal 
información. 

, 
Subtema 4.5 Diseño modular efectivo 

En el subtema anterior tratamos acerca de la modularidad, la cual se ha convenido en un 
enfoque aceptado en todas las disciplinas de ingeniería. Algunas ventajas que proporciona el 
diseño modular es que reduce la complejidad, facilita los cambios y da como resultado una 
fácil implementación, posibilita además el desarrollo paralelo de diferentes partes de un 
sistema. 
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Tema 4. Fundamentos del Diseño de Software 

Tipos de módulos 

Los módulos se dividen en categorías, las cuales son: 

- módulo secuencial 
( se llama y ejecuta sin interrupción aparente, son los más comunes y se categorizan 
como macros en tiempo de compilación y subprogramas convencionales, conocidas 
como funciones, procedimientos o subrutinas ) 

- módulo incremental 
( se puede interrumpir antes de la terminación por software de aplicación y rees
tablecido en el punto de interrupción, se les llama comúnmente corrutinas, man
tienen un apuntador de entrada que permite al módulo reestablecer el punto de 
interrupción ) 

- módulo paralelo 
( se ejecuta simultáneamente con otro módulo en multiprocesamientos concurrentes, se 
encuentran en cálculos de alta velocidad que necesitan dos o mas procesadores 
trabajando en paralelo ). 

Independencia funcional 

La comunicación entre módulos no debe ser excesiva y se deben desarrollar con una clara 
función de lo que va a hacer, para llegar a lo que se conoce como independencia funcional. 

Siempre es preferible diseñar software de forma que cada módulo se enfoque a una subfunción 
específica de requerimientos y se tenga una interface sencilla. 

Esta independencia se mide con dos criterios cualitativos: 

-Cohesión 

- Acoplamiento 

Cohesión: 

Al hablar de un móduÍo coherente, se hace referencia a una tarea sencilla en un procedimiento 
de software y requiere poca interacción con procedimientos que ejecutan en otras panes de 
un programa, es decir, un módulo coherente debe hacer sólo una cosa 

La cohesión puede ser representada como el "espectro" mostrado en la siguiente figura, en la 
cual se nota los diferentes tipos de cohesión que se tienen de acuerdo al nivel. 

En la medida de la fonaleza funcional de un módulo, si se ejecutan un conjunto de tareas 
relacionadas con otras debilrnente, se habla de cohesión coincidental, si se relacionan 
lógicamente es cohesión lógica y cuando se contienen tareas relacionadas por el hecho de que 
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se deben ejecutar dentro de un mismo tiempo, se exhibe cohesión temporal. Se puede apreciar 
también que la escala de la cohesión no es lineal, siempre se intenta conseguir un gran 
cohesión, aunque el punto medio del rango del espectro es aceptable. 

Se habla de cohesión procedimental, cuando los elementos de procesamiento de un módulo 
están relacionados y deben ejecutarse en un orden especifico, y cuando los elementos de 
procesamiento se concentran sobre una área de un estructura de datos, se presenta cohesión 
de comunicación. 

No es necesario determinar el nivel preciso de cohesión. Es importante buscar una cohesión 
alta y reconocer la cohesión baja de forma que el diseño del software pueda modificarse, de 
forma que contenga una mayor independencia funcional. 

Acoplamiento 

Otro criterio de medida de independencia, el cual es acoplamiento, que se puede definir como 
la medida de la interconexión entre módulos en una estructura de un programa, que depende 
de la complejidad de la interface entre módulos, del punto en el que se hace una entrada o 
referencia a un módulo y de los datos que pasan a través de la interface. Al igual que la cohesión 
se puede representar por un espectro, en el que se marcan los tipos de acoplamiento. 

El acoplamiento directo se da cuando dos módulos están relacionados en forma directa, el 
acoplamiento de datos es cuando un modulo Bes subordinado de un modulo Ay esta accesible 
mediante una lista de argumentos convencionales, a través de los cuales pasa datos. Al pasar 
una porción de una estructura de datos mediante una interface de módulo que es una variación 
del acoplamiento de datos, se le conoce como acoplamiento por estampado. A niveles 
moderados, el acoplamiento se caracteriza por el paso de control entre módulos, en su forma 
sencilla, el control se pasa mediante un indicador sobre el que se toman las decisiones en un 
módulo subordinado o superior. · 

Se producen niveles altos de acoplamiento, cuando los módulos están ligados a un entorno 
externo al software. El acoplamiento externo es esencial, pero debe limitarse a un pequeño 
numero de módulos dentro de una estructura. Asf mismo a niveles altos de acoplamiento se 
encuentra el acoplamiento común, que se da cuando varios módulos se hace referencia a un 
área de datos global. Y el mayor grado de acoplamiento se da en el acoplamiento por 
contenido, cuando un módulo hace uso de información de control o de datos mantenidos 

' dentro de los limites de otro módulo. 

Subtema 4.6 Diseño de datos 

Una de las mas importantes de las tres actividades de diseño que se realizan durante la 
ingeniería de software, es el diseño de datos. 

Esta actividad como ya mencionamos es la primera en el diseño de datos y se encarga 
principalmente de seleccionar las representaciones lógicas de los objetos de datos, conocidas 
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como estructuras de datos, las cuales se identifican durante las fases de definición y 
especificación de requerimientos. 

Independientemente de las técnicas de diseño usadas, los datos bien diseñados nos pueden 
conducir a una mejor estructura del programa, modularidad y reducción de la complejidad de 
los procedimientos. 

Al especificar los datos tenemos tener presentes los siguientes principios: 

l. Los métodos de análisis sistemático, aplicados al software deben también aplicarse a 
los datos: deben desarrollarse y revisarse las representaciones de flujo y estructura 
de datos, considerar organizaciones alternativas y evaluar el impacto del diseño de 
datos sobre el diseño de software, es decir, si por ejemplo, la especificación de una 
estructura de lista doblemente ligada puede satisfacer agradablemente a los re
querimientos de los datos, pero conducir a un diseño de software difícil de manejar. 

2. Deben identificarse todas las estructuras de datos y operaciones que han de 
ejecutarse sobre cada una de ellas: Si por ejemplo, se considera una estructura de 
datos formado por un conjunto de diversos elementos de datos. La estructura será 
manipulada por varias funciones principales, para la evaluación de la operación 
ejecutada sobre esa estrucr: 7a, se define un tipo abstracto de datos para usarlo en el 
diseño subsecuente del sof¡ware, que puede llegar a simplificar el diseño de sof¡ware. 

3. Deben establecerse y usarse un diccionario de datos para definir el diseño de los 
datos y el software: En el diccionario de datos se representa explícitamente las 
relaciones entre los datos y las ligaduras de los elementos de una estructura de datos. 

4. Las decisiones de diseño de datos a bajo nivel deben retrasarse hasta las ultimas 
etapas del proceso ;e diseño: Puede usarse un proceso de refinamiento sucesivo 
para el diseño de datos, es decir, definir una organización global de los datos 
durante el análisis de requerimientos, refinarse durante el diseño preliminar y 
especificarse en detalle durante el diseño detallado. 

5. La representación de una estructura de datos debe ser conocida sólo por los módulos 
que hagan un uso directo de los datos contenidos dentro de la estructura: Este punto 
hace referencia .a los conceptos antes vistos de ocultación de información y 
acoplamiento, los cuales proporcionan un aspecto importante en la calidad del 
diseño de software. 

6. Debe desarrollarse una biblioteca de estructuras de datos útiles y de las operaciones 
que pueden aplicarse a ellas: Una biblioteca de estructuras de datos, pueden reducir 
el trabajo de especificación y diseño de los datos. 

7. El diseño de software y el lenguaje de programación deben soportar la especificación 
y realización de tipos abstractos de datos: La implementación de una estructura de 
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datos sofisticada puede hacerse excesivamente difícil si no hay forma de realizar una 
especificación directa de la estructura. 

Los principios descritos forman la base de un método de diseño de datos, que puede ser 
integrado en la fase de definición y desarrollo del proceso de ingeniería de software, dado que 
una clara definición de la información es esencial para desarrollar bien el software. 

Subtema 4.7 Diseño Arquitectónico 

El diseño principal del diseño arquitectonico es desarrollar una estructura de programa 
modular y representar las relaciones de control entre los módulos, además mezcla la estructura 
de programas y la estructura de datos, define las interfaces que facilitan el flujo de los datos a 
lo largo del programa. 

Subtema 4.8 Diseño Procedimental 

U na vez que se ha establecido la estructura del programa y de los datos, se realiza el diseño 
procedimental. En este se realiza la especificación procedimental que requiere definir los 
detalles algorítmicos que deben establecerse en un lenguaje natural, existe desafortunada
mente un pequeño problema, en el diseño procedimental debe especificarse los detalles de 
los procedimientos sin ambigüedad y la falta de ambigüedad en un lenguaje natural no es 
corriente. 

Programación Estructurada 

En el desarrollo procedimental se requiere del uso de un lenguaje, como ya mencionamos, sus 
fundamentos se formaron a principios de los años 60, en el cual se propuso el uso de un 
conjunto de construcciones lógicas con las que podría formarse cualquier programa. Cada 
construcción tenía una estructura lógica predecible, se entraba por el principio y se salía por 
el final, y facilitaba al lector seguir más fácilmente el flujo procedimental. Las construcciones 
introducidas anteriormente en la representación de datos, son la secuencia, condición y 
repetición. 

Secuencia: la secuencia, implementa los paso de procesamiento esenciales en la 
especificación de cualquier algoritmo. 

, 
Condición: la condición da la facilidad para seleccionar un procedimiento basado en al-
guna ocurrencia lógica. 

Repetición: la repetición suministra el ciclo. 

Estas tres construcciones son fundamentales en la programación estructurada, la cual es una 
técnica de diseño importante en el campo más amplio de lo que hemos aprendido de ingeniería 
del software. 
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Cualquier programa, independientemente del área de aplicación o complejidad técnica, puede 
diseñarse e implementarse usando sólo las tres construcciones estructuradas. 

Herramientas gráficas de diseño 

Alguien alguna vez dijo: un dibujo vale mas que mil palabras, pero es importante saber que 
dibujo y que miles de palabras" ... No hay duda que las herramientas gráficas, tales como los 
diagramas de flujo o de cajas, dan una excelente forma gráfica de describir fácilmente los 
detalles procedimentales. 

Diagrama de flujo: 

El diagrama de flujo es la representación gráfica más usada para el diseño procedimental. Pero 
también es del que mas se ha abusado. Es un gráfico muy sencillo, una caja indica un paso de 
procesamiento, un rombo representa una condición lógica y las flechas muestran el flujo de 
control. 

La siguiente figura muestra las tres construcciones de programación estructurada. 

,_ .... 

,_ -- -
La secuencia esta representada por dos cajas de procesamiento conectadas por una línea de 
control. 

La condición también llamada IF·THE-ElSE, se dibuja como un rombo de decisión, el cual, 
si es verdad, hace que se realice el.procesamiento de la parte then y si es falso llama al 
procesamiento de la parte del ElSE. 

La repetición se representa usando dos fe,,- illas algo düerentes.l..a forma DO· WHILE prueba 
una condición y ejecuta repetidamente una tarea mientras la condición sea verdadera. La 
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forma REPEAT-UNTIL ejecuta primero el ciclo, luego checa la condición y repite la tarea 
hasta que falla la condición. 

Estas construcciones estructuradas pueden estar anidadas unas en otras como se muestra en 
la siguiente figura. 

Pll ono·'\olso _____ l=;;,~==-===---Pnme•o ¡8 ,
88 -----, 

-
1
- Condic•on 

1¡- -- --~ Siguoente la•eo 

lj ,.~-., ~~ ·
1 

Pone then 
1 1 r---''----, 

Tarea bucle 1 1 c______,c---' 
1 L___ ------· . 1 Condición L_______ __-__ -_ _j del bucle 

Una herramienta mas en el disefto gráfico es el diagrama de cajas, que surgió del deseo 
procedimental que no permitiera la violación de las construcciones estructuradas, y tiene las 
siguientes características: 

- Dominio funcional: 
el ámbito de la repetición o un IF-TIIEN-El.SE, esta bien definido y claramente visible 
como una representación gráfica. 

- Imposible transferencia arbitraria de control 

- Determinación de los ámbitos de los datos locales y/o globales, estos pueden deter
minarse fácilmente. 

- Representación fácil de la recursividad. 

En la siguiente figura,se muestra, la representación gráfica de construcciones estructuradas 
usando diagramas de·cajas, en esta se ve que el elemento fundamental del diagrama es la caja, 
para representar la secuencia se conectan dos cajas seguidas. para representar el IF-lHEN
ElSE, se pone una caja de la parte THEN y otra de la parte El.SE, a continuación de la caja 
de condición. La repetición se dibuja con una caja interior que encierra el proceso que ha de 
repetirse (parte del DO-WHILE o parte REPEAT-UNTIL). 

Y la selección se representa usando la forma gráfica mostrada al final. 
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Selección 

Las llamadas a los módulos subordinados puede representarse mediante una caja con el 
nombre del módulo encerrado dentro de un óvalo. 

Lenguaje de diseño de programas 

Para el diseño de programas se requiere de un lenguaje, llamado pseudocódigo, que es un 
lenguaje mezclado que utiliza el vocabulario de un lenguaje por ejemplo el inglés, y la sintaxis 
general de otro por ejemplo, un lenguaje de programación estructurada. 

La diferencia entre el lenguaje de diseño de programas y un lenguaje de programación de alto 
nivel real se refiere al uso del texto narrativo insenado directamente dentro de las sentencias 
del lenguaje de diseño de programas. 

Independientemente de su origen, un lenguaje de diseño debe tener las siguientes 
características: 

-Sintaxis fija de palabras clave que den todas las construcciones e otructuradas, 
declaraciones de datos y características de modularidad 

- Sintaxis libre en lenguaje natural que describa las características del procesamiento 

- Facilidad para declaración de datos que incluyan las estructuras de datos sencillas (es
calares y arreglos) y complejas (listas ligadas o árboles). , 
- Definición de subprogramas y técnicas de llamada que soponen los distintos modos de 
descripción de interfaces. 

La sintaxis básica del LDP debe incluir: 

- definición de subprograma 

- descripción de interfases 
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- declaración y tipificación de datos 

- técnicas para estructurar en bloques 

- instrucciones de condición 

- instrucciones repetitivas 

- instrucciones de entrada/salida. 

El formato y semántica de un LDP es: 

donde: 

-Instrucción que permite representar las estructuras de datos locales y globales: 

TYPE [nombre-variable] IS [cali.fi.cadorl] [cali.fi.cador2] 

[nombre-varible] - es una varible declarada dentro de un módulo o declarada 
para uso global o entre módulos. 

[cali.fi.cadorl] indica la estructura de datos especifica e incluye palabras 
reservadas como: SCAIAR, ARRA Y, UST, STRING, 
STRUCfURE 

[ cali.fi.cador2] indica como se utilizan los nombres de variables en el 
contexto de un módulo o programa. 

- Elementos procedimentales estructurados en bloques, es decir, pude definirse un 
pseudocódigo en bloques que se ejecute como una entidad simple. 

Un bloque esta delimitado de la siguiente manera: 

BEGIN [nombre-bloque] 

[sentencias de pseudocódigo]; , 

END 

donde, [nombre-bloque] puede usarse para dar un nodo de referencia subsecuente a un bloque 
y [sentencias en pseudocódigo] son una combinación de otras instrucciones en LDP. 
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- Instrucción de condición en LDP, tiene la forma cíásica if-then-else. 

IF [descripción-condición] 

THEN [bloque o sentencia de pseudocódigo]; 

EI...SE [bloque o sentencia de pseudocódigo]; 

ENDIF 

donde, (descripción-condición] indica la decisión lógica que debe hacerse para llamar a la 
pane de procesamiento THEN o EI...SE. 

- Instrucción de selección, es un conjunto de IF anidados, esta instrucción compara un 
parámetro especifico, la variable del case, con un conjunto de condiciones. Cuando se satisface 
una condición, se llama a un bloque o sentencia individual en pseudocódigo. Su representación 
es: 

CASE OF [nombre-variable-case] 

WHEN [condiciónl-case] SELECT [bloque o sentencia de pseudocódigo]; 

WHEN [condición2-case] SELECT (bloque o sentencia de pseudocódigo]; 

WHEN [ultima-condición-case] SELECT (bloque o sentencia de pseudocódigo]; 

DEFAULT [fallo o error del case. bloque o sentencia de pseudocódigo]; 

ENOCASE 

- Instrucción de repetición en LDP, incluye ciclos pre-test y post-test así como un ciclo con 
índice. 

DO WHILE descripción-condición .. 

bloque o sentencia en pseudocódigo 

ENDDO 
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REPEAT UN1TI... descripción-condición 

bloque o sentencia en pseudocódigo 

ENDREP 

DO FOR (índice= lista-índice, expresión o secuencia) 

bloque o sentencia en pseudocódigo 

ENDFOR 

- Los subprogramas y sus correspondientes interfases se definen usando las siguientes instruc
ciones del LDP. 

PROCEDURE [nombre-subprograma)[ atributos) 

INTERFACE [lista-argumentos) 

[bloques y/o sentencias en pseudocódigo]; 

donde, (atributos) de un subprograma describe sus características de referencia (internas o 
externas) y otros atributos dependientes de la implementación (lenguaje de programación) si 
los hubiera INTERFACE se utiliza para especificar una lista de argumentos del módulo que 
contiene los identificadores para la información de llegada y salida. 

- Especificaciones de entrada/salida, dependen mucho de los lenguajes de diseño, las mas 
comunes son: , 

READ/WRITE TO (dispositivo) [lista EIS) 

donde dispositivo indica el dispositivo fisico de·EIS y lista EIS contiene las variables que se 
transmiten. 
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Comparación de notaciones de diseño 

Cualquier notación para el diseño procedimental, si se usa correctamente, puede ser de ayuda 
muy valiosa en el proceso de diseño, es por esto que cualquier comparación debe basarse en 
esta premisa, recíprocamente, incluso la mejor notación, si se aplica mal, añade poco a la 
compresión. Tomando en consideración lo anterior podemos aplicar comparaciones a las 
notaciones: 

Modularidad: 

Una notación de diseño debe soponar el desarrollo de software modular. 

Simplicidad global: 

Una notación de diseño debe ser relativamente sencilla de aprender, relativamente fácil 
de usar y generalmente fácil de leer. 

Facilidad de edición: 

La facilidad con la que una representación de diseño pueda ser editada, puede ayudar a 
facilitar cada uno de estos pasos de la ingeniería de software. 

Legible por la máquina: 

Una notación que pueda ser introducida directamente en un sistema de desarrollo 
basado en computadora, ofrece enormes beneficios potenciales. 

Mantenimiento: 

Es esta la fase mas costosa del ciclo de vida del software. El mantenimiento de la 
configuración de software casi siempre significa mantenimiento de la representación 
del diseño procedimental. 

Exigencia de estructura: 

La notación de diseño que refuerce el uso de únicamente construcciones estrucruradas, 
promueve la pr~ctica de un buen diseño. 

Representación de datos: 

La habilidad para representar los datos locales y globales es un elemento esencial en el 
diseño detallado. Una notación puede idealmente, representar directamente los 
datos. 
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Verificación lógica: 

La verificación automática de la lógica del diseño es un objetivo supremo durante la 
prueba de software. Una notación que la refuerce mejora grandemente la suficiencia 
de la prueba. 

Disposición de la codificación: 

Una notación que se convierta fácilmente a código fuente reduce el trabajo y los errores. 

Parece que un lenguaje de diseño de programas ofrece la mejor combinación de 
características. Se puede insertar directamente en los listados fuente, mejorando de esta forma 
la documentación y haciendo menos difícil el mantenimiento del diseño. 

, 
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El diseño se ha descrito como un proceso multipaso en el que las representaciones de la 
estructura de datos, estructura de programa y procedimiento, se sintetizan a partir de los 
requerimientos de la información. Es además, una actividad referida a la toma de decisiones 
importantes, frecuentemente de una naturaleza estructural. Comparte con la programación 
los aspectos referentes a la abstracción en la representación de la información y en las 
secuencias de procesamiento, pero el nivel de detalles es muy diferente en ambos e ·os. El 
diseño construye representaciones coherentes y bien planificadas de pro0 . amas, 
concentrándose en las interrelaciones de las partes a un nivel más alto y en las operaciones 
lógicas implicadas en los niveles inferiores. 

En este tema trataremos acerca del diseño orientado al flujo de datos (y en general el diseño 
de software), el cual tiene sus orígenes en los primeros conceptos de diseño que aventuraron 
la modularidad, diseño descendente y programación estructurada. Sin embargo, el enfoque 
de diseño orientado al flujo de datos amplió estas técnicas procedimentales, integrando 
explícitamente el flujo de la información en el proceso de diseño. 

Subtema 5.1 Areas de aplicación. 

El diseño orientado al flujo de datos puede aplicarse a un amplio rango de áreas de aplicación. 
Por lo cual es un factor importante de selección de un método de diseño, la amplitud de las 
áreas en la que se aplica. 

Un método de diseño orientado al flujo de datos es particularmente útil cuando la información 
se procesa secuencialmente y no existe una estructura de datos jerárquica. 

Las técnicas de diseño orientadas al flujo de datos se aplican también a aquellas que se 
relacionen con el procesamiento de datos y pueden aplicarse con efectividad, incluso cuando 
existen estructuras de datos jerárquicas. 

Subtema 5.2 Consideraciones sobre el proceso de diseño. 

El diseño orientado al flujo de datos permite una cómoda transición de las representaciones 
de la información a una descripción de diseño de la estructura del programa . 

. -
Esta transición se realiza en cinco pasos: 

1) se establece el tipo del flujo de información; 

2) se indican los límites del flujo; 

3) el diseño de flujo de datos se convierte en la estructura del programa; 

4) se define la jerarquía de control mediante factorización, y 
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5) se refina la estructura resultante usando medidas y heurísticas de diseño. 

Subtema 5.3 Flujo de transformación y Flujo de Transacción. 

Analizaremos ahora dos tipos de flujo de información. Primero veremos el flujo de 
transformación: 

Recordando el modelo fundamental del sistema (diagrama de flujo de datos), la información 
debe entrar y salir en una forma del "mundo externo". Por ejemplo, los datos escritos sobre un 
teclado de una terminal, hablados sobre una línea de teléfono y dibujados sobre una 
presentación gráfica por computadora, son todos formas de información del mundo externo. 
Tales datos externos deben ser convertidos en una forma interna para el procesamiento. 

La historia del tiempo del flujo de datos se muestra en la siguiente figura, en la que se aprecia, 
la información entra al sistema mediante caminos que transforman los datos externos en una 
forma interna y se identifica como flujo de llegada. En el núcleo del software ocurre una 
transición. Los datos de llegada se pasan a través del centro de transformación y comienzan a 
moverse a lo largo de caminos que conducen ahora hacia la "salida" del software, se llaman 
flujo de salida. 

En lo que se refiere al flujo de transacción tenemos que : 

El modelo fundamental del sistema implica un flujo de transformación; el flujo de información 
se caracteriza frecuentemente por un elemento de datos sencillo, llamado una transacción, 
que desencadena otro flujo de datos a lo largo de uno de los muchos caminos. Cuando un DFD 
toma la forma mostrada a continuación, se presenta un flujo de transacción. 

Este flujo de transacción se caracteriza por datos que se mueven a lo largo de un camino de 
llegada que convierte información del mundo externo en una transacción, esta transacción es 
evaluada, y basándose en este valor el flujo se inicia por uno de los muchos caminos de acción. 
El centro de flujo de información desde que salen muchos caminos de acción se llama un centro 
de transición. En un DFD para un gran sistema, pueden presentarse los dos tipos de flujos de 
transformación y de transacción. 

Para completar este punto vamos a definir que es un Análisis de Transformación. 

El análisis de transfo~ación es un conjunto de pasos de diseño que permiten a un DFD, con 
características de flujo de transformación, convertirse en una templeta predefinida para la 
estructura del programa. 

Subtema 5.4 Pasos del diseño. 

Los pasos de diseño comienzan con una revaluación del trabajo hecho durante el análisis de 
requerimientos y luego se va hacia el desarrollo de la estructura del programa. Analicemos 
paso a paso como se lleva a cabo este diseño: 

DECFI -32-

l¡ ~ 

CECAFI 



Representación 
ex tema 

Representac1on 
interna 

CenllO de 
tranaacciOn 

, 

Flujo de llegada Flujo de sahda 

••• 

• • • 



Tema 5 DISEÑO ORIENTADO AL FLUJO DE DATOS. 

Paso l. Revisión del modelo fundamental del sistema. El modo fundamental del sis
tema abarca el nivel 01 DFD y el soporte de la información. En realidad, el paso de 
diseño comienza con una evaluación de la Especificación del Sistema y de la 
Especificación de los Requerimientos del Software. Ambos documentos describen 
el flujo y estructura de la información de la interfase del software. 

Paso 2. Revisión y refinamiento de los diagramas de flujo de datos para el Software. 
Usando la información obtenida de una Especificación de Requerimientos del 
software, se deriva un diagrama de flujos de datos;a nivel 03 para el implicado en 
una transformación ejecuta una función sencilla y diferenciada, el DFD contiene los 
suficientes detalles para un "primer corte" en el diseño de la estructura de programa, 
y procedemos sin más refinamientos. 

Paso 3. Determinar si el DFD tiene características de transformación de transacción, el 
flujo de información de un sistema puede presentarse siempre como transformación. 
Sin embargo, cuando se encuentra una transacción, se recomienda una organización 
de diseño diferente. 
En este paso, el diseñador selecciona una característica global del flujo basándose en la 
naturaleza prevalen te del DFD. Además, se aíslan las regiones locales del flujo de 
transformación o transacción. Estos subflujos pueden usarse para refinar la estruc
-tura del programa derivada de la característica global descrita anteriormente. 

Paso 4. Aislar el centro de transformación especificando los límites del flujo de llegada 
y salida. 
Los límites del flujo de llegada y salida están abiertos a diferentes diseñadores pueden 
seleccionar puntos algo diferentes en el flujo como posiciones límites, pueden 
derivarse soluciones de diseño alternativas variar>~ o la colocación de los límites del 
flujo. 

Paso 5. Realización del "primer nivel de factorización". La estructura del programa rep
resenta una distribución descendente del control. La factorización da como resul
tado una estructura de programa en la que los módulos de nivel superior toman las 
decisiones de ejecución y los módulos de nivel inferior ejecutan la mayoría del 
trabajo de entrada, computacional y de salida. Los módulos de nivel intermedio 
ejecutan algún control y realizan moderadas cantidades de trabajo . 

. · 
Primer nivel de faclorización. 
El número de módulos del primer nivel debe limitarse al mínimo necesario, para que 
puedan realizarse laS funciones de control y mantener al mismo tiempo unas buenas 
características de acoplamiento y cohesión. 

Paso 6. Ejecución del "segundo nivel de factorización". El segundo nivel de 
factorización se realiza mediante la conversión de las transformaciones individuales 
de un DFD, en los módulos correspondientes de la estructura del programa. Comen
zando en el límite del centro de transformación y yendo hacia fuera a lo largo de los 
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caminos de llegada y luego de salida, las transformaciones se convierten en niveles 
subordinados de la estructura del software. 

Una estructura de programa de primer corte puede siempre refinarse aplicando los conceptos 
de independencia de módulos. Se puede aumentar o reducir el número de módulos para 
producir una estructura que pueda implementarse sin dificultad, probarse sin confusión y 
mantenerse. sin problemas. 

El objetivo de los siete pasos procedentes es desarrollar una representación global del 
software. Esto es, una vez que se define la estructura, podemos evaluar y refinar la arquitectura 
del software viéndola como un todo. 

Subtema 5.5 ANALISIS DE TRANSACCION 

En muchas aplicaciones software, un elemento de dato determina uno o más flujos de 
información que afectan a la función implicada por el elemento de dato determinante. El 
elemento de dato, llamado transacción. 

Pasos del diseño 

Los pasos del diseño para el análisis de transacciones son similares y en algunos casos idénticos 
a los pasos para el análisis de transformaciones. La principal diferencia se refiere a la 
conversión del DFD en estructura de programa. 

Paso l. Revisar el modelo fundamental del sistema. 

Paso 2.Revisar y refinar los diagramas de flujo de datos par software. 

Paso 3.Deterrninar si el DFD tiene características de transformación o de transacción. 
De.ben establecerse límites de flujo para ambos tipos de flujo. 

. ~ ~ .. 

Paso 4.1dentificar el centro de transacción y las características del flujo de cada camino 
de acción. La posición del centro de transacción puede discernirse inmediatamente 
a partir del DFD. El centro de transacción está ligado al origen de varios caminos de 
información que fluyen radialmente de el. 

' Paso S.Transformar el DFD en una estructura software adecuada al procesamiento de 
transacciones. El flujo de transacción se convierte en una estructura de programa 
que contiene una bifurcación de entrada y una bifurcacíón de salida o expedición. La 
estructura para la bifurcación de entrada se desarrolla de la misma forma que el 
análisis de transformaciones. 

Paso 6.Factorizar y refinar la estructura de transacciones y la estructura de cada camino 
de acción. Cada camino de acción del diagrama de flujo de datos tiene sus propias 
características de flujo de información, se puede encontrar un flujo de 
transformación de transacción. 
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La transformación crear y visualizar mensaje del DFD se convierte en un módulo de 
utilidad (es decir, un módulo llamado por dos o más módulos) que se utiliza por dos 
estructuras de flujo de acción. 

Paso 7 .Refinar la estructura del software de "primer corte" usando medidas y heurísticas 
de diseño. Criterios tales como independencia de módulos, práctica y mantenimien
to, deben ser considerados cuidadosamente cuando se propagan modificaciones a la 
estructura. 

U na vez que se ha desarrollado la estructura del programa usando el diseño orientado al flujo 
de datos, puede conseguirse una modularidad efectiva aplicando los conceptos introducidos 
en el tema anterior y manipulando la estructura resultante de acuerdo al siguiente conjunto 
de criterios. 

l. Evaluar la estructura de programa preliminar para reducir el acoplamiento y mejorar 
la cohesión. Los módulos pueden expandirse o reducirse con la mirada puesta en la 
mejora de la independencia de los módulos. 

II.Intentar minimizar las estructuras con un abanico de salida ancho; fomentar los 
abanicos de entrada conforme se incrementa la profundidad. 

III.Mantener el efecto de un módulo dentro del ámbito de control de ese módulo. 

IV.Evaluar las interfases de los módulos para reducir la complejidad y redundancia y 
mejorar la consistencia. 

V. Definir módulos cuyas funciones sean predecibles, pero evitar módulos que sean_ 
demasiado restrictivos. 

VI.Buscar los módulos de una única entrada y una única salida, evitando las conexiones 
patológicas. · 

VII.Empaquetar el software basándose en las restricciones del diseño y requerimientos 
de transportabilidad. 

En forma global, pod~mos decir que las técnicas expuestas en este tema conducen a una 
descripción del diseño preliminar del software. Se definen módulos, se establecen las inter
fases y se desarrollan las estructuras de datos. Estas representaciones del diseño forman la 
base de todo el trabajo posterior de desarrollo. 
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Tema 6 Diseño Orientado a las Estructuras de Datos 

En este tema trataremos la relación entre el software y datos, la cual siempre ha existido desde 
los orígenes de la computación, comenzaremos diciendo que la estructura de la información 
llamada estructura de datos, es un factor que tiene impacto en la complejidad y eficiencia de 
los algoritmos diseñados para procesar la información. 

La identificación de las estructuras de datos inherentes es vital y la estructura de los datos 
puede usarse para derivar la estructura de un programa. 

Los datos de entrada, internamente información almacenada y los datos de salida, pueden 
tener cada uno una estructura única. El diseño orientado a la estructura de datos hace uso de 
estas estructuras como base para el desarrollo de software. 

Nos daremos cuenta a lo largo de este tema que las estructuras de datos son tan importantes 
dado que afectan al diseño tanto en el aspecto estructural, como procedimental del software. 
Transforma además una representación de la estructura de datos en una representación de 
software, los creadores del diseño orientado a la estructura de datos han de definir un conjunto 
de procedimientos de transformación que utilizan la estructura de la información( datos) como 
guía. 

Subtema 6.1 Técnicas de estructura de datos frente a las de flujo de datos 

Antes de considerar las diferencias entre el diseño orientado al flujo de datos y orientado a la 
estructura de datos, es importante hacer mención que ambos comienzan en los paso de análisis 
que conducen a los siguientes pasos de diseño. Ambos son conducidos por la información; 
ambos intentan trartSformar la información en una representación de software. 

El diseño orientado a la estructura de datos no hace un uso explícito de un diagrama de flujo 
de datos. El objetivo último de los métodos orientados a la estructura de datos es producir una 
descripción procedimental del software. El concepto de estructura modular de programa no 
se considera explícitamente. El diseño orientado a la estructura de datos hace uso de un 
diagrama jerárquico para representar la estruCtura de la información. 

Subtema 6.2 Consideraciones sobre el proceso de diseño 

El análisis de requerimientos del software permanece como la base del diseño orientado a la 
estructura de datos. La descripción del dominio de la información (estructura, contenido y 
flujo de datos) contenida en la Especificación de Requerimientos de Software prefigura la 
arquitectura del software que ha de desarrollarse durante del diseño. 

Los métodos orientados a la estructura de datos tienen su propio conjunto de reglas. Sin 
embargo, las tareas de diseño que deben siempre realizarse son: 

1.- evaluar las características de la estructura de datos 

DECFI - 1- CECAFI 

5.) 



Tema 6 Diseño Orientado a las Estructuras de Datos 

2.- representar los datos en ténninos de formas elementales, tales como secuencia, 
selección y repetición. 

3.- transformar la representación de la estructura de datos en una jerarquía de control 
para el software 

4.- refinar la jerarquía del software usando los criterios definidos como parte de un 
método 

5.- desarrollar finalmente una descripción procedimental del software. 

Sub tema 6.3 Descomposición usando estructuras de datos. 

Los orígenes del diseño orientado a la estructura de datos pueden dirigirse a las dos técnicas 
de descomposición usando estructuras de datos desarrolladas en forma independiente y 
prácticamente al mismo tiempo por Jackson en Inglaterra y Warnier en Francia. 

Estas técnicas están basadas en el principio de correspondencia entre la estructura del 
programa y la del problema que la programación pretende resolver. Como generalmente el 
problema a resolver consiste en el procesamiento de datos, la estructura del programa deberá 
corresponder a la estructura de los datos que procesa. Jackson menciona: "si un programa no 
corresponde al ambiente del problema, el programa no es ni pobre ni malo: es incorrecto". 

Para comprender mejor es_to, consideremos el siguiente problema: 

En un almacén de una fábrica se requiere producir un reporte que presente el movimiento 
~eto de productos (artículos, piezas, partes, etc}, que el almacén compra y vende. Se cue-nta 
con un sistema de cómputo que tiene un archivo maestro de transacciones, en donde se registra 
cada venta y cada compra. Los registros del archivo contienen, entre otras variables, el número 
de identificador del artículo, el tipo de movimiento (venta o compra) y la cantidad. El archivo 
se encuentra clasificado por número de artículo, de tal forma, que todos los registros que 
representan los movimientos que ha tenido un artículo se encuentran secuencialmente ligados. 

El programa deberá producir el movimiento neto de cada artículo y al final resumirá el total 
de productos que sufrieron movimientos. El repone final deberá tener el formato como se 
muestra en la figura .... , 
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La estructura dei programa deberá derivarse de la estructura de datos. Puesto que se desea 
obtener una estructura jerárquica, los datos serán analizados jerárquicamente. El diagrama 
de estructura de los datos, así como el diagrama de estructura de programa, representan la 
relación "es compuesto de". Por ejemplo, como entrada al programa tenemos el archivo de 
transacciones que "es compuesto de " un grupo de registros y cada grupo de registros "es 
compuesto de" registros individuales y, finalmente, cada registro es de uno de dos tipos: venta 
o compra, en el diagrama siguiente se puede apreciar lo anterior ... 

... 
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~----
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Por otro lado, a la salida del programa el reporte "es compuesto de" un encabezado, un cuerpo 
(todos los movimiento& netos) y el resumen. 

La estructura del programa se deriva de la estructura del reporte y de la de los datos de entrada 
al programa: el programa que produce el reporte "es compuesto de "un módulo que produce 
el encabezado, de un módulo que produce el cuerpo y de uno que produce el resumen. A su 
vez, el módulo que produce el cuerpo contiene un módulo que procesa un grupo de registros, 
requiriendo al mismo tiempo, de un módulo que emplea un registro y finalmente, dado que 
los registros son de dos tipos, se necesitaran dos diferentes módulos: uno para analizar los de 
tipo de venta y otro para consumir los de tipo compra, como se aprecia en la figura. 
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Como puede apreciar, una pane del diagrama de estructura del programa que produce el 
reporte corresponde a la estructura de los datos de entrada (el archivo de transacciones), y 
otra pan e corresponde a la estructura de los datos de salida (el reporte). 

Subtema 6.4 Areas _e aplicación 

El diseño orientado a la estructura de datos puede aplicarse con éxito a aplicaciones que tengan 
una estructura jerárquica, bien defmida, de la información. Algunas son: 

- Aplicaciones en sistemas de información comerciales. 

La entrada y salida tiene distinta estructura (como en el ejemplo anterior), el uso de una base 
de datos jerárquica es frecuente. 

-Aplicaciones de sistema 

La estructura de datos para Jos sistemas operativos comprende muchas tablas, archivos y listas 
que tienen una estructura bien definida. 

- Aplicaciones de CAD/CAM/CAE 

Los sistemas de diseño/fabricación/ingeniería asistidos por computadoras requieren estruc
turas de datos sofisticadas para el almacenamiento, traducción y procesamiento de 
información. 

- Aplicaciones del dominio de la ingeniería y de la ciencia. 

El diseño orientado a la estructura de datos es mas diflcil de aprender y mas complicado de 
aplicar que las técnicas orientadas al flujo de datos. Sin embargo, el diseño orientado a la 
estructura de datos ofrece un enfoque más rico y potencialmente, más poderoso para el diseño 
de software. 
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En este tema trataremos el diseño orientado al objeto, año con año se logran avances que 
conducen a la construcción de computadoras mas veloces, mas compactas y baratas; sin 
embargo, el aspecto de software no se ha desarrollado en forma similar, mientras los costos 
de hardware han disminuido continuamente, los de software han hecho lo contrario. No es 
una tarea fácil la construcción de software y en varias ocasiones los proyectos de programación 
sobregiran los presupuestos de tiempo y dinero. 

El problema del mantenimiento de software 

Como ya hemos mencionado en temas anteriores la construcción de software ha sido la 
principal preocupación de los expenos por lo que se han conseguido avances significativos 
para la construcción de programas en forma sistemática y a bajo costo. Algunos de los 
resultados de estos esfuerzos son las técnicas que con el diseño estructurado y el desarrollo 
descendente (top-down), han sido utilizadas durante mucho tiempo por los programadores. 
Pero hay aun tres grandes deficiencias: 

- los productos que resultan de emplear estas técnicas son poco flexibles 

· - los programadores que las usan tienden a concentrarse en el diseño e implementación 
inicial del sistema, sin tomar en cuenta su vida posterior. 

- no alientan al programador a aprovechar el trabajo de proyectos anteriores. 

Una desventaja de utilizar una metodología que se concentra en el diseño inicial del sistema 
se hace evidente si se considera que la vida útil de un producto de software puede ser cinco o 
seis veces mas grande que el lapso en que se desarrolla. Los gastos que se hacen durante el 
último período (gastos de mantenimiento) representan el 70% del costo total del sistema. 
Alrededor del42% del costo total se tienen que hacer por cambios en las especificaciones del 
usuario o en los formatos de los datos. Es por ello que la extensibilidad (la facilidad con que 
se modifica un sistema para que realice nuevas funciones) debe ser uno de los objetivos 
primarios de la etapa de diseño. 

En la fase de mantenimiento es muy irnponante que cualquier método de diseño tenga como 
objetivo principal producir sistemas que faciliten su propio mantenimiento. Para ello se 
recomienda una serie de actividades y heurísticas que pueden servir como gufa durante el 
desarrollo del sistema. 

Reutilización de código 

Otro de los factores que no se toma en cuenta en los métodos de diseño tradicionales es la 
reutilización de código. Cualquier programador que desarrolla un sistema nuevo debe escribir 
una buena cantidad de código que ha escrito anteriormente una y otra vez. Las rutinas de 
búsqueda, ordenamiento, manejo de menús y despliegue de ventanas, se repiten continua-
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mente en proyectos diferentes. Los métodos de desarrollo de software deben alentar al 
programador a utilizar el código escrito previamente por el mismo o por otros programadores. 

Se han empleado tres tipos de reutilización: 

- de personal: un proyecto nuevo se le asignan a programadores que tienen experiencia 
en el desarrollo de proyectos semejantes. 

- de diseño: consiste en emplear el diseño de un sistema para desarrollar otro sistema 
similar 

- de código fuente: se da cuando un programador utiliza pane de un programa escrito 
con anterioridad para crear un nuevo programa. 

Sin embargo, estas tres formas de reutilización se han empleado en forma muy limitada, por 
lo que es necesario buscar técnicas mas generales. 

Modularidad 

En temas anteriores mencionamos una de las herramientas de diseño más poderosa para 
facilitar el desarrollo y mantenimiento de sistemas de software, la modularidad. En este tema 
trataremos algunas de las caracteósticas de esta herramienta. 

Como recordaran, la modularidad es dividir un sistema complejo en unidades mas pequeñas 
y manejables, cada una de esas unidades se encarga de manejar un aspecto local de todo el 
sistema, interactuando con otros módulos para cumplir con el objetivo global. 

El concepto de módulo es aún mas sofisticado. Entre las propiedades que tiene están: la 
decomponibilidad, componibilidad, comprensibilidad, continuidad y protección. 

a) Decomponibilidad: Un método modular debe permitir descomponer un problema de 
diseño en problemas más pequeños que pueden resolverse en forma independiente. 

b) Componibilidad: una vez que se cuenta con un conjunto de módulos que realizan una 
función especifica, se debe alentar al programador a usar esos módulos para con-
struir nuevos programas. 

' 
e) Comprensibilidad: El lector de un programa o libreóa debe ser capaz de entender el 
funcionamiento de cada módulo sin necesidad de consultar el texto de otros 
módulos. 

d) Continuidad: un cambio pequeño en las especificaciones de un programa debe 
causar cambios en un sólo módulo ó en un conjunto pequeño de ellos. 

e) Protección: un error de ejecución en el funcionamiento de un modulo no debe expan
dirse hacia los demás módulos. 
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Para alentar estas propiedades se utilizan las siguientes estrategias: 

Primero: Un modulo debe corresponder con una unidad sintáctica del lenguaje. 

Segundo: Los módulos deber tener pocas interfaces (medio de comunicación entre módulos) 
y estas debe ser pequeñas. Un número pequeño de interfaces aumenta la independencia de 
los módulos, haciendo mas fácil el proceso de componer nuevos sistemas a partir de módulos 
prefabricados, ayuda además a evitar que los errores de un módulo se propaguen por todo el 
sistema. 

y Tercero: Cada módulo debe ocultar su implementación y algoritmos internos al resto del 
sistema. No se debe permitir que un módulo modifique los elementos internos de otros 
módulos. 

Diseño orientado a objetos 

El diseño orientado a objetos (000), es un método que tiene como objetivo establecer 
técnicas de desarrollo de software para producir sistemas modulares. Un sistema orientado a 
objetos se puede entender fácilmente, facilitando así su desarrollo, depuración y mantenimien
to. 

El 000, se basa en un medida sencillas; un sistema de computadora es un modelo que 
representa un subconjunto del mundo real; la estructura de ese sistema se simplifica en gran 
medida si cada una de las entidades u objetos, del problema que se esta modelando cor
responde directamente con un objeto que se pueda manipular internamente en el sistema. 

El proceso de representar entidades reales con elementos internos en un sistema recibe el 
nombre de abstracción de datos. 

La abstracción de datos no se concentra en la representación interna de un objeto (una cadena, 
un arreglo, un entero, etc.) 

sino en sus atributos y en las operaciones que se pueden realizar sobre ese objeto. De esta 
forma, un tipo de dato abstracto se puede describir concentrándose en las operaciones que 
manipulan a los objetos de ese tipo, sin caer en los detalles de representación y manipulación 
de datos. , 

La creación de tipos abstractos permite al diseñador adaptar el diseño a sus necesidades 
especificas, se debe ser capaz de definir tipos de datos que se ajusten al problema que se esta 
resolviendo y que puedan ser manipulados después por el lenguaje. Concentrándose así en los 
objetos que manipula su sistema y las relaciones entre estos objetos, haciendo a un lado la 
representación y manipulación de datos, para comprender mejor el problema. 
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Conceptos 

Bien, ahora para entender un poco mas acerca del diseño orientado a objetos (DOO), 
trataremos algunos conceptos: 

ClASE: 

Es un tipo abstracto del diseño orientado a objetos, una clase describe un conjunto de objetos 
semejames. Dicha descripción se hace en dos partes: 

-los datos que especifican las propiedades de los objetos de esa clase, llamados 
atributos. 

- y las funciones que manipulan esos datos, llamados métodos. 

Un objeto puede recibir mensajes de otros objetos; entonces, debe escoger uno de sus métodos 
y dar una respuesta basándose en los datos que representan su estado. 

ELEMENTOS PRIVADOS Y PUBLICOS 

Cada objeto cuenta con elementos privados, que solo pueden ser usados por objetos de su 
ntisma clase. Los elementos públicos representan la interface de un objeto con su medio 
ambiente, únicamente esos elementos pueden modificar a los datos privados, los cuales 
representan el estado del objeto. 

Se proponen dos estrategias para la reutilización de código: la composición y la herencia. 

La COMPOSICION permite definir una nueva clase de objetos mediante la unión de un 
conjunto de clases ya existentes. 

La HERENCIA permite derivar una nueva clase basándose en otra clase mas general. Una 
clase derivada adquiere todas las propiedades y métodos de la clase de la que se derivo, llamada 
clase base. 

Además de facilitar la reutilización de código, la herencia es un medio ideal para crear sistemas 
con alta extensibilidad. Otra ventaja de esta técnica es que permite manipular objetos de clases 
diferentes como si fueran de la ntisma clase, con lo cual es posible definir interfaces uniformes 
para diferentes tipos de objetos. 

Lenguajes orientados a objetos 

Las técnicas en las que se basa el diseño orientado a objetos como son ocultamiento de 
información, abstracción de datos, manejo de clase, eran conocidas y utilizadas por los 
ingenieros de software desde hace muchos años, sin embargo hay pocos lenguajes que brindan 
todas las facilidades para escribir programas orientados a objetos, algunos de los mas populares 
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ELEMENTOS PRIVADOS Y PUBliCO S 

son Simula67, Smalltalk, Eiffe~ Ada o Modula Estos lenguajes orientados a objetos no hablan 
tenido hasta hace poco una aceptación amplia entre la comunidad de programadores. 

, 
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TEMA 8. IMPLEMENTACION DEL SISTEMA 

Introducción 

Hasta el momento hemos aprendimos cómo se efectúa el análisis del sistema; es decir cómo 
elaborar un estudio de necesidades y requerimientos de nuestro sistema de información antes 
de desarrollarlo. 

Posteriormente, conocimos las técnicas para diseñar, con base al análisis previo, nuestro 
sistema, orientándolo al medio en el que se desarrollará y aplicará. 

Ahora sabremos cómo desarrollar nuestro sistema tomando en cuenta las especificaciones del 
diseño y el equipo de cómputo seleccionado. 

En este tema conoceremos las formas de plasmar en un equipo de cómputo el diseño de un 
sistema. Para ello contamos con cuatro subtemas: 

Introducción 

Técnicas de codificación estructurada 

Estándares de Implementación y 

Documentación 

Subtema 8.1 Introducción 

Hasta ahora hemos hablado de cómo efectuar el análisis y el diseño de un sistema que van 
dirigidos hacia un objetivo final: la traducción de las especificaciones del diseño a una forma 
que puede ser "comprendida" por una computadora. Hemos llegado finalmente al paso de la 
codificación. El objetivo principal de la implementación del sistema es el escribir código fuente 
así como la documentación interna de modo que la concordancia del código con sus 
especificaciones sea fácil de verificar, así como facilitar la depuración, las pruebas y 
modificaciones al sistema. Para ello se debe elaborar un código claro utilizando 3 parámetros: 

Técnicas de codificació¡¡. estructurada 

Estándares de implementación y 

Documentación. 

Cada uno de estos puntos lo tocaremos específicamente en los siguientes subte mas. 
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TEMA 8.1MPLEMENTACION DEL SISTEMA 

SuLtema 8.2 Técnicas de codificación estructurada. 

Las técnicas de codificación tienen como fin facilitar la traducción del diseño detallado de los 
módulos que componen un programa a un lenguaje de programación específico, manteniendo 
la estructura jerárquica definida en la fase de diseño. 

La programación estructurada es la aplicación de métodos básicos de descomposición de 
problemas para establecer una estructura jerárquica fácilmentC? manejable a través del proceso 
de refinamiento progresivo. Es decir, cualquier módulo, aún el más complicado, se detalla 
utilizando las reglas básicas de la programación estructurada que son: 

Secuencia 

Decisión 

Repetición 

A continuación explicaré cada una de estas reglas. 

La secuencia se define como una estructura de proceso que consiste en enunciar, una después 
de otra, una serie de instrucciones. 

l 
A=lO 

8=40 

PROCESA(A,B) 

, 

Gráficamente se representa como se muestra en la figura, en donde cada instrucción está 
encerrada en un cuadro y mantiene unajerarqu!a. Esto es, se van ejecutando las instrucciones 
una después de la otra. 
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A=lO 

B=40 

PROCESA(A,B) 

TEMA 8.1MPLEMENTACION DEL SISTEMA 

Esta figura muestra un ejemplo en donde está parte de un programa que contiene instrucciones 
simples exclusivamente. Una proposición simple puede ser una asignación o un llamado a un 
procedimiento; una proposición compuesta es un if-then-else o un while-do. Todas estas 
proposiciones Sé pueden presentar como una secuencia 

La segunda regla básica, la decisión, es una estructura de proceso que permite especificar 
alternativas en la ejecución de instrucciones, dependiendo de una condición. 

V A>B r 

PRINT A PRINTB 

Gráficamente se representa como se ve en la figura, en donde la condición que determinará 
la alternativa a seleccionar está en un rombo y de éste se desprenden las alternativas a seguir. 

Un ejemplo de codificación de una decisión se muestra a continuación. Las alternativas a 
realizar se presentan con ciena sangría para detectar con facilidad la dependencia de su 
ejecución con respecto a la condición. Comunmente se utiliza la proposición if-then-else para 
su construcción. 
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IF A>BlHEN 
PRINTA 

ELSE 
PRINTB 

ENDIF 

TEMA 8.1MPLEMENTACION DEL SISTEMA 

Y la última regla básica, la repetición, es una estructura de proceso que permite la 
especificación de la ejecución iterativa de una serie de instrucciones. 

En la figura se puede observar la representación gráfica de la repetición. La condición que 
determinará el número de iteraciones está encerrada en un rombo. 

A< lO r 

A=A+l 

PRINT A 

Al codificar una repetición, como se muestra en la figura, se deberán sangrar las instrucciones 
que se estarán iterando. Es común utilizar las proposiciones while-do o repeat-until para 
codificar la estructura'de repetición. 

DECFI 

WHILE A<lO 
A=A+l 
PRINT A 

END 
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TEMA 8. IMPLEMENTACION DEL SISTEMA 

Una vez que han quedado claras las tres reglas básicas de la codificación estructurada, 
podemos decir que la programación estructurada se basa en un teorema el cual establece lo 
siguiente: 

Cualquier módulo de un programa con una entrada y una salida que tenga todas las 
proposiciones en algún camino de la entrada a la salida puede especificarse usando solamente 
secuenciación, decisión y repetición. 

La propiedad de una entrada y una salida permite el anidamiento de construcciones dentro 
de otra en cualquier forma que se desee. Esto es, por ejemplo, si tenemos una proposición de 
decisión, una alternativa puede ser otra proposición de decisión que a su vez una de sus 
alternativas sea otra proposición de decisión. La codificación correspondiente a este ejemplo 
se muestra en la figura. 

WHILE A>B 

END 

A=A-1 
WHlLE B>O 

B=NB 
WHILE 8>1 

PRINTB 
END 

END 

El proceso de la codificación, que es la comunicación entre los humanos y las computadoras 
mediante un lenguaje de programación, es una actividad humana y es por ello que las 
características del lenguaje afectan directamente a la calidad de la comunicación, tienen un 
impacto importante sobre el éxito de un proyecto de desarrollo de software y pueden 
influenciar la calidad del diseño (ya que prácticamente el diseño detallado se dirige hacia un 
lenguaje de prr:ogramación específico). 

La elección de un lenguaje de programación para un proyecto específico debe tener en cuenta 
sus características y ciertos criterios. 

, 
El problema asociado con la elección del lenguaje puede desaparecer si solo se dispone de un 
lenguaje o si el cliente demanda uno en particular. 

Los criterios que se aplican durante la evaluación de los lenguajes disponibles están: 

1) are a de aplicación general 

2) complejidad algorítmica y computacional 
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TEMÁ 8. IMPLEMENTACION DEL SISTEMA 

3) entorno en el que se ejecutará el software 

4) consideraciones de rendimiento 

5) complejidad de las estructuras de datos 

6) conocimiento de la plantilla de desarrollo de software y 

7) disponibilidad de un buen compilador o compilador cruzado. 

Actualmente Ces el lenguaje elegido comunmente en el desarrollo de software de sistemas. 

Y volviendo con las técnicas de codificación estructurada podemos decir que en un nivel 
fundamental, todos los lenguajes modernos permiten al programador representar secuencias, 
decisiones y repeticiones -que son las construcciones lógicas de la programación estructurada. 
La mayoría de los lenguajes de programación modernos proporcionan un sintáxis para la 
especificación directa del if then else, del do while y del repeat until. Otros lenguajes, como 
Lisp y APL, requieren que el programador emule esas construcciones dentro de los lfmi tes de 
sintaxis del lenguaje. 

Con frecuencia se menciona que el apegarse estrictamente a las técnicas de codificación 
estructurada existe la necesidad de emplear variables auxiliares, segmentos de código repetido 
y un excesivo llamado a subprogramas, dando como resultado una utilización ineficiente del 
espacio de memoria y del tiempo de ejecución. Es por ello que hablaré de la eficiencia de 
código. 

La eficiencia del código fuente está directamente unida a la eficiencia de los algoritmos 
definidos durante el diseño detallado. Sin embargo, el estilo de codificación puede afectar a 
la velocidad de ejecución y a los requerimientos de memoria. Las siguientes directrices se 
deben seguir siempre en el proceso de traducción del diseño detallado al código: 

- Simplificar las expresiones aritméticas y lógicas antes de convertirlas en código. 

- Evaluar cuidadosamente las iteraciones anidadas para determinar si se pueden sacar 
fuera de ellos algunas sentencias o expresiones. 

, 
- Cuando sea posible, evitar el uso de arreglos multidimensionales. 

- Cuando sea posible, evitar el uso de apuntadores y listas complejas. 

- Usar rápidas operaciones aritméticas. 

- Usar cuando sea posible aritmética entera y expresiones Booleanas o lógicas. 
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TEMA 8. IMPLEMENTACION DEL SISTEMA 

Por lo anterior, podemos decir que las técnicas de codificación estructurada no son en sí las 
que propician la ineficiencia sino los algoritmos y las estructuras de datos los que afectan la 
velocidad de ejecución y el espacio en memoria respectivamente. 

Subtema 8.3 Estándares de Implementación. 

• A continuación veremos qué son y para qué nos siiVen los estándares de implementación, 
dentro de la implementación de un sistema. 

Los estándares de :odificación son especificaciones para un estilo de codificación preferido. 
Dada una situacion de elegir los caminos para lograr un efecto, se especifica un camino 
preferido. Los estándares de codificación a menudo son vistos por los programadores como 
mecanismos para restringir y devaluar las habilidades para resolver problemas creativos de los 
programadores. La creatividad siempre ocurre dentro de u~ 11arco de trabajo básico de 
estándares. Los artistas siguen los principios básicos de estructura y composición, los poetas 
se apegan al ritmo y a la métrica del lenguaje. Sin un marco de trabajo de estándares que guíen 
y canalicen una actividad, la creatividad se vuelve un caos sin sentido. 

Así, es deseable que todos los programadores de un proyecto adopten un estilo de codificación 
similar, de modo que se produzca un código de calidad uniforme. 

Algunos de los estándares que se pueden aplicar en todas las situaciones son: 

- El uso de la instrucción GOTO debe evitarse en circunstancias normales. Esto es, utilizarse 
únicamente para lograr el formato de las construcciones de la codificación estructurada en los 
lenguajes primitivos. La proposición GOTO es valiosa para las salidas múltiples y prematuras 
de los ciclos, y para transferir el control al código manipulador de errores. Como pueden 
obseiVar en su pantalla tenemos primeramente un código en el que se emplea la instrucción 
GOTO sin necesidad y posteriormente cómo debe ser. 

- Introdúzcanse tipos de datos definidos por el usuario. Muchos lenguajes de programación 
proporcionan tipos de datos definidos por el usuario. El uso de distintos tipos de datos hace 
posible distinguir las entidades propias del problema. Por ejemplo si definimos un tipo de 
datos llamado color y declararnos los colores: amarillo, rojo, azul, verde y anaranjado; podemos 
saber que únicamente, de toda la gama de colores que existen, se van a utilizar esos. 

' - Examínense cuidadosamente las rutinas que tengan menos de 5 o más de 25 proposiciones. 
Un subprograma que tiene más de 25 proposiciones ejecutables probablemente contiene una 
o más subfunciones bien definidas que pueden agruparse como subprogramas distintos e 
invocarse cuando se necesiten. Se dice también que 30 proposiciones ejecutables es el límite 
superior de compresión para una sola lectura de un subprograma escrito en un lenguaje de 
programación. Un subprograma que tiene menos de cinco proposiciones normalmente es muy 
pequeño para proporcionar una función bien definida. Existen excepciones obvias a estos 
principios generales: por ejemplo rutinas para obtener el valor absoluto o el módulo de un 
número y que tiene menos de 5 llneas pueden ser muy útiles. 
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TEMA 8.1MPLEMENTACION DEL SISTEMA 

- Utilíncese sangrías, paréntesis, espacios y líneas en blanco, así como márgenes alrededor de 
los bloques de comentarios para aumentar la legibilidad. Si el formato del texto fuente lo 
hacen varios programadores, todos ellos deben acordar y apegarse a condiciones estándar. 

- Proporciónense prólogos estándares de documentación para cada subprograma Un prólogo 
de documentación contiene la información acerca de un subprograma o una unidad de 
compilación que no resulta obvia al leer el texto fuente del subprograma o unidad de • 
compilación. 

- Aíslense las dependencias de la máquina en unas cuantas rutinas. Si se necesita cambiar la 
naturaleza de la representación de datos, o si el programa se cambia a una máquina diferente, 
se localizan los detalles de la dependencia de la máquina y pueden modificarse en consecuen
Cia. 

- La profundidad de anidamiento de la construcciones de un programa debe ser de cinco o 
menos. Si el anidamiento se vuelve demasiado profundo, se vuelve difícil determinar las 
condiciones bajo las cuales se va a ejecutar la proposición más anidada. 

La claridad de un programa depende en gran medida, del estilo del programador. Si bien los 
principios de un buen estilo de programación no pueden ser expresados como reglas mecánicas 
de la buena programación, ia experiencia nos indica que los estándares pueden servir como 
"guías de estilo". 

Subtema 8.4 Documentación. 

La programación por computadora incluye el código fuente de un sistema y todos los documen
tos de apoyo generados durante el análisis, diseño, implementación, pruebas y mantenirnien
todel sistema. 

Las especificaciones de requisitos, documentos de diseño, planes de prueba, manuales de 
usuario y los reportes de mantenimiento son ejemplos de documentos de apoyo. Estos 
documentos son los productos que resultan del desarrollo y mantenimiento sistemático de la 
programación. 

Un enfoque sistemático al desarrollo de la programación garantiza que los documentos de 
apoyo se desarrollen ge una manera ordenada y que esos documentos se encuentren dis
ponibles cuando se necesiten. Estos documentos deben desarrollarse como un producto 
natural paralelo al proceso de desarrollo. La calidad, cantidad, duración y utilidad de los 
documentos de apoyo son las principales medidas de la salud y la bondad de un proyecto de 
programación. 

Los documentos sirven para explicar y/o aclarar lo que sucede en el flujo de control de un 
programa. Existen dos tipos de Documentación: 

- Documentación interna 
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TEMA 8.IMPLEMENTACION DEL SISTEMA 

- Comentarios explicativos del cuerpo del módulo. 

La documentación interna consiste en un prólogo estándar para cada unidad de programa, los 
aspectos autodocumentados del código fuente y los comentarios internos intercalados en la 
porción ejecutable del código. 

La mejor documentación de un programa de computadora la constituye la claridad de su 
estructura; además la documentación más confiable de un programa es el cóé¡go mismo. Por 
lo tanto se recomienda la selección de lenguajes que estimulen una programación legible y 
estructurada, evitando la necesidad de instrucciones de flujo arbitrariamente complicadas. 

El formato característico de los prólogos de subprogramas es: 

Nombre del autor: 

Fecha de terminación: 

Función realizada: 

Rutinas que lo invocan: 

Rutinas que invoca: 

Autor/fecha/modificación: 

Resumen 

La implementación de un sistema tiene por objetivo obtener un código fuente claro, que 
facilite la depuración, prueba y modificación y que estas actividades consuman una gran 
porción de la mayor pane de los presupuestos en la programación. 

En este tema se analizaron las técnicas de la codificación estructurada, el estilo de codificación, 
estándares y principios generales y la documentación interna y de apoyo del código fuente. 

, 
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TEMA 9. Verificación y validación del Sistema 

En el te -:o a anterior conocimos las técnicas y consideraciones para implantar nuestro sistema 
de infc .ación en un equipo de cómputo elegido; sin embargo es muy importante efectuar 
verificaciones o pruebas en su implementación para obtener un sistema confiable y eficiente. 
El desarrollo de sistemas de software envuelve una serie de actividades de producción en las 
que las posibilidades de que aparezca la falla humana son enormes. Los errores pueden darse 
desde el primer momento del proceso en el que los objetivos se pueden especificar de forma 
errónea o imperfecta, as! como los errores que aparecen en los posteriores pasos de diseño y 
desarrollo. Debido a la imposibilidad humana de trabajar y comunicarse de forma perfecta, el 
desarrollo de software ha de ir acompañado de una actividad que garantice la calidad. 

Los objetivos de las actividades de verificación y validación son el valorar y mejorar la calidad 
de los productos de trabajo generado durante el desarrollo del diseño y la implementación. 

La verificación se refiere al conjunto de actividades que aseguran que el software implementa 
correctamente una función específica. La validación se refiere a un conjunto diferente de 
actividades que aseguran que el software construido se ajusta a los requerimientos del cliente. 
Podemos establecer como 

Verificación al hacer la pregunta: ¿Estamos construyendo correctamente el producto? es 
decir, cómo estamos construyendo el producto, ¿de manera adecuada?. Mientras que para 
establecer a la validación podemos hacer la pregunta: ¿Estamos construyendo el producto 
correcto? es decir, el producto que se está elaborando es el que cubre todos los requerimientos. 

La calidad de los productos de trabajo generados durante el análisis y el diseño se pueden 
estimar y mejorar utilizando procedimientos sistemáticos de control de calidad, mediante 
recorridos e inspecciones y por medio de verificaciones automatizadas para supervisar que sea 
consistente y que esté completo. La técnica para estimar y mejorar la calidad del código fuente 
incluye los procedimientos sistemáticos de la prueba de unidad, la prueba de integración, la 
prueba de validación y la prueba del sistema. 

Subtema 9.1 Pruebas del Sistema. 

Ahora detallaré cada una de las pruebas que se mencionaron anteriormente. 

Iniciaremos con la P~eba de Unidad. La prueba de unidad centra el proceso de verificación 
en la menor unidad de diseño de software. Las pruebas de unidad comprenden el conjunto de 
pruebas efectuadas por un programador individual, antes de la integración de la unidad en un 
sistema más grande. Una unidad de programa suele ser lo suficientemente pequeña como para 
que el programador que la desarrolló pueda probarla con minuciosidad. Las pruebas que se 
dán como parte de la prueba de unidad son: 

Prueba de interfaz 

Prueba de las estructuras de datos 
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Pruebas de condiciones cie límite 

Pruebas de caminos independientes 

Manejos de errores 

Veamos ahora Pruebas de integración. Las pruebas de integración es una técnica sistemática 
para construir la estructura del sistema mientras que al mismo tiempo se llevan acabo pruebas 
para detectar errores asociados con la interacción entre sus módulos. El objetivo es tomar los 
módulos probados en unidad y construir una estructura de programa que esté de acuerdo con 
lo que dicta el diseño. 

Existen dos estrategias de integración: 

-Integración descendente 

-Integración ascendente 

Veremos cada una de ellas a continuación; comenzaremos primeramente con la Integración 
descendente. 

En la integración descendente se va haciendo una aproximación incremental a la construcción 
de la estructura de programas. Es decir, se integran los módulos moviéndose hacia abajo por __ 
la jerarquía de control, comenzando con el módulo de control principal (llamado comúnmente 
programa principal). Los módulos subordinados al módulo de control principal se van incor
porando en la estructura, ya sea de la forma primero-en-profundidad o de la forma primero
en-anchura 

En la integración primero-en-profundidad se integran todos los módulos de un camino de 
control principal de la estructura. Para seleccionar el camino principal se puede hacer de una 
manera arbitraria v dependerá de las características específicas de la aplicación. 

, 
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4o. Se eliminan los conductores y se combinan los grupos moviéndose hacia arriba por 
la estructura del programa. 

Veámoslo a manera ilustrativa con el siguiente ejemplo: Siguiendo el esquema que se muestra 
en la figura, se combinan los módulos para formar los grupos 1, 2, y 3. Cada uno de los grupos 
se somete a prueba mediante un conductor que se muestra como un bloque punteado. Los 
módulos de los grupos 1 y 2 son subordinados de Ma. Se eliminan los conductores C1 y C2 y 
se conectan los grupos directamente a Ma. De forma similar se elimina el conductor C3 del 
grupo 3 antes de integrarlo con el módulo Mb. Finalmente, tanto Ma como Mb se integran en 
el Módulo Me, y as! sucesivamente. 

Grupo 't 

A medida que la integración progresa hacia arriba, disminuye la necesidad de conductores de 
prueba separados. De hecho, si los niveles superiores del programa se integran de forma 
descendente, se puede reducir sustancialmente el número de conductores y se simplifica 
enormemente la integración de grupos. 

Revisemos ahora la Prueba de Validación. 

Tras la culminación de la prueba de integración, el software está completamente ensamblado 
corno un paquete; se han encontrado y corregido los errores de interfaces, y debe comenzar 
una serie fmal de pruebas de software la prueba de validación y ésta se logra cuando el software 
funciona de acuerdo a las espectativas razonables del cliente. Para la prueba de validación 
tenernos que considerar 3 puntos. 

Criterios para la prueba de validación. 

Repaso de la configuración. 

Pruebas alfa beta. 
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Por último pasemos a describir la Prueba del Sistema. 

U na vez que el software es incorporado a otros elementos del sistema y se realiza una serie 
de pruebas de integración del sistema y de validación, se realizan las pruebas generales del 
Sistema. 

Los pasos dados durante el diseño del software y durante la prueba pueden mejorar enorme
mente la probabilidad de éxito en la integración del software en el sistema total. 

La prueba del sistema realmente está constituida por una serie de pruebas diferentes cuyo 
propósito primordial es ejercitar profundamente el sistema basado en la computadora. Los 
tipos de prueba del sistema son: 

Prueba de recuperación 

Prueba de seguridad 

Prueba de resistencia 

Prueba de rendimiento 

Bien, en este tema conocimos las pruebas que hay que aplicar ha nuestro sistema tanto en el 
momento de su desarrollo como cuando se ha integrado totalmente con la finalidad de obtener 
un sistema de alta calidad. 

, 
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ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 

LECTURA: PRUEBAS DE UNIDAD. 

En las pruebas de unidad se prueba la interfaz del módulo para 
asegurar que la información fluye de forma adecuada hacia y desde 
la unidad del programa que está siendo probada. se examinan las 
estructuras de datos locales para asegurar que los datos que se 
mantienen temporalmente conservan su integridad durante todos los 
pasos de ejecución del algoritmo. Se prueban las condiciones limite 
para asegurar que el módulo funciona correctamente en los limites 
establecidos como restricciones de procesamiento. Se ejercitan 
todos los caminos independientes (caminos básicos) de la estructura 
de control con el fin de asegurar que todas las sentencias del 
módulo se ejecutan por lo menos una vez. Y finalmente, se prueban 
todos los caminos de manejo de errores. 

Antes de iniciar cualquier otra prueba es preciso probar el flujo 
de datos de la interfaz del módulo. Si los datos no entran 
correctamente, todas las demás pruebas no tienen sentido. Myers, en 
su libro sobre prueba de software, propone una lista de 
comprobaciones para la prueba de interfaces: 

l. ¿Es igual el número de parámetros de entrada al número de 
argumentos? 
2. ¿Coinciden los atributos de los parámetros y los argumentos? 
3. ¿Coinciden los sistemas de unidades de los parámetros y de los 
argumentos? 
4. ¿Es igual el número de argumentos transmitidos a los zr:-.)dulos de 
llamada que el número de parámetros? 
5. ¿Son iguales los "!tributos de los argumentos transmitidos a los 
módulos de llamada j los atributos de los parámetros? 
6. ¿Son iguales los sistemas de unidades de los argumentos 
transmitidos a los módulos de llamada y de los parámetros? 
7. ¿Son correctos el número, los atributos y el orden de los 
argumentos de las funciones incorporadas? 
8. ¿Existen referencias a parámetros que no estén asociados con el 
punto de entrac3 actual? 
9. ¿Entran sólo argumentos alterados? 
10. ¿Son consistentes las definiciones de variables globales entre 
los módulos? 
11. ¿Se pasan las restricciones como argumentos? 

Cuando un módulo lleve a cabo E/S externa, se deben llevar a cabo 
pruebas de interfaz adicionales. De nuevo, de Myers: 

1. ¿Son correctos los atributos de los archivos? 
2. ¿Son correctas las sentencias de apertura? 
3. ¿Cuadran las especificaciones de formato con las sentencias de 
E/ S? 
4. ¿Cuadra el tamaño del buffer con el tamaño del registro? 
5. ¿Se abren los archivos antes de usarlos? 
6. ¿Se tienen en cuenta las condiciones de fin de archivo? 
7. ¿Se manejan los errores de E/S? 
8. ¿Hay algún error textual en la información de salida? 

Las estructuras de datos locales de cada módulo son una fuente 
potencial de errores. Se deben diseñar casos de prueba para 
descubrir errores de las siguientes categorias. 

1. tipificación impropia o inconsistente 
2. iniciación o valores impl1citos erróneos 
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3. nombres de variables incorrectos (mal escritos o truncados) 
4. tipos de datos inconsistentes 
5. excepciones de desbordamiento por arriba o por abajo, 0 de 
direccionamiento 

Además de las estructuras de datos locales, durante la prueba de 
unidad se debe comptobar (en la medida de lo posible) el impacto de 
los datos globales sobre el módulo (p.ej., el COMMON de FORTRAN). 

Durante la prueba de unidad, la comprobación selectiva de los 
caminos de ejecución es una tarea escencial. Se deben diseñar casos 
de prueba para detectar errores debido a cálculos incorrectos, 
comparaciones incorrectas o flujo de control inapropiados. Las 
pruebas del camino básico y de bucles son técnicas muy efectivas 
para descubrir una gran cantidad de errores en los caminos. 

Entre los errores más comunes en los cálculos estan: 1) 
precedencia incorrecta o mal interpretada; 2) operaciones de modo 
mixto; 3) inicializaciones incorrectas; 4) falta de precisión; 5) 
incorrecta representación simbólica de una expresión. Las 
comparaciones y el flujo de control están fuertemente emparejadas 
(p. ej., el flujo de control cambia frecuentemente tras una 
comparación). Los casos de prueba deben descubrir errores como: 1) 
comparaciones entre tipos de datos distintos; 2) operadores lógicos 
o precedencia incorrectos; 3) igualdad operada cuando los errores 
de precisión la hacen poco probable; 4) variables o comparadores 
incorrectos; 5) terminación de bucles inapropiada o inexistente; 6) 
fallo de salida cuando se encuentra una iteración divergente, y 7) 
variables de bucles modificadas de forma inapropiada. 

Un buen diseño dicta que las condiciones de error sean 
previstas de antemano y que se dispongan unos caminos de manejo de 
errores que dirijan o terminen de una forma limpia el procesamiento 
cuando se dé un error. 

Entre los errores potenciales que se deben comprobar cuando se 
evalúa la manipulación de errores están: 

1. Descripción ininteligible del error 
2. El error señalado no se corresponde con el error encontrado. 
3. La condición de error hace que intervenga el sistema antes que 
el mecanismo.de manejo de errores 
4. El procesamiento de la condición excepcional es incorrecto. 
5. La descripción del error no proporciona suficiente información 
para ayudar en la localización de la causa del error. 

La prueba de limites es la última (y probablemente la más 
importante) tarea del paso de prueba de unidad. El software falla 
en sus condiciones limites. O sea, a menudo aparece un error cuando 
se procesa el e1emento n-simo de un arreglo n-dimensional, cuando 
se hace la i-ésima repetición de un bucle de i pasos o cuando se 
encuentra los valores máximo o minimo permitidos. Los casos de 
prueba que ejerciten las estructuras de datos, el flujo de control 
y los valores de los datos por debajo, en y por encima de los 
máximos y los minimos son muy apropiados para descubrir estos 
errores. 



ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 

LECTURA: PRUEBAS DE VALIDACION. 

La validación del software se consigue mediante una serie de 
pruebas que demuestran la conformidad con los requerimientos. Un 
plan de prueba traza las pruebas que se han de llevar a cabo, y un 
procedimiento de prueba define los casos de prueba espec1ficos que 
serán usados para demostrar la conformidad con los requerimientos. 
Tanto el plan como el procedimiento estarán disefiados para asegurar 
que se satisfacen todos los requerimientos funcionales, que se 
alcanzan todos los requerimientos de rendimiento, que la 
documentación es correcta e inteligible y que se alcanzan otros 
requerimientos (p. ej., portabilidad, compatibilidad, recuperación 
de errores, facilidad de mantenimiento). 

Una vez que se procede con cada caso de prueba de validación, 
puede darse una de dos condiciones: 1) Las caracter1sticas de 
funcionamiento o de rendimiento están de acuerdo con las 
especificaciones y son aceptables, o 2) Se descubre una desviación 
de las especificaciones y se crea una lista de deficiencias. Las 
desviaciones o errores descubiertos en esta fase del proyecto 
raramente se pueden corregir antes de terminar el plan. A menudo es 
necesario negociar con el cliente un método para resolver las 
deficiencias. 

Repaso de la configuraci6n 

Un elemento importante del proceso de validación es el repaso de la 
configuración. El repaso intenta asegurar que todos los elementos 
de la configuración del software se han desarrollado de forma 
adecuada, están catalogados y tienen el suficiente detalle para 
facilitar la fase de mantenimiento dentro del ciclo de vida del 
software. 

Pruebas alfa y beta 

Es virtualmente imposible que un encargado del desarrollo del 
software pueda prever cómo un cliente usará realmente un programa. 
Se pueden interpretar mal las instrucciones de uso, se pueden usar 
regularmente extrafias combinaciones de datos y una salida que 
pueden estar clara para el que realiza la prueba puede resultar 
ininteligible para un usuario normal. 

Cuando se construye software a medida para un cliente, se 
lleva a cabo una .. serie de pruebas de aceptación para permitir que 
el cliente valide todos los requerimientos. Llevado a cabo por el 
usuario final en lugar del equipo de desarrollo, una prueba de 
aceptación puede ir desde un informal "paso de prueba" hasta la 
ejecución sistemática de una serie de pruebas bien planificadas. De 
hecho, la prueba de aceptación puede tener lugar a lo largo de 
semanas o meses, descubriendo as1 errores acumulados que pueden ir 
degradando el sistema. 

Si el software se desarrolla como un producto a ser usado por 
muchos clientes, no es práctico realizar pruebas de aceptación 
formales para cada uno de ellos. La mayor1a de los constructores de 
productos de software llevan a cabo un proceso denominado prueba 
alfa y beta para descrubrir errores que parezcan que sólo el 
usuario final puede descubrir. 

La prueba alfa es conducida por un cliente en el lugar de 
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desarrollo. Se usa el software de forma natural, con el encargado 
del desarrollo "mirando por encima del hombro" del usuario y 
registrando errores y problemas de uso. Las pruebas alfa se llevan 
a cabo en un entorno controlado. 

La prueba beta se lleva a cabo en uno o más lugares de 
clientes por los usuarios finales del software. A diferencia de la 
prueba alfa, el encargado del desarrollo normalmente no está 
presente. As1, la prueba beta es una aplicaci6n "en vivo" del 
software en un entorno que no puede ser controlado por el equipo de 
desarrollo. El cliente registra todos los problemas (reales o 
imaginarios) que encuentra durante la prueba beta e informa a 
intervalos regulares al equipo de desarrollo. Como r~sultado de los 
problemas anotados durante la prueba beta, el equipo de desarrollo 
del software lleva a cabo modificaciones y as1 prepara una versi6n 
del producto de software para toda la base de clientes. 

, 



ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 

LECTURA: PRUEBA DEL SISTEMA. 

Prueba de recuperaci6n 

Muchos sistemas basados en computadora deben recuperarse de los 
fallos y resumir el procesamiento en un tiempo previamente 
especificado. En algunos casos un sistema debe ser tolerante a 
fallos de procesamiento no deben hacer que cese el funcionamiento 
de todo el sistema. En otros casos, se debe corregir un fallo del 
sistema en un determinado periodo de tiempo a riesgo de que se 
produzca un serio daño econ6~ico. 

La prueba de recuperación es una prueba del sistema que fuerza 
el fallo del software de muchas formas y verifica que la 
recuperación se lleva a cabo apropiadamente. Si la recuperación es 
automAtica (llevada a cabo por el propio sistema) hay que evaluar 
la corrección de la reinicialización, de los mecanismos de 
recuperación del estado del sistema, de la recuperación de datos y 
del arranque. Si la recuperación requiere la intervención humana, 
hay que evaluar los tiempos medios de reparación para determinar si 
estAn dentro de unos limites aceptables. 

Prueba de sequridad 

Cualquier sistema basado en computadora que maneje información 
sensible o lleve a cabo acciones que puedan impropiamente 
perjudicar (o beneficiar) a los individuos es objeto de 
penetraciones impropias o ilegales. La penetración incluye un 
amplio rango de actividades: "destripadores" que intentan penetrar 
sistemas como deporte, empleados disgustados que intentan penet~ar 
por venganza e individuos deshonestos que intentan penetrar por 
obtener ganancias personales ilicitas. 

La prueba de seguridad intenta verificar que los mecanismos de 
protección incorporados en el sistema lo protegerAn, de hecho, de 
la penetración impropia. Citando a Beizer [BEI84]: "Por supuesto, 
la seguridad del sistema debe ser probada en su invulnerabilidad 
frente a un ataque frontal pero también debe ser probada en su 
invulnerabilidad frente a ataques por los flancos o por la 
retaguardia". 

Durante la prueba de sequridad, el encargado de la prueba 
juega el papel de un individuo que desea penetrar en el sistema. 
¡Todo vale! Debe intentar hacerse con las claves de acceso por 
cualquier medio externo del oficio; debe atacar al sistema con 
software a medida, diseñado para romper cualquier defensa que haya 
sido construida; debe bloquear el sistema, negando asi el servicio 
a otras personas; debe producir a propósito errores del sistema, 
intentando penetrar durante la recuperación; o debe curiosear en 
los datos públicos, intentando encontrar la clave de acceso al 
sistema. 

Con el suficiente tiempo y los suficientes recursos, una buena 
prueba de seguridad terminarA por penetrar en el sistema. El papel 
del diseñador del sistema es hacer que el coste de penetración sea 
mayor que el valor de la información obtenida mediante la 
penetración. 

Prueba de resistencia 

Durante los anteriores pasos de prueba, la técnica de la caja 
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blanca y de la caja negra daban como resultado la evaluación del 
funcionamiento y del rendimiento normales del programa. Las pruebas 
de resistencia están diseñadas para enfrentar a los programas con 
situaciones anormales. En esencia, el sujeto que realiza la prueba 
de resistencia se pregunta: "¿A qué potencia puedo ponerlo a 
funcionar antes de que falle? 

La prueba de resistencia ejecuta un sistema de forma que 
demande recursos en cantidad, frecuencia o volúmenes anormales. Por 
ejemplo: 1) diseñar pruebas especiales que generan diez 
interrupciones por segundo, mientras que una o dos son las 
normales; 2) incrementar las frecuencias de datos de entrada en un 
orden de magnitud con el fin de comprobar cómo responden las 
funciones de entrada; 3) ejecutar casos de prueba que requieran el 
máximo de memoria o de otros recursos; 4) diseñar casos de prueba 
que puedan dar problemas con el esquema de gestión de memoria 
virtual; 5) diseñar casos de prueba que produzcan excesivas 
búsquedas de datos residentes en disco. Esencialmente, el encargado 
de la prueba intenta tirar abajo el programa. 

Una variación de la prueba de resistencia es una técnica 
denominada prueba de sensibilidad. En algunas situaciones (la más 
común se da con algoritmos matemáticos) un rango muy pequeño de 
datos dentro de los limites de una entrada válida para un programa 
puede producir un procesamiento extremo e incluso erróneo o una 
profunda degradación del rendimiento. Esta situación es análoga a 
la existencia de una signularidad en una función matemática. La 
prueba de sensibilidad intenta descubrir combinaciones de datos 
dentro de una clase de entrada válida que pueda producir 
inestabilidad o procesamiento incorrecto. 

Prue~a de rendimiento 

Para sistemas de tiempo real o sistemas empotrados, el software que ... 
proporciona las funciones requeridas pero que no se ajusta a los 
requerimientos. de rendimiento es inaceptable. La prueba de 
rendimiento está diseñada para probar el rendimiento del software 
en tiempo de ejecución dentro del contexto de un sistema integrado. 
La prueba de rendimiento se da durante todos los pasos del proceso 
de prueba. Incluso al nivel de unidad, se debe asegurar el 
rendimiento de los módulos individuales a medida que se llevan a 
cabo las pruebas de la caja blanca. Sin embargo, hasta que no están 
completamente integrados todos los elementos del sistema no se 
puede asegurar realmente el rendiminento del sistema. 

Las pruebas de rendimiento a menudo van emparejadas con las 
pruebas de resistencia y a menudo requieren instrumentación tanto 
de software como de hardware. o sea, a menudo es necesario medir la 
utilización de recursos (p. ej., ciclos de procesador) de una forma 
exacta. La instrumentación externa puede monitorizar los 
intervalos de ejecución, los sucesos ocurridos (p. ej., 
interrupciones) y muestras de los estados de la máquina en un 
funcionamiento normal. Instrumentando un sistema, el encargado de 
la prueba puede descubrir situaciones que lleven a degradaciones y 
posibles fallos del sistema. 
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ANALISIS Y DISEÑO DE SISTEMAS DE COMPUTO 

LECTURA: MANTENIMIENTO DEL SISTEMA. 

Mantenimiento estructurado frente al no estructurado 

Si sólo se dispone del código fuente como elemento de 
configuración, la actividad de mantenimiento comienza con una 
dolorosa evaluación del código, a menudo complicada por la pobre 
documentación interna. Las sutiles caractristicas, tales como la 
estructura del programa, las estructuras de datos globales, las 
interfaces del sistema, el rendimiento y/o las limitaciones del 
disei'lo, son difíciles de descubrir y frecuentemente mal 
interpretadas. Es dificil asegurar cuAles son las ramificaciones de 
cambios llevados ültimamente en el código. Es imposible llevar a 
cabo pruebas de regresión (repetir prueba anterior para asegurar 
que las modificaciones no han introducido fallos en el software 
previamente operativo) , ya que no existe ningün registro de 
pruebas. Lo que hacemos es un mantenimiento no estructurado y 
pagamos el precio (en esfuerzo desperdiciado y en frustraciones 
personales) que se adjunta a todo software que no ha sido 
desarrollado mediante una metodologia bien definida. 

Si existe una completa configuración del software, la tarea de 
mantenimiento comienza con una evaluación de la documentación del 
sidei'lo. Se determinan las importantes caractristicas estructurales, 
de rendimiento y de interfaz del software. Se estudia el impacto de 
las correciones o modificaciones requeridas y se traza un plan de 
actuación. Se modifica el disei'lo (usando técnicas idénticas a las 
discutidas en capitulas anteriores) y se revisa. Se desarrolla 
nuevo código fuente, se realizan pruebas de regresión mediante la 
información contenida en la Especificación de Prueba y se vuelve a 
lanzar el software. 

Esta secuencia de sucesos constituye el mantenimiento 
estructurado y aparece e ·:no resultado de una anterior aplicación de 
una metodologia de ingen.aria del software. Aunque la existencia de 
una configuración del software no garantiza un mantenimiento libre 
de problemas, se reduce la cantidad de esfuerzo requerido y se 
mejora la calidad general del cambio o de la corrección . 

Costos de mantenimiento 

El costo del mantenimiento de software ha crecido rApidamente 
durante los ültimos veinte ai'los. Los porcentajes de factura total 
del software que se gastan en el mantenimiento de software 
existente son: para los aftas 70's de 35-40%, para los aftas 80's de 
40-60% y se estima que para los ai'los 90's serA de 70-80%. Aunque 
los promedios industriales son dificiles de asegurar y están 
abiertos a muchas interpretaciones, una organización de desarrollo 
de software tipica gasta entre el 40 y el 70 por ciento de todo su 
dinero en el mantenimiento correctivo, adaptivo, perfectivo y 
preventivo. 

Los costos en dólares del mantenimiento son los más obvios. 
Sin embargo, otros cotos, menos tangibles, pueden en ültimo lugar 
ser la causa de muchas preocupaciones. Citando a Daniel McCracken 
[MCCSO): 
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Los retrasos en las nuevas ampliaciones y en los grandes 
cambios medidos en a~os se van alargando. Como industria, ni 
siquiera podemos hacer frente -digamos sólo poner al dia- a lo 
que nuestros usuarios quieren que hagamos. 

McCracken alude a la organización en la barrera del mantenimiento. 
Un costo intangible del mantenimiento del software viene dado por 
una oportunidad de desarrollo que se propone o se pierde debido a 
que los recursos disponibles deben estar dedicados a las tareas de 
mantenimiento. Otros costos intangibles incluyen: 

insatisfacción del cliente cuando una petición de reparac1on 
o de modificación aparentemente legitima no se puede antender 
en un tiempo razonable 
disminución de la calidad global del software debido a los 
errores :atentes que introducen los cambios en el software 
mantenido 
trastornos en otros esfuerzos de desarrollo al tener que 
"poner" a trabajar a la plantilla en tareas de mantenimiento. 

El costo final del mantenimiento de software es una dramAtica 
reducción de la productividad (medida en LDC por persona-mes o en 
punto de función por persona mes) que se encuentra cuando se inicia 
el mantenimiento de viejos programas. Se ha informado de 
reducciones de la productividad de 40 a 1 [BOE79]. o sea, un 
esfuerzo de desarrollo que haya resultado en un costo de $25 por 
linea de código desarrollada, costaria $1.000 por cada linea de 
código que sea mantenida. 

El esfue~:o gastado en el mantenimiento se puede dividir en 
actividades productivas (p. el., análisis y evaluación, modificación 
del dise~o, codificación) y actividades "menos productivas" (p. 
eje., tratar de comprender lo que es el código; tratar de 
interpretar las estructuras de datos, las caracteristicas de la 
interfaz, los limites de rendimiento). La siguiente expresión 
[BEL72) proporciona un modelo del esfuerzo de mantenimiento: 

M = p + K exp(c-f) 

donde M = esfuerzo total gastado en el mantenimiento 
p = esfuerzo productivo (descrito arriba) 
k = una constante empirica 
e= una medidad de la complejidoad que se puede atribuir a la 

falta de un buen dise~o y de documentación 
f = una medida del grado de familiaridad con el software. 

Este modelo indica que el esfuerzo (Y costo) puede aumentar 
exponencialmente si se usa una pobre aproximación de desarrollo de 
software (o sea, una falta de ingenieria del software) y si la 
persona o grupo que usan la aproximación no está disponible para 
llevar a cabo el mantenimiento. 

Problemas 

La mayoria de los problemas asociados con el mantenimiento de 
software se debe a las deficiencias de la forma en que el software 
ha sido definido y desarrollado. Aqui aparece el clásico síndrome 
del pague ahora o pague después" La falta de control y disciplina 
en las dos primeras fases del proceso de ingenieria del software 
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casi siempre se traduce en problemas para la ültima fase. 
Entre los muchos problemas cl&sicos asociados con el 

mantenimiento de software se encuentran los siguientes: 

A menudo es excepcionalmente dificil comprender un programa 
"ajeno". A medida que existen menos elementos de configuraci6n 
del software, mayor es la dificultad. Si s6lo existe el c6digo 
indocumentado, es de esperar que aparezcan serios problemas. 
Ese personaje "ajeno" a menudo no s·e encuentra alrededor para 
poder explicarse. La movilidad entre los profesionales del 
software es actualmente muy grande. No podemos esperar una 
explicaci6n personal del software por el que lo ha 
desarrollado una vez que se requiere el mantenimiento. 
No existe una documentaci6n apropiada o est& mal preparada. Un 
primer paso es el reconocimiento de que el software debe ser 
documentado, pero para que la documentaci6n sea de algün valor 
debe ser comprensible y consistente con el c6digo fuente. 

La mayor1a del software no ha sido diseñado previendo el 
cambio. A menos que el método de diseño prevea el cambio 
mediante conceptos tales como independencia funcional o clases 
de objetos, las modificaciones del software ser&n difíciles y 
propensas a errores. 

El mantenimiento no se ve como un trabajo atractivo. Muchas de 
las causas de esto vienen dadas por el alto nivel de 
frustraci6n asociado con el trabajo de mantenimiento. 

Todos los problemas que se acaban de describir se pueden, en parte, 
atribuir al gran nümero de programas actualmente existentes que ha 
sido desarrollados sin tener en cuenta la ingenier1a del software. 
Tampoco se debe ver como una panacea el uso de una metodolog!.a 
disciplinada. Sin embargo, la ingenier1a del software por lo menos 
proporciona soluciones parciales a cada problema asociado con el 
mantenimiento. 

Como consecuencia de los problemas asociados con el 
mantenimiento de software, surgen varias cuestiones técnicas y de 
organizaci6n. ¿Es posible desarrollar software que esté bien 
diseñado y sea f&cil de mantener? ¿Podemos mantener la integridad 
del software cuando tiene que ser modificado? ¿Existen enfoques 
técnicos y organizativos que se puedan aplicar con éxito al 
mantenimiento .de software? En las secciones que vienen a 
continuaci6n se discuten estos y otros puntos. 
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1 ESTRATH;JAS lJE lli'SARROLLO E I~II'I.I·:MENTACION IJE 
SISTEMAS 

La inqcnieria de !'o(twan~ es un conjunto de <lcl¡vidadrs cuyo 
objr.tivo es el dcs.,rrollo de software m.~s confiable, meno~ rnr:to·~o, 
y quc func i onc ef i e 1 cntr:!mcntc sobre m.""'cJII i n.1s ¡-c.,., 1 e!;. flh,Jn:a un 
conj1Jnto de tres elrmcntos: 

- mót.orlos 
- hcrr.tmicntas 
- procedimientos 

l.os métodos aharc"'n la planlricación y estim<Jción de 
proyectos, an<\llsi5 de los n:~qucrimientos del sistema y df"l 
sottw.,rc, riJscflo liC las e5tructur,,s de rlilt.o:., arquitcct.JII"ill !le 
proqr,lmas y procedimientos allJnri.tmic.:os, pruebo~ y m.tnlenrmicnto. 

Las hcrr.1mic-ntilS etc la inqenic-ri.¡¡ ele soft.w,"Jre> suministr·iln un 
~aporte autom:ttico o srmiautomi'it.ico par·a los ml!todos. lloy en dia, 
cxist~n he>rrdmicntas para soportar Citda uno de los diversos 
métod'ls. 

Los prnccdimicntns unr>n a los métodos y IH~rr-Jmir:!nlas y 
f,)cilitiHI un dr.s.trrollo racion<tl y oportuno del so/twan~ de 
computadora. Definen la secuencia en la que se aplic,,n los métodot;, 
los controles que ayud.tn a asequrar la calidad y coordinación de 
los cambios en el sotlwarc. 

r .. ,~ herrilmi,~nta~ ser,ín ana.li7<trlas ,, dr~til)le 1"11 P] capítulo 
siguiente, por· ot.r,, pclr·tr".! dado que los procc.,dimicntos vienen 
inherentes tanto a ¡,, mctorlo)oql,, como a la~ hcn·,,micnLH; ele<.;l,ts, 
estos no serán desarrollados con tanta profundidad. 

METOOOS ESTRUCTUR~DOS 

Los mótodos estrnctur,,dos consisten ele un conjunto de reql<~s, 
tilrcas, y técnic.1s, par·a ayud,,r en r>l dco.;H-r-olln rle !;i!;tem¡¡s en 11110 
o más de sus cst.Hios (cstr.tteqt.,, ,JTJ.Í.) isis, di!>clm, ~~t.r;). 

Los métodos estructurados cmpcz,,ron a ~P.I" ut i 1 i ('.atlos r.n 
clrculos acildémJcos a llll•llcs etc los 60's, y ,,Jcan?.o.~ron (•opula.ri,l.ul 
en el :imhito cnmr~rci,,l rl medi,Hios de los "10'!;. t:f;t.n!~ métoclos 
ofrecienm un,, •;olución ;¡ los cnlon<:C!s C){Ístcntt)!:> c~;t<lnd.trc:::; eh! 
desarrollo no e!>tTIIf"tur.ttlos y c;,trentes de discf1o. 

. 2 

i 

t 
1 

1 

l. 

'hll~" 1'\~\ 1\ !llri<I .. AI\.1~</1<1' Ul 1!11"~"'"''"' 0~\<11 011'11111111 '" ol/1~ 

-----~---- ------------------

Dentro de los mét.oclos estnn;t.ur·¡¡dos se encontr·.,han las 
g 1 ,, rc.,s estructurilrl<tS de 'r'ourdnn, ¡f¡,¡qr<~m.ts de Wilr"llicr¡or·r, 
d 1 tHp-.lmas de ,J,tckson, 1 ,, t.écn ica c~;t r uclu¡·;ui,J de Chr:!n piii.,J el 
diseño estructurado de d,Jt.os, di.ttp;,¡m,t~; de ~~ntitl.rd rel,n.:ión, etc. 

A. medio1don ~~~ lns "IO's, .l,tmes M,¡r·l in din inic1o al concepto de 
ciclo de virl.l p.lra unif ic.tr y cuntnllilr todo el (JI"oceso de 
des.,rrollo de un SJ!;tem.J. Este método ll<~mddo Inqenieri<t. de 
Informilción (IF:) en el quP. se nlqliC! 1111 enfoque top-down, se 
identifican las nccesid,,dcs de intor·m.1ción ¡IJu·,,nt.e la etapa de 
an:ilisis con el fin 1le delimitar lo~ alcancr.n del sistema. Las 
metodologías CASf: (Computcr Aidnd S'yst.em lüH;inccriiHJJ fueron 
construidas siquiendo este enfoque. 

¡.,,s llerramicntas CASE empezaron a ser cles.,rrollo~das a 
principio de los 80's fMI·a soport¡u· y illlt.om.tl.iz,JT· alqun<t!:i de lc1s 
Ltlrc.ls encontrad,¡!; un lu~: métodos c;.tnrclliJ",\dO!"i di' descu·rollo. 

A 1 qunos de los 
sistemas dentro de 
continuación. 

Hétodo warnler¡orr 

métodos más conocidos par·.t el tlcsar¡·ollo de 
l<1 inqeníar·ta de solf.W<Jl"t! se tlci.,I)Ian a 

Warnicr/Orr no es propi.1m• trl.c una mctodoiO<J~•' P"• ,, la construcción 
de sistemas, existen los diagramas Warnier¡orr e• método de 
Warnier (lt).¡ir'l ,,,.. cstrur.tura de dato~. corrstrucc:ión de sistemas 
lóqica, 'r ,,')n lóqica de proq,·amas) y el método de Orr 
(DesarrtJ 1 . ,;t.em,ls cstr·ur:t ur·,,¡lo~;) est t111 un idos pi! ro 
estr ictaml.!L•l ,_ .•ndu no existe Ulhl m•~t.odo luq i ,, I.J,¡rn 1 er /Or·r·. 

Es muy comú.n que Sü confunda la metodoloqia con los di,tqramas, 
tal vez esto sect porque los ciidql·am<t5 ~;on 1<1 parte m.í:; visihle de 
la mayorla etc ¡,,s meto<loloqí,,s; sin emh.1ICJO, un,¡ metoduloqía es 
mucho m.ís que sólo diagramas y reglas lle sinlaxi5. 

oentro del conte){to de inqcnierla de softw,1¡·e un método es un 
proccdtmiento o una técnica que reilliza una pon;rón significante 
del ciclo de vid,, de un sistema. Una m•!t.ndoluql:,, es une~ colección 
ele métodos h,¡s.ulos en un,, fi lo!'.of1a comlrrr que j11rrtos cubren par·te 
o todo el ciclo de VJda de un sistcm.t. 

El nombr·e correclo de lo que much,, qcnlc llama mctotloloqla 
w,1 rnier¡Orr es: Desarrollo Estrucllll·ario de Sist.f!m,,:. dr- f),Jtos (llSSD 
{)at_,¡-~;tructured ~y:.tems flcvclopmcrrt) y PS el I"CSIIIl..ttlo d1!l lr,¡IJ,,ju 
con junto de m•tchol qf!nl e. 

l . 
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f.n 1972, el ;.u-tfculo de Tcrry Dal'.cr "Chicf l'roqrammcr Team 
Operation~" en el scm.lnario de sistemas lDM, rf!unió Vi\ria~ ideas de 
pr·oqram<~c ión estrur..:l.lU"iHia, di sci\o Top-Vown f! i mp 1 emcntar..: i 6n, esto 
tuvo un qran imp<tcto en el campo de la computación. Fue entonces 
cuando empezó la revolución estructurada en los F.stados Unidos. 

A principios de los 70's Ken Orr descubre que la estructura 
jedir'quiea de los programas es reflejada en la estructura 
jerárquica de los datos y fue por ese tiempo que Jean Warnler habla 
hecho e 1 mismo dcscubr 1m iento, pero adem.!ls habt a construIdo una 
metodolog1a sistemAtica alrededor de este descubrimiento. 

La programación estructurada de los datos significa que pueden 
ser construidas soluciones predeciblemente correctas para una 
amplia qt1ma de problemi\s de programación. L.a tl!cnica de datos 
est rucl\H"cldos fue extendida para resolver programas complejos y 
;ubitrarios. 

Se desarrolló un esquema en el cual las entradas fisicas son 
convertidas a entradas lóqicas; las entradas lógicas se convierten 
en sal it1.1s lóqic<~s; fin.Jlmellte, las sal idas lógicas son convertidas 
en s.Jlida~ 1 tsic.Js. 

con este pr·oecso df! diseño de programi'ls comienza la estrategia 
ctel diseño orientado a objetivos, l!ste inicia con la estructura de 
salida y trabaji'l hi'lcia atrti!'i, inicia con la salida l6qica, entrada 
lógica y finalmente ent~da f1sica. 

Poco a poco nssn se movió de la metodolorJta de diseño de 
¡H-oq¡·;lm,\s a una metodoloq[,1 de diseño de sistemas. Dl!spués la 
mctodoloqia fue expandida para abarcar el diseño de bi'lses de datos, 
definición de requerimientos y finalmente la planeaci6n y 
arquitectura de los Sistemas. 

A nivel conceptual nsso aün contiene ri'lsqo!'i caracter1sticos a 
nivel de proqram.tci6n. Por ejemplo, aUn se enfoca (en su fase de 
diseño) a trc\b,-.jos hacia atrás desde las salidas. nsso trabaja 
haci,t <~tr·,"'!> hast.l J,-. hase !1.-.los 16qica y lucqo h<lCla las entradas. 
!.<~ hilo-e de datos lóqica se tri'lnsforma en und base de datos 
re 1 ar..: i unt~l y nor·m" 1 i Zi\cl.t (ver f j gura 1. 1. 1) . 

Hij!ntr·,-.s que un.1 definición completa 11C los requerimientos 
(salijl,,~; má~; illl¡orrlmos) es un excelrmlf"' punto de partida en el 
di.seño, uo e.s propi.-.mente el punto desde el cual empez,¡r la 
ilt~finición ole}(¡!; l"t!q•wrlmient.o.s. As1 a tr.1vé.s de los aflo~~. USSO se 
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ha extendido hasta cubrir primero el contexto, luego las funciones 
y finalmente los resultados del sistema. 

Se hicieron nPcesarias un número de herramientas para 
facilitar este proceso. Los diagramas de Entidades ayudan a definir 
el contexto del sist€!ma, y los diagramas de llnea de montaje (una 
forma modificada de los diagramas Warnier/Orr) ayudan a definir el 
flujo funcional del sistema. 

[.as mctodolog las estructuradas de datos tienen ventaja sobre 
muchas mctodoloqlas orientadas a procesos, dado que son mAs 
rigurosas y por tanto proporcionan una mejor base para 1.!11 verdadera 
inteqraci6n a través de todo el ciclo de vida de un sistema. OSSD 
ha si do u~ado exitosa mente en un qran ri'lnqo de sistemas de 
sofl.~o~arc, desde sistemas comerciales en ltnca hasta sistemas de 
control tic tiempo real. Cientos de personas lo han aprendido y 
cientos de sistemas han sido desarrollados con este m~todo. 

USSD es un acercamiento a la inqenierla de software que h.!ll 
proporcionado un m~rco de trabajo estable para incorporar nuevas 
tccnoloqiar: conforme éstas surgen. Por ejemplo, sr:- han incorporado 
los prototipos de diseno en llnea y en tiempo real sin sacrificar 
lo yd r~alizado. 

Hétodo Gana 1 Bar9on 

Este método está bilsado en el modelado 16gico el cual consiste en 
tomar J.-.s idc<lS V<HJ<IS necesarias acerca de los requ€!rimientos y 
convertirlas en de(iniciones precisas tan pron~o como sea posible, 
este proceso puede real izarse rápidamente si se cuenta con und 
técnica qr•\rica que nos permita tener )¡o¡ esencia del sistema sin lr 
al problem,, de la implementación flstcd, con esto pudiera hacerse 
por ejemplo un 1 ',)tipo. 

El modelado lóqico puede verse como un proceso de 7 pasos: 

1.- Desarrollo de un Diaqrama de i-"lujo de D<ltos (DFO) qencral que 
descr ibé\ lo que ocurre en cada Ar-ca de lil empresa. Para 
simplificar los diaqraiJ\as se emplean solamente cuatro stmbolos 
que pr·oducen un dic"lqrama mostrando la naturilleza lógica de 
cu.llquier· sbotema de información a Clli'llquier n1vel deseado de 
detillle. Lu~ Di-"U nor: muestran los 11mites de una :,r~a dentro 
del sistema y d€! la empresa misma, los tllaqr<1mi'ls no son 
técnicos, es decir son t.'iciles de entend•~1 por cualquier 
pr!t-~on,l (,1mi llill·iztul,, con el Arca descr ila, nt1s mul'~lran d.tlos 
alm.u:en,,tlos y los procesos que tran~rorm<ln esos t1.1t.us. 

~~~-----·---------- ------~- ~------
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2.- Derivar un<~ 1 ista de los dato~ que sPrAn almacenados en cad.!ll 
alm<tcén de t1.1tos, la lista puede afin<trse revisando los datos 
de entr<Hia¡s,llida al sistem,, y determinando que representa 
c."lda d."lto. 

J.- Revir:ar lo que el análisis entidad-relación pueda decirme 
acerca de 1~ €!structura de los datos. Obtener las Entidades y 
crear un diaqrama con las entidades que se han detlnido, 
después buscar las relaciones existentes entre las entidades 
y dihuj;lr 1 incas que mul!stren estas relaciones. 

··-
5.-

.. -

Por c."lda par de entidades se tiene una relación entre sus 
elemento~. la r·elaci6n puede ser uno a uno, muchos a uno o 
m11chos ,, muchos. Estos diiHJramas nos dan mucha inrorm<lci6n 
iiCerca d€!1 r:i~tem<t, mostrt"1ndonos todas las relaciones que 
ex i r:ten entre las ent idadcs i nvo 1 ucradas (vt:Jr f i gurlt 1. 1. 2} . 

Fil'}ura l. 1.2 Todas lils relaciones 
identificables entre entidades 

Emplear l."l inlormactón de los cl."ltos para describir un modelo 
que h•HJ·' url<l 1 HJ" entre dos t<lbltls bidimensionales. Las tablas 
delJcr.ín est .. 1r normalizad.ts. 

U€!dibujar f.l Df-"il par<t rcflcjilr una vista mAs 
!;islr~m., de d.ttos como resultarlo del anAiisis 
cnl.ltl~d-reJ,,ción y 1le Id nor·mal izactórl. 

precisa de 1 
del modelo 

l'.ll·ticionc"ll" P!;fr:> modelo lóqico de procesos y di'tt.os 1lentro de 
unidade!~ d1~ procedimlr>nto!~. !~ep.tr·,,r los J>I'OCCdlmzcntus que 
ptu~tl.ill Sl!r ~~ i•·eul adoo. m,lfHI<II o olllt om,\t. ICclmcn~e. 

l.,, 
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1.- Especificar el det.tlle de cada unidad de procedimiento que se 
requiere par."l implcment•"lr el sistem."l: 1-:lttr.ter· ¡,, unidad del 
DfD y mostrar donde queda dentro del sistema, detallar la!:i 
tablas acces;,das por esa unidad, mosll.tr un esqlH'!ma de 
pantallas y reportes involucradas en la tllticla(l y detallar 1~ 

16qica y los procedimientos que ser:t.n implementados. 

Uni\ vez definidos los procedimientos se puede decirlir si ser<\ 
un prototipo o se debe implementar directamente en <llgún lenguaje. 

l.os pasos 6 y 7 no son estrictamente hablando un modelado 
16gico dado que tratan de convertir el modelo lógico en modelo 
ftsico, sin embargo son pc"trte del flujo naturc"ll a través del 
proceso que comienza en la definición de sistema y termina con el 
diseño flsico. 

Método Entidad-Relación 

Es una metodoloq'la estructurada que puerle nistemáticamente 
convertir los requerimientos del usuario en una base de datos bien 
diseñada. No es propiamente una metodolog'la sino una aproximaci6n. 

f.stc mótodo se basa en lo si•JUicnte: 

- Oesarrollar un diaqramt"l entidad-relación (f.RD 1-:ntity Relational 
Diaqram). Este p<1so identificd Entidades, Relaciones y atributo~ 
asociados adem.'is de la llave primaria de Cclod.t tipo de entid<td. 

F'iqura 1.1.1 
Di.u:~r·am.l Entidad RclacJón 

1 .• 

~1\ 11 MA PAliA 1 A AIIIOMA II!J\1 ION 111' INI IIMM~I I"N ORAC 1 1 NI~10il01 II(JIAI 

llll<"l cnlidad es una cosa, un concepto, una organización o un 
evento de interés para la orqanlzact6n que se est~ modelando. Una 
1-:ntidad Tipo es un•"l clasiricac16n de entidades que satisfacen 
ciertos criterios. un."l relación es un."l interacción entre entidades. 
Una relación tipo es una clasificación de relaciones basada en 
cierto crit.crio. usualmente Jos sustantivos corresponden a las 
ent idadcs m ientl'"<loS que los verbos corresponden a las relaciones. 

F.l siquicnte paso es identificar la cardinalidad de los tipos 
ele relaciones, es decir con cuantos elementos de una entidad 8 se 
puede relacionar un elemento de una entidad A y visccversa. Se 
identifican despuós las propiedades (atributos) de cada Entidad
Relación y r:c eltpresaran gráficamente con c\rculos (o elipses). t.as 
llaves primar·ias son identificadas con un doble circulo. 

convertir los diaqram.los entid<HI-relaclón en 
convencionales y estructuras de bases de datos. 
conjunlo de reglas para hacer esto. 

archivos 
Ex late un 

OP~arrollar los proqramas de aplicación basados en los 
a.·chivor. y estructuras de lit h,"tse de d."ltos. Si se estA usando 
un .si:~tem,, Haucjador de H,Jscs de lJ.ttos (DBHSJ es posible 
escribir en esle momento un proqr-am,¡ en SQL (System Query 
t.anquage) JMra expresar la consulta a los datos. 

F.l modc 1 a do f.nt i dad-Re ),"le i ón puede ser usitdo 
hcrramient.cl de di="cilo s1no como la base para 
si stemc~s mc"lnP. )adores de bases de datos. 

Método Yourdon 

no sólo como una 
el modelado en 

El método Yourdon e~ una colección qenóric."l de ideas de lngenicrla 
de sofl..wan~ desarrolladas por muchas personas quienes han trabajado 
para la compar\1a vounlon. Las ideas de todi'ls estas personas se 
re un¡ e ron y ne les di ó el nombre de tt!cn icas estructuradas: 
proqr·amación estructurada, diseño estructurado, y análisis 
estruet.ura<lo, con esto t:d Yourdon intenta cnlclozar su metodologta a 
las dcmt'ts eli1par. del proceso de desarrollo de un sistema, para 
crear una mP.t.o<l<llO(jia rpu:~ compita con ],,., métodos que sl cubren 
completamente el ciclo de vill<l de un ~istf!m,t, ~s.deci~, los ml!todos 
que inician con li'l etapa de _c_strclolecp."l_ Y_ an~llSls, d1:'ei\o IOqico y 
flr.ICO haSl.l la Ímplcmentac¡on, tr<Ul5lCIÓn y producc~fln. 
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Debido a la continua inr tuenc1a dP n•u~va!, itlco.-¡s dt:! rJ~nt~ 
nueva, el ml!todo Yourdon est:il en cantil•· ,lf~sar·rollo, de t,¡J lor·m.l 
que actualmente el método Younlon es muy tlifercnl•! del di! h.u.:c 10 
años, ahora se J¡,-¡n lncot·pori\do las mcjor·cs ltlt~.~.:. d1! diseño 
orientado a olljctos y de análisis. 

Este ml!todo consta de dos partes: herramlf'nt.-¡r; y técnicas. I.;H; 

hC>rramientas son una variedad de diaqramas qr·,'tficos 11natlor. para 
modelar los requerimientos y la arquit<!ctur·,, tle un sistemil de 
información, El m.ís fami 1 icH de estos diaqr,-¡m.ts e!> el di,¡rp·ilma de 
flujo de datos (UFIJ), este diagrama ha sido exterulido para soportar 
sistemas de ti empo-rea 1. Los DfD i nc 1 u yen contr·o 1 de flujo y 
control de procesos (ver figura 1.1 .4). 

Este ml!todo 
y d i.vJrcunas de 
f)j,-¡qramc.). Pc"lra 

incluyr> atlemás diaqr.,mas cntidad-n:-l,,clón (1-:RD'.:.) 
tr<~nsición de cst.ados (!>TU'5 Sl..,t.e Tr·<uE;ition 
terminar de definir los r·P.qurr imicnt.os ele un 

SIStema pueden empJe,-¡r~F' las cart,¡!; (h~ c~;t r·uclu¡·,, par,t mosl¡-,¡r lil 
onJ<lnización de los módulos que ~cr·<'in implcmcnt.ulo!;. 

Para complement.1r l.t descr·¡pción del ~istem.t •~" nr.cr-~;ilr·lo un 
soporte textu.""tl .""tdtcional, un diccion<trio de dillo!O que nos des•;r·ib,, 
cómo cst:il compllesto cada elemento y un con junto dC' r.~;pcci f icac ioru~s 
de procc5oS que nos describa el compot·tamiento de los procesos en 
cacl.1 n 1 ve 1 • 

r.., tCcn1Cil del mCtndo Vounlon conslil de q••Í•l!; que 11os llevan 
de Id nild;, a un mo•lclo riC!l sistem., bien orq<~lli/.•Hio. E!;l.a t.ócnic,, 
constste en particionc1r (rop-down) el si:;(¡~ma en funcione~;. 
Actu¡¡\mr>nte el mCtodo usa unél técnic,-¡ conoci<lcl t·omo p,u·¡ ic10n de 
CVI!rltos, inicia dibuji\1\(lo un tliarJI'".llllil de contexto el •;u,,¡ permitP. 
definir lo~ al•~ance~; 11c!l s¡~;tcmil y la~; intcrl.u;•:~; con luent.c:; 
externas. OC!spués dP. l."ls entrevistas <11 usu.1rin se e.scrib<•n un.1 
serie de eVf!ntos que ocurren en el mr.dio ,,mhi~>nt.~ cxten1n y,, l.1s 
cu<lles el sistema responde, esto nos permitf! •lih••iar un primer 
diaqram<l de flujo (le d.""ttos. ror ejemplo, s1 un ~;¡~;tema •:n,,~;t,¡ tic 
100 eventos tcnrlrti. 100 hlll"lJuj.-¡s e-n el DFO, doulo lo <~llll!l·ior C'!l 
postble part.icionar los eventos en v,1rio~ y unirlo~; ~~n un !;olo 
proceso, <':Sta técnica cos parf':cida al di51!IHJ orient.•do ,, ohp!lo~;. 

El Diseño t:struct.ur,u.lo Younlon const.il el•~ '1 p.!!iO!;: 

MuP ~; 1 1 ,, 1 tl!i 
tr.lll!;form<lll tJ,-¡ttJ•;. 

:.i!;l Pm.lr, como 1111 •·<111 Jllnt" •h• 1" '":•--;n•; '111" 
Los dr.''ll•'m.J!; d,!! lujtl dP tl.d"•; nn', nHI••:;t¡o~\1 1.1 
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relación entre los procesos y el flujo de información entre ellos. 
l.os rcqueri.mientos en tiempo real son mostrados en los Diagramas de 
flujo de datos vla el control de flujo y el control de procesos. 
Los comportamientos dependientes del tiempo son mostrados con 
diaqrama5 de transición de estados y los datos involucrados son 
modelados de una forma simple en modelos de entidad. 

2.- cartas de Estructura 

t.as carta de estructura son una jerarquta de unidades 
proceduralcs que documentan el control del programa, el flujo de 
información entre programas y la lógica del programa. So emplean 
lns tl!cnicas de Análisis de Transformación y de An.!ilisis de 
'l'riln!>acción. 

J.- Evaluación del Diseño 

F.n este paso se mide la calidad del disei'lo, para ello son 
empleados los criterios de acoplamiento y cohesión. 

4.- Preí'aración para. la Implementación 

T.a lógica diseñada del programa es empaquetada en unidades de 
implementación tlsica, llamadas unidades de carga. 

MCtodo do Ingeniería de Información (IEM) 

El método de Ingenierla de Información sigue un enfoque top-down, 
desarrollando modelos en cada una de las etapas del ciclo de vida 
que cubre (e~trategia; análisis y diseño), forzando el desarrollo 
de sintemils al manejo de metas y planes de estratcgi<'ls. 

IEH ofrece modelos de alto nivel para la represent<lci6n total 
de una empresa durante la etapa de estrategia y diaqramtts de 
estructura de diltos detallados (entidades, relaciones, atributos), 
de~compo~ición funcion<'ll, flujo de d<ttos y diagramas de 
dependencia, y definición de reportes y pantallas durante el 
"an.'ílisir. df! lil~ ucccsld<tdes de la empresa". D1c1gramas mostrando 
detali<Hiilmentc 1.1 lóqictt del programa, incluyendo el manejo 
¡H·ocedural y criterios de selección durante subsecuentes disei'los y 
construcciones de sistemas. Hatricen para el m<lpeo de las 
~!;pecific.lciones del an,\lisis y del diseño, para el manejo de 
met.1r., conJUIIt.u¡do los rcquerimiPntn~ de datos y procesos, y 
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a::;egurando una terminación e integración de éstos a nivel de 
ap 1 icaci 6n. 

MOtado DeMarco 

DeHarco es un ml!todo de an~l isis estructurado orientado a procesos. 
t:s utilizado para derinir los requerimientos de un sistema. en las 
et.1pas de an.'\lisis y disei'lo. r>urante la etapa de an.1lisis, OeHarco 
obtiene todo el conjunto de información manejada por los procesos 
actuales y los nuevos requerimientos de ~sta y los utiliza para. 
obtener la descripción de la funcionalidad del sistema a construir. 
tJLi 1 iz<t diaqramas de !lujo de datos como técnica de representación. 

P<tsos que siquc: 

1.- Constrtlir el modelo fls1co actual (DFDs). 

2.- A partir del modelo ftsico, construir el modelo lógico actual 
(llFDs). 

J.- Construir el modelo lógico del nuevo sistema a desarrollar 
incluyendo UFos, definiciones del diccionario de datos, y 
especificaciones de Jos nuevos procesos. 

c.- c1·car tiria familia de nuevos modelos flsicos (DfU). 

S.- Obtener el costo y tiempos estimados p.1ra cadcl modelo. 

6.- Seleccionar el modelo más adecuado. 

Mittodo Jack9on 

.Jacknon es una tl!cniCil de diseiio orientad<~" datos, la cual se basa 
en la~; cstrucltu·,,s de datos requeridds pard obtener la estructura 
ele lo5 procesos. Empieza asumiendo que la ct.lpa de análisis ha sido 
tcrmiu.tdil. 

~:n ea t. e ml!t odo e 1 si s tem.1 es vi nto como un conjunto de 
procet;ns, Jo~ cu.11es SI"! adecuan .., 1 m<lnc jo de las estructuras de 
d.tt.o~;. 1.1s cu;tlcs ~;r.> considertln rsl.\ticas. Utiliza bc\sicamente dos 
t_{!¡;nic:,IS dr.> di;H¡r.lm,\Ción: di•lQl"'ilmtlS dP- t·ede!>, en los cuales se 
mue!ot.r·il 'd 1 lu ¡u de información a t.ravós de los procesos, y 
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diaqrarn<lS arhorescünt~s, en lo!> cualüs se mue.r.tran lds relacion•~r. 
jer~rquicas entre proceso!> y datos. 

Pasos que sigue. 

1.- Dibujar los diiHJramils de estn¡ctur·.,. dú c'lr·bol mor.trando 1'1 
flujo de d~tos entre cada l'roceso. 

2.- Tomar todas las estructuras anteriores y formar un =:>olo 
programa. 

l.- Mostrar las operaciones necesarias para obtener la información 
de sal ida de la información de entrada y asignar cildl\ una de 
~stas a los componentes del programa (procesos). 

4.- Transcribir el proqramil a un texto e5tructurado, c'llJrf.'qilndo 
tanto lóqica de selección como ciclos. 

CA.C.E•Hethod c5 una metodoloqta que quta lo!> proyectos hasta su 
terminación, a través de la aplicc"'!ci.ón de técnic.'ls riquro~;as p;,r·a 
el desarrollo de sistemas. CASE•Hethod permite <lprovechar lo!• 
beneficios de la tecnologla CASE dando un milrco de trciiMjo 
estructurado para quiar y control<tr el desarrollo pn>ductivo ,, 
tr,..,vés ele toda el ciclo de vldcl. 

F.sta Metodoloqia abarca el anAiisb; esl•·dtél)ico, ilnc"'li!;is 
detallado y diseño relc"lcional de sistem<ts, pül·mite llev<lr el 
control del sistema en todas las etapas de su ciclo de vida de un;¡ 
m<~nera eficiente, or·denada y con la cert.ezil de <llcilnzar las 
objetivos del sistern~. 

Durante l<ts et<Jpas de cstrateqia y ilrlc"'li~•~ del ciclo~~~ 

desarrollo del sistema, CASE'Hethod establece una comunictlción m;\~; 
efectiva con los usuarios a través de t.écnic<~~:. f'!ntrevist.il~; y 
diaqramación. Al entender· los requerimientos de lo~ usuarias d(>sde 
el principio, se evitan revisiones costo~as posl.~1·1or·es dur<lntc el 
dcs<~rrolla de sistcm<~s. 

Un,) vez ulcnt.i f icadnr. los r·equeri.mtr.onto~ CA:;J·:•Mt•t hotl del ine PI 
••nino ópt.tmo para completar· Pstas t.arc.1~• r·:lpido~mt!nte y con 

•:is!Ón, bcls.índose Pll la t.eor1a rt!l.lCÍOihll y PXIPnsto~: cont¡nl••:; 
<1<: ¡;,¡ l itJ,¡d. 

-" 

~H'IOIHOI l><il"' 

El método C/L'>f-." es un métadq f.np-clown, en el la 'qente estc'\ 
antes que las documentar., es un método de alllochcquco, la 
implemcntc1ci.on es inrh~pentlientc de los r·eqlterimient.os, este\ 
discñcl.dO para el camiHo, se impl•~mt!nt.a en fonna mct6dica en todo 
tiempo. 

CASE•Hethod soporta tadils las etapas del ciclo de vida de un 
sistema. 

~1515 
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Fiquril 1. l. 5 
CASE•Helhnd Enfoque ürotructurado 
p.1rd el dC!sarrollo de st~:t.t!m,l~: 

CASF.•Hcthod comlf.'lllrl con el principio del ciclo de vida, 
involucramlo a u~u<tr 10~ y admlniSI.radore!: P.n },¡ l!~~per:ificación tle 
los objetivos, requerlmi•'nlo!: y pr iorttlclde~; q111~ !'le necesitcln p.tra 
tle:.,¡r·rollar el Sl~;tcm~-

H¡cnt.r.l:. s1~ prPp.ll.lll ·~ inc¡PmPnt.ul modelo:. oiPt,,Jlatlo:~, pueden 
Ve! ific;,Jr!iC y L'OII!IImoll~··~ COl\ lo;. U~iU,H"IO!i, o:lt!,\11'10 jl!Otot ipO!O 
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conceptuales del sistema completo. Ut.i 1 izando el enfoque 
comllin.~do con técnicas bottom-up para el chequeo 
CASE*Mcthod incrementa la calidad en cada etapa. 

top-down, 
cruzado, 

Despuós de completar el análisis, se crea el diseño t1sico y 
lóqico para un dcscmpciío y flexibilidad óptimos. La documentación 
e implementación del sistema ocurren paralelamente, mientras se 
construyen los sistemas y se realizan pruebas de unidad. La 
transición incluye el entrenamiento del uauario, la conversión de 
datos, y las pruebas del sistema, basado en una planeacl6n anterior 
durante el anAllsis y diGeño. 

Etapa Estrat6gica 

- r-:stableccr los objetivos, 
ncqocio. 

prioridades y restricciones del 

- Determinar los Hodelos de Negocio. 

- Establecer el compromiso administrativo, 
de involucrar usuilrios clave y !H!cciones 
retroalimentación. 

ganado a trav/!g 
interactivas con 

- Real izar el plan de desarrollo y arquitectura del sistema. 

Etapa de Anillsis 

- F.specificación de laG modelos detallados de la información 
nccesar1a para el sistema, v1a los diagramas Entidad-Relación. 

- Crear los modelos de los requerimientos funcionales utilizando 
tócnicas de descomposición. 

-Realizar di<1gramas de flujo de datos y matrices de chequeo 
cruzado. 

-Realizar el plan de transición incluyendo la conv~rsión y el 
entrenamiento. 

-Definir la frontera del sistema. 

Etapa de Diseño 

- Establecer la arqllitPCtiJra dctal lada del sistema. 
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- Tran~fc1·ir Las cr,pccificacioncs conceptuales a diseños flsicos 
y lófJ ices. 

- Real iz.~r el diseño relacional de bases de datos incluyendo 
cons ider.1c i oncs de rend im i ente y tamaño. 

-De las especificaciones funcionales, realizar el diser.o de 
módulos para ~istema de aplicacl6n. 

-Realizar el diseño para la transición y la arquitectura de 
pruebas. 

- llti 1 izar las matrices que ilustran referencias cruzadas de los 
componentes del sistema, para control de cambios. 

Etapa de construcción 

Creación de la base de datos relacional. 

Implcmcnlación de los siGtemaG de aplicación. 

Pruebi-1!1 de unid.1d y revisioneG del usuario. 

- 1\.segiJramicnto de la calidad y aceptación. 

Etapa de Documentación 

- Oocument."lc i ón del sistema. 

- Material de entrenamiento, operaciones y gu1as del usuario. 

Etapa de Transición 

- Conversión de los datos. 

- Ejccut.lr las pruebas de simulación paralelas. 

- t-:jecutar !.~s 

1 uncionill id<lll, 
y ~;cguridad. 

- 1\.ccptilción del 

pruebas del sistema para verificar la 
1·endimiento, utilidad, 1·ecuperaci6n, integridad 

usuario. 

- Convort ir el sistema para que sea completamente operacional. 

.11 



Etapa de producción 

Realizar 

- f.jücut;,r 
sist~ma. 

las prur.hM> de integridad. 

los procedimientos de sopnrlü 

- Registro de los n~qucrimicntos. 

-Cambio en los procedimientos de control. 

- Realizar revisiones regulares. 

~~~ ]llhlll '"''"' 

1' mon i toreo del 

ANAI.ISIS COMPARATIVO DE LAS HETODOLOGIAB DE DESARROLLO 

Método Warnier/Orr (DSGD) 

OS~IJ es un m6toclo enfoc;.Hio a datos el cu<tl contcmpl~ (lnici'lmPnte ¡,, 
~t.apa de cltsefio. O~rlVil \as est_r-uct.UI"•"lS tlrl proqr.tm.l de 1.1:~ 
estructuras ele los datos siquienrlo una er:tr<~teqia hot tom-trp, pont! 
,"'tenc ión en 1 it!l sal idas requeridas p•u·a ohtencr 1 a5 cstn1ctur<tr: de 1 
proqr·ama y las estructuras dc los datos de entrad<~. 

P.tsos que sique: 

1.- Fase de planeación del proyecto: un plan dP. proyecto P.~ 
desarrollado, con¡untanclo las mP.tas de I."l empr·csa con un 
sistema particular de objetivos en un nivel de disefio lóqico. 

2.- Fasl:! de definición de requerimientos: se dcfinen en un nivel 
lóqico y después en uno fisico los requcrimironto:. de usua.rios 
y sistem.l, adcm,'is de las necl:!sidadc5 de hanlwan•. !le 
desarrollan dL"lqramas de entidades (Diaqr."'mas de Flu¡o de 
D<ttos) describiendo las entid.tdes y las l.riHJsaccionr.s quc 
pasan a través de ellAs. I.,-,s sal iol.1s el,. lnr: pr-ncf~r:o:. son 
mo5t.radm; utilizando diaqr·amas de W,Jrnier-Or-.- y un drccion,u-io 
de datos. 

l.- F.lse d~ cli~eño: Se hace un diseño lór¡ico dro lol hasr. rlro d,-,to:; 
normi'll izadil y un fl1sefio \óqico d~ procP.so:>, lhJS,tnclo tlp~;IHH~~~ 

al llischo risico. 

l. lfl 

Ventaja9 

- Ofrece a los clisefi~d•,rcs pasos 
sol;, técnic,-, de di<~qr-am"ción 

finaL. 

~· 1 1 1 os a süqu i r, 
clo~: •• le el principio 

MI'IUiotU ,,., ... ~ 

usando una 
h<H>la el 

W.Jrnicr/Orr es bucno par" sistr.mils pequcfws orient<tdos a 
reportes. 

Desventajas 

- nsso utiliza las s;,licias 
requerimientos del mismo. 
caus.-,r un manejo incompleto 
de procesos. 

del sistüma para obtener los 
Esta rstrateqi.-, hol.t.om-up puede 
o redundante tanto de ddto!; como 

- nsso sólo pur!de contemplar estructuras de d<~tos jcrárquic<ts, 
por lo que no SI:! pur.dc ut i 1 i 7.<tr l:!n e 1 d 1scfio de lMscs de d,¡tos 
¡elacionales ni (listribuillils. 

Método de Gane and Bar~on 

Gane and Sarson es un método bot tom-up que contcmpl<l solamente las 
etapas de análisis y discfio. 

Paso!> que sigue: 

1.- Construir el modelo lóqico del sistc~ma dctua.l (DFDG). 

2.-

J.-

··-

construir 
incluyr!nclo 
diccionario 
procesos. 

el modr:>lo lóqico 
espec 1 [ icctc iones 
de datos y la 

dr.l s1st.ema <t desarrollar 
cslnlctur<tdas (Ot'lls), un 

nueva e5pcc i f i cae i ón de 1 o5 

Realizar un anAI1sis cnticlafl-reldción. 

Diseñar las tahl.,s de la bilse de datos que soporten al disefio 
lógico. 

!t.- Crear un mlr>Vo morlelo (~sien llt!l st:;tem.l q1rc consiste en 
rcdibu¡ilr el orn p.u-,J qu,. muc~tn~ dc una fnrm.1 m.-,:-; pr·eci:><J los 
cJ,-,t_os ele! sistP.m.i como r·c:r,u\t,tdo drol ,,n;'tl isi:; P.nt idacl-r·eJ,Jción 
y de la norm.tl ÍZiiC:IÓn. 

l. 1'1 
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6.-

7.-

Dividir el IJFIJ en un conjunto de procesos. 

F.~peci(Icar los detalles de implementación de cada uno de los 
procesos. 

Ventajas 

- I.as convenciones que se ut i 1 izan para los diagramas de f 1 u jo 
de datos son las más rigurosas de todos los mótodos. 

- Los di aqramas son fA e i 1 es de entender ya que s6lo constan de 
cuatro simbolos. 

Desventajas 

Es un método en el que puede omitir el anAlisis conceptual ya 
que empieza con una vista 16gica del sistema existente con lo 
qul:! no se podrta satisfacer completamente las necesidades de 
los usuarios. 

- Tiene un 
inadecuada 

alcance 1 imitado, ya 
las etapas siquicntes a 

que contenpla de 
la etapa de diseño. 

forma 

Hittodo Yourdon 

El Dtscilo cstruct urado Yourdon es un método que cubre la etapa del 
diseño durante el ciclo de vida de una sistema, fue desarrollado 
por Ed Yourdon a principios de los 70's. Es altamente recomendado 
para soluciones basadas en lenguajes de tercera generación y se 
enfoca al diseño de sistemas en tiempo real. 

A finales de 1988 una revista de software public6 que el 30.2\ 
de las empresas ~n Estados Unidos (la mayor la de gobierno, con 
necesidades de tiempo-real) emplean para el desarrollo de sus 
proyecto~ el método Vourdon, mi entras que e 1 29. 2\ (la mayor la 
empresas comer·c i .11 es) emp 1 ean m~ todos top-down. 

F:l método Vourdon examina los sistemas actuales, obteniendo 
mu:ovéts soluciones de los viejos siztemas. Este m~todo es capaz de 
ohtC!ncr soluciones para las necesidades de defensa y en general de 
cu,tlquier.t apilCétción en tiempo-real. 

Younlon e!>l.'l l•lcn a<la.pti!odo par."l la P.lilJl•"l de rlisei'lo de los 
~·~~:trm.t:> qu•~ r•~quicrcn de p!·oce~c:tmicnto en t.¡empo real y se 
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r·equ i f~rc de un.l et "P" de 
d1rlc1ir untl luncionalld.HI 
flrocc(lural limit.c.lda (JGI.). 

Ventajas 

<"lll<'i l 1515 
complcJd 

eMtensi\. Este m~ todo 
con solamente una 

- t-:s ideal par,¡ aplicaciones de tiempo reaL. 

puede 
l6gica 

-Tiene un diccion."lrio de datos para la C•"lptura de detalles 
l."llcs como ilt.ributo~ e identificadores únicos. 

- No depende de los d."ltos, dado que se concentra en la 16gica 
petra los proqramas. 

- Yourdon es In mejor p<~ra sistemil:. pequeño:. con requerimientos 
de p¡·oces<lmicnLo procetlurdl y sistemc"l de archivos simple. 

Desventajas 

- No ofrece un01 técnica propia pcl.ra. e 1 modr 1 ildo de ~nt idadcs o 
di~>j!flo de d.ttos, pero recomicndct el uso de la técnica Chen de 
l:nt 1 d,td Re 1 clC 1 ón. 

f"'iqura l.1.6 Modelo F.nt1d<1d 
Hclación de Chcn 

Esta técnica es mt<y !;up~rf icial Y•l. que no nos da mucha 
info 1 mación <IC<!IC•I de las rel.IciotH!S entre C!ntidildi!S. Ezta forma de 
n~pl e~;cntilc i ón rto C!l muy r iqurosa y la. norma 1 i zac tón es imposible. 

-un se cn~a un modelo de requerimient-os de información 
cunc:eptua 1. 

·----. ··-----·-···------
. ? 1 
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Sus diagramas no se prestan para describir los r·equer·imi~ntos 
del nintema, éstos son vistos únicamente como un mec;lni~mo de 
procesos ant i e i p<ldos de 1 sistema. 

- No estA diseñado para alternativas futuras, sus Ufll'!l no e!ltán 
bien relacionados con las otras técnicas emplead;u; por 
Yourdon. No es posible saber en esta representación, donde 
tom~ luqar el proceso dentro de la organización. Yourdon no 
dcf1ne el alcance de cada diaqrama di! flujo de datos. 

F.s un conjunto de t.f>cn~cas que no están bien acopladas, 1.01s 
cartas de Estructura no corre!lpondcn a los Diaqrams F.ntid;ui
Relaci6n. No hay funciones que verifiquen el modelo de datos 
ni es posible verificar la lóqica funcional del proqrama. 

r.L alcance 1 imitado de 'iourdon es su m?Jyor desvcntajél Y•' qnr. 
pasa por ,,lto la etapa de an~l isi.s y postcrior·mcntc lar; ctap01~ 
de desarrollo y se concentra en el disef\o de prmJI·OimoHi 
proccduralcn. 

Método da Ingeniería da Información (IEM) 

El método 
estrategia, 

de Jnql!nil!rla de Información cubre 1M> etapa!> 
an.\1 ini.s y diseflo del ciclo de vida de un sigtcm,•. 

<lo 

Tf.H ofr(!ce diagr~m01s de estructura de datos detalladog 
(entidades, r~lacioncs, atributos), descomposición funcional, lluju 
de datos Y d1agramas de dependencia, y definición de reporles y 
pantallas. 

ventajas 

- Es un método que no cstii enrocado a pr·ocesos ni '' dato~•. 
obtif!ne los requerimientos de inform.lci.ón en un cont.exlo 
btllanccado (!lltl"C neccsid,¡()cg de usuario y pl.lncs P-~lr·,,téqico~;. 

- l.os prototipos de ent idadcs y mode 1 a do de funcione~ ~;on hcchils 
en conJunción con el usu<lrio, para ascqur·,u· la sa.t.i.slar.ción de 
~st.e. 

1 • ) ") 
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Desventajas 

- IF.I1 no contcmplil el cntrcn<tmicnto il usuaraos, 
ni diseño f'll tiempo r·c,\1. r.an etapan de 
producción son li"ilt.ulils en ror·ma m¡nima. 

- l.os modelos de lf.H son diftciles de leer. 

M6todo DeMarco 

dClCIIII\I'IlldC ión, 
conslrlu..:ci6n Y 

. t<ldo a procesos. 
DeMarco es un método etc an."tl i!>i.s estructurado o_ra_cn ' 61 amente en 
Al igual que el método Gane ilml Sarson es ut.1l1Z•111° 

5 

tas etapas de an:illsi~; y diseño. 

Ventajas 

-DeMarco empieza el an."tlisis utilizando 
existentes, lo cu,"ll ayuda a los analistas 
tener un plinto de ulicio. 

tos 5 ¡st.P-tn<lS ya 
y ti¡ sei'ltHiorcs a 

-El modc}."tdo del si~tf!mil es inici.Hio con racilid,Hi. 

De~vuntaja!l 
el j !>Cf\O. 

- DeM.,Irco sólo contcmpl•"' las ct."tpas llc análisi~> Y 

11 .-cf,a el nuevo 
- Tiene un enfoque bottom-up, en el cu<ll 5 '' ( ·' cxistt!nle, 

si stem~ tom<lndo l01s cspcc i f i c,,c i. unes de 11110 ya tos nuevo!; 
teniendo como proi.Jicma 1..1 posible pén.ladd tiC 

requerimientos. 

M6todo Jackson 

. . _ . s 1 a clM 1 se basa 
Jackson es un01 técn lCo"l de d I!>Cno or tent<tdil a <},\tO. ' 1 , p<;t.ruct.nra 
en las estructuras de cl,\tos rcqurrlcl01s P•"'''' oht.en~""r· ' 1c -~n·ocesos. 

. . t conJunto t • 
de los procesos, el sast.cm,.., es Vl!i o com~ un .

6 
. di<HJramt~s de 

Ut.tliza b,fisicamente do!i técn¡cas de dtC\qramacl 
11

" 

redes y d iaqramas arborescentes. 

Ventajas 

·---- ·-·· --------·· ------- ----···· 
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Es cap~z de contcmpldr requerimientos tanto a nivel sistema 
como a nivel proceso (módulo). 

Desventajas 

Esta limit<tdo al manejo 
procesamiento en batch por 
bases de datos. 

secuencial de 
lo que ignora 

Solo contempla la etapa de diseño. 

CABB•Mathod 

registros y al 
la tecnolog1a de 

CASE,Hct.hod el un ml!todo que contempla todas las et.ctpas del ciclo 
de vida. ~cdiantc la utilización de este Détodo se pueden conocer 
Las n~c.estdadcs de los usua~ios, sin que éstas tengan que ser 
cspcctftcadas por sistemas existentes. Utiliza técnicas bottom-up 
como herramienta para asegurar la exactitud y terminación de una 
tarea. 

~{\ Ventajas 

- CA!lE*Hcthod es flexible, ya que se puede adaptar con facilidad 
a proyectos de cualquier tamaño y complejidad. 

-Enfatiza la utilización de referencias cruzadas con el 
propósito de detectar posibles errores, usando para ello 
matrices y diagramas de flujo de datos durante las etapas de 
análisis y diseño. 

Ut i 1 iza cnt tdadcs conceptuales y e 1 modelado de runc iones para 
mostrar los requerimientos esenciales de la empresa, lo que se 
traduce a un diseño sin errores, es decir, se puede saber 
desde un inicio si el sistema va a satisfacer completamente 
las necesid<1des del usuario. 

- Soporta el m~nejo de prototipos de Interfaces con el usuario 
(pantalla~. reportes, etc) durante las eta.pas de disel'lo y 
construcción. 

-Sus l~c:nic.J5 de diaqr;unación son 
entender. 
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- Ofrece sugerencias para la elaboraci6n de documentacl6n del 
sistema. 

Daavantajaa 

No se puede aplicar el desarrollo de sistemas de tiempo real. 

- Necesita de una técnica para especificar a detalle el dlsefto 
de los m6dulos. 

Obaarvaclonaa Finales 

Despul!s del estudio y análisis comparativo de diversas metodologlas 
de desarrollo de sistemas, hemos podido observar que existen una 
qran diveraidad de m~todos para el desarrollo de sistemas. 

Sin embargo y de acuerdo al estudio realizado, se observa que 
algunas metodoloqtas ya han quedado obsoletas, pues se enfocan al 
desarrollo en lenguajes de tercera qeneraci6n o bien son para 
sistemaR de bi\5C de datos jerárquic;,s, muchas rlc ~stas metodoloqtas 
cubren sólo una parte del ciclo de vida de un sistema, es decir son 
incompletas, la mayoria de ellas se enfocan al diseño haciendo a un 
lado una de las partes m:is import."lntes como lo es el análisis. 
Algunos ml!todos emplean para sus modelos diagramas que son muy 
diftciles de entender, por lo cual se requiere de un entrenamiento 
especial para apl icarios, otros ml!todos por el contrario emplean 
diagramas tan simples que por lo mismo dichos diagramas resultan 
incompletos. 

Por otro lado basamos en la tendencia actual del mercado de 
softwaro hemos encontrado lo siguiente: una revista de Softt~are 
publ ic6 que hay un interl!s creciente en los ml!todos de ciclo de 
vida completo y top-do.,n. De la misma manera en que la programación 
estructurada reemplazó al código no estructurado de los 70's asl 
también en los 80's se muestra una adopción gradual de las técnicas 
estrueturadas que cubren completamente el ciclo de vida de un 
si~tema. 

Las caracterlsticas del sistrm,l que se desea implantar, se 
ad.1ptan completamente a un modelo ·L• bases de datos relacional y 
hemos podido observar con el estudio de laa metodologias, que 
much-"S ele ellas no fueron pensadas para este tipo de 
implementación. 
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Se necesita implantar un sistema de información compartida, 
que sea sencillo de aprender por los usuarios finales y que incluya 
una documentación adecuada, además de que contemple modificaciones 
futuras conforme la empresa crezca. 

Para el caso de estudio d~ esta tesis se n~c~sita un siscema 
de bases de datos relacional y se emplearA para este desarrollo los 
productos basados en la metodolog1a ChSE. 

El Método de Desarrollo de Sistemas Ci\SE•Ho;thod, es una 
metodolog 1a completa y moderna enfoca·~a a la tecnolog 1a de bas8S de 
datos relacional que cubre completamente el ciclo de vida de un 
sistema, nos brinda una estrategia de planeación de sistemas de muy 
alto nivel, nos permite realizar un análisis detallado del sist6ma. 
Cuenta con técnicas de referencia cruzada que aseguran que el 
modelo sea completo y exacto. Sus DFD's son mAs rigurosos que otros 
métodos. Se basa en la comunicación e.ntre usuar.ios y 
desarrolladores en el diseño de aplicaciones de 4a. generación y 
estados de post-diseño. 

El método CASE es un método TOP-DOivN, es un método de 
autochequeo, la implementación es independiente de los 
requerimientos - tanto de hardware como de software, está diseñado 
para el cambio, se implementa en forma metódica en todo tiempo. 
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INTRODUCTION 

Welcome to EasyCASE Plus 

Welcome to EasyCASE Plus version 3.1, a powerful yet easy-to-use, easy-to-learn 
Computer Aided Software Engineering (CASE) tool. EasyCASE Plus is a 
graphical software environment designed to make the software development 
process more efficient and consistent. EasyCASE Plus features a consistent, 
industry standard IBM SAA/CUA compliant graphical user interface (GUI), 
similar in appearance and usage to the Microsoft Windows and OS/2 user 
interfaces, anda dBASE 111 Plus compatible data dictionary. 

You can use EasyCASE Plus to perform structured analysis, structured design, 
and data and information modeling. Eas·-CASE Plus supports the foUowing types 
of diagrams: 

• Data llow diagrams (DFDs) 

• Transformation graphs (TRGs) 

• State transition diagrams (STDs) 

• Structure charts (STCs) 

• Entity relationsbip diagrams (EROs) 

• Data structure diagrams (DSDs) 

• Data model diagrams (DMDs) 

• Entity life history diagrams (ELHs) 

• Logical data structure diagrams (LDSs) 
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With EasyCASE Plus you can ere ate charts according to these methodologies: 

• Y ourdon/DeMarco 

• Gane & Sarson 

• SSADM versions 3 and 4 

• Ward & Mellor 

• Hatley-Pirbhai 

• Yourdon/Constantine 

• Chen 

• Martin 

• Jackson 

• Bachman 

• Elmasri & Navathe 

• Shlaer & Mellor 

Why Use EasyCASE Plus? 

EasyCASE Plus automates the analysis and design phase of your project's 
development, eliminating some of the more mechanical, repetitive tasks so you 
can focus on design logic and concepts. EasyCASE Plus also provides support for 
real-time systems development and data and information modeling. 

EasyCASE Plus 3.1, with its easy-to-use graphical user interface, malees it easy to 
select and manipulate objects on charts. The pulldown menus give quick access to 
commands without having to guess at, or remember, command names. The scroll 
bars enable you to access portions of the chart that are not currently visible. The 
dialog boxes allow you to select options, enter information, etc. 

The integrated dBASE III Plus formal data dictionary malees it possible to 
achieve a high leve! of consistency, because once you've described an object in the 
data dictionary, you can reuse the object, plus any relationships it may have, over 
and over, on the same or different diagram types. 
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You can link objects and charts in a hierarchy to provide functional 
decomposition. Once the objects or charts are linked, you can easily move back 
and forth between the various levels. You can also link text files to objects, and 
edit them using your preferred text editor. In addition, you can link chart objects 
to records, elements, and control tables to define data structures. 

EasyCASE Plus lets you document your system as you proceed with the design. 
Y o u can access text files, export diagrams into a word processor or desktop 
publishing program, expr>rt lhe data diclionary to a database, create and print 
reports and oulput lhe charts directly toa printer, plotter, or file. 

How EasyCASE Plus Works 

You use the chart editor (EASYCASE.EXE) to create, save, load, modify, and 
print charts. You describe objects on charls lo the data dictionary from within the 
chart editor, and link the charts ( and the objecls on them) wilh other charts to 
create a hierarchical system of diagrams. The chart editor is completely 
integrated with other parls of the product. Y o u can access the other portions of 
the product via the Utility menu. You can also access other external programs 
(such as your word processor or database) via the Utility menu. 

You use the Data Dictionary and Reports Manager (DDRM.EXE) to add, 
modify, delete, copy, and rename dic1ionary enlries. You can also browse data 
dictionary entries, export and import entries, and pack and sort the dictionary. 
You can also merge data dictionaries from olher projects and/or other users. 
You can also print predefined chart and data dictionary reports lo check the 
consistency and logic of your work. 

The Analysis Manager (ANAL YZE.EXE) is an optional, add-on module, 
included with EasyCASE Professional and the EasyCASE Plus Developer's 
Edition, lhat you use to verify the consistency and logic of your charts and data 
dictionary, and to print chart verification and level balancing reports. 

The Schema Generator (SCHEMA.EXE) is an optional, add-on module, 
included with the EasyCASE Plus Developer's Edition, that allows you to 
produce database schemas in dBASE and/or SOL format, from enlity 
relationship diagrams and the data diclionary. 

All parts of E:J>yCASE Plus are integrated and accessible from other parts of the 
program. Y ou can also access any of the modules directly from the DOS prompt. 
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About This Tutorial 

This tutorial provides basic information on using the product, enables you to 
practice with it, and gives you hints and suggestions on how to proceed with your 
own work. It is designed to help you get familiar with EasyCASE Plus and its 
most frequently used features. It is aimed at the beginning user who has little or 
no experience with CASE tools. It does NOT attempt to teach you about 
structured analysis, design, and data modeling techniques or methods. 

With EasyCASE Plus, you will find there are sometimes severa! ways to complete 
a task. This book does not contain complete details on everything you can do with 
EasyCASE Plus. See the Chart Editor User's Guide for more information on the 
tasks you practice here. 

For a comprehensive tutorial about the usage of the chart editor to create an 
ERO and populate the data dictionary with database structure defmitions, please 
refer to Appendix 1 of the Schema Generator User's Guide. That tutorial will 
take you through the process of defining a database using an ERD and then using 
the Schema Generator to create dBASE and SOL sebe mas. 

The EasyCASE Plus Package 

The EasyCASE Plus package includes the following items: 

• Chart Editor User's Guide 

• Installation Guide 

• This Beginner's Tutorial 

• Data Dictionary and Reports Manager (DDRM) User Guide 

• Methodology Guide 

• EasyCASE Plus disk pack with registration card 

• Analysis Manager U ser Reference (if you purchased EasyCASE Professional) 

• Schema Generator User·s Guide (ifyou purchased EasyCASE Plus 
Developer·s Edition) 
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To get started, you should use these items in the following order: 

l. The fll"st thing you should do is to install the EasyCASE Plus software on 
your PC. Read the Installation Guide first, and follow the directions to 
install the software. 

NOTE: If you want to use this tutorial, you need to install the Sample Project 
mes. 

2. Read this tutorial and go through the practices and lessons to learn the 
basics about the product and to become familiar with how the menus, 
commands, and chart editor work. 

3. Once you are familiar with the product, you will know which commands 
and features you would like more information about. Refer to the other 
doc;umentation to get complete information about EasyCASE Plus. 

If you are an experienced user and have used previous versions of EasyCASE 
Plus, read the Upgrade chapter in the Installation Guide for information on what 
has changed and how to upgrade your prior version projects. If you want to 
become familiar with the new EasyCASE Plus interface, go through Lesson 1 in 
this book and Chapter 2 of the Chart Editor User"s Guide. 

How To Use This Tutorial 

This tutorial is organized so that you start by learning basic tasks and skills, and 
then advance to more complex procedures. 

• This Introduction provides information about this and the other manuals in 
the EasyCASE Plus package. 

• The Basic Tutorial (Lessons 1 to 4) contains information on starting 
EasyCASE Plus and using menus, commands, and dialog boxes; plus guided 
practices in scrolling, creating a chart, modifying it, options, printing, and 
savmg. 

• The Intermediare Tutorial (Lessons 5 and 6) contains information on 
identifying objects by accessing the data dictionary, and on linking objects to 
other charts, text files, records and elements. 

For each lesson, you will see a short description of what is to be covered in the 
lesson. Next, the steps for the Iesson are listed. At the end of each lesson are 
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suggestions, alternatives, and extra information that you can try when you do your 
own work. 

Symbols and Conventions 

To help you locate information easily, these symbols and conventicos are used 
throughout the Tutorial: 

• Examples of what yo u should type appear as: 

CD\ECPLUS 

• Information you should note appears as: 

• NOTE: Important or supporting information looks like this. 

• Key names appear in small capitalletters: ESe. 

• Keys that should be pressed at the same time appear with + between them: 
CfRL+S. 

• Bulleted lists (such as this one) give you information or choices. 

• Numbered lists indicate procedural steps. 

Terminology 

Throughout the Tutorial these terms are used consistently to indica te operations: 

Click. You click the mouse by pressing and releasing a mouse button. To select 
an object you would click the left mouse button while the mouse pointer is over 
the object. 

Double Clic:k. You press and release the left mouse button twice in quick 
succ:ession. 

Select. You select commands and objects on a chart. When you select a menu or 
dialog box command, an operation is executed. When you select an object or 
group of objects on a chart, the object or objects is/ are ready for a subsequent 
operation, and EasyCASE Plus performs the next command you select on the 
selected object(s). To selecta command or object, position the mouse pointer 
over it and then press and re le ase ( click) the left mouse button. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 

! 



• 

lntroduction 7 

Drag. You move the objects oo a chart with the mouse. To move an object, select 
the object, theo press and hold down the left mouse buttoo uotil the mouse cursor 
turns into a hand icon. Use the mouse to move the object to the desired positioo 
on the chart. Release the mouse buttoo to place the object. Tbe same process 
applies to dragging selection boxes around. 

Enter. You enter information. To enter something, you type the information theo 
press the EI'ITER key. 

Cancel. To cancel a command or operation, press the ESC key. 

Tutorial Files 

Tbere are Tutorial files in the Samples subdirectory that you will need to access 
for these lessoos. These files are: 

• ECPCONTX.DFD 

• MODIFY.DFD 

Basic Skills Tutorial 

Tbe Basic Skills section of the Tutorial introduces the EasyCASE Plus user 
interface and the fundamental skills you will need. Tbe lessons are as follows: 

Lesson 1 Starting to Use EasyCASE Plus 

Lesson 2 Creating a Chart 

Lesson 3 Modifying a Chart 

Lessoo 4 Other Cbart File Operations 

The material in eacb lessoo builds oo what you have learned in preceding lessons. 

lntermediate Skills Tutorial 

The Intermediate Skills sectioo of the Tutorial takes you tbrough identifying cbart 
objects, describing tbem to the data dictionary, and linking them to other objects 
as follows: 
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Lesson 5 Interacting With The Data Dictiooary 

Lesson 6 Linking Chart Objects via the Data Dictiooary 

The material in each lesson builds oo what you have learned in precediog lessoos. 

Schema Generator Tutorial 

The Schema Geoerator Tutorial is provided in the Schema Geoerator User's 
Guide and takes you through the design of a sample database. lt familiarizes you 
with creating an Eotity Relationship Diagram (ERO), interacting with the data 
dictionary, linking chart objects to records, and defming databases using Records 
and Elements. lt also covers the generation of SOL and dBASE lll database 
sebe mas using the schema generator product. 
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LESSON 1 
STARTING TO USE EA -::-Y CASE PLUS 

Overview 

This lesson covers: 

• Ruoning EasyCASE Plus and loading a sample cbart 

• Cboosing commands from tbe pull-down menus 

• Cboosing options and supplying information via pop-up dialog boxes 

• Selecting cbart objects using tbe mouse 

• Scrolling and zooming to vary tbe display of tbe chart in the chart window 

• Exiting EasyCASE Plus 

Before you start this lesson, you should bave already installed EasyCASE Plus. If 
you bave not, see Cbapters 1 and 2 of the Installation Guide for information on 
bow to do tbis. 

NOTE: Keep in mind tbat EasyCASE Plus is designed to be very flexible, and 
tbat there are often many ways to accomplisb your task. At the end of eacb 
lesson, you"ll fmd information about alternative procedures. 

This lesson sbould take you about 45 minutes to complete. 

Running EasyCASE Plus 

You will begin EasyCASE Plus by loading a cbart from a sample project tbat is 
provided. In tbe next section, you will use tbis cbart to explore tbe EasyCASE 
Plus user interface. · 

Tbe following procedures assume you have installed EasyCASE Plus in tbe 
default (C:\ECPLUS31) directory on your hard drive, and the sample project in 
the SAMPLES subdirectory. If you have installed the product into a different 
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directory than the default, substitute the names of the directories you have 
created for \ECPLUS31 and SAMPLES. 

To start EasyCASE Plus: 

l. At the DOS prompt type: 

CD \ECPLUS31 

to go to the directory containing EasyCASE Plus. 

2. Al the EasyCASE Plus program directory, type: 

TSRINT 

This loads the memory-resident program TSRINT. lt is a small utility task 
switching program, enabling you to suspend the EasyCASE Plus charting 
program and run EasyCASE Plus· adjunct programs (such as the Data 
Dictionary & Reports Manager), as well as externa! programs or DOS 
commands. 

3. At the EasyCASE Plus program directory, type: 

EASYCASE SAMPLES ECPCONTX.DFD 

NOTE: ECPCONTX.DFD is a sample data flow diagram used for the EasyCASE 
Plus tutorial. 

4. The U ser N ame dialog is then displayed. 

5. Type in your name (up to 24 characters), and click on the 'OK' button. 

r-------------~~ Enter User NaMe ~~------------~ 

User NaMe : John R. Hopkinsl 

[ [Cancel] 

Figure 1.1 User Name Text Entry Box 
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NOTE: If this is the first time you have run the product after installing it, you will 
f~rst be required to enter your (registe red user) name, company and product serial 
number. Refer to the Installation Guide for further information about how todo 
this. 

A message indicating that the program is loading the data dictionary for the 
project is displaycd. The sample data llow diagram, ECPCONTX.DFD, is then 
automatically loaded and displayed in the chart window. 

For more information on running EasyCASE Plus, refer to Chapter 3 of the 
Installation Guide. 

The EasyCASE Plus User Interface 

The EasyCASE Plus user interface is designed for clear, consisten! and efficient 
use of commands and objects. If you bave used other windowing applications, 
(such as Microsoft Windows 3.0) you will find familiar elements here: pull-down 
menus, icons, shortcut keys, scroll bars, and pop-up dialog boxes. 

Take a few minutes to familiarize yourself with the screen layout: 

The sample chart that you loaded (ECPCONTX.DFD) should now be displayed 
in the chart window. This chart is larger than the chart window to help illustrate 
some of the display tools. For the remainder of this lesson, you will use this chart 
to become accustomed to the EasyCASE Plus user interface. 
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Figure 1.2 The EasyCASE Plus Chart Editor User Interface 

The Chart Window 

A cbart contains a maximum of 32 rows and columns roughly equivalent to 6 
sbeets of regular U.S. letter size paper (3 wide by 2 high). The chart window 
displays an 8 column by 9 row section of the entire chart. 

Menu Bar 

The Menu bar (located at the top of the screen) contains the ten pull-down menu 
options. These are described in more detail in a subsequent section. 
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Drawing Grid 

The drawing grid segments the chart into positions that symbols can occupy. Each 
"box' on the grid can hold a symbol which is centered in that box. The chart is a 32 
by 32 grid of these boxes. The outline of each box is composed of fl.nely spaced 
dots. All other objects that yo u place on a chart ( connections, couples, la beis a.nd 
lext blocks) will "snap" (aulomatically move) to locations indicated by the more 
widely spaced dots. 

Seroll Bars 

The horizontal and vertical scroll bars make it easy to move around large 
diagrams. 

Scroll Arrows. The scroll arrows move the chart one row (up and down arrows) 
or column (left and right arrows) ata time. You can increase this scroU increment 
to 4, 8, or 16 by using the ctRL, ALT and SHIFf keys, respectively. 

Scroll box. The Scroll box moves the position of the chart window relative to the 
entire chart, when you drag it along the scroll bar. 

Status Line 

The Status line contains the chart offset coordinates, the curren! level number (in 
a li.nked chart set), the fliename, descriptive name, and type of the curren! eh;;.. •· 

Prompt Line 

The Prompt lioe, located below the status lioe, displays status aod error 
messages, or prompts you for your next actioo. 

Redraw lean Button 

This icon, located in the lower right corner of the screen, refreshes the chart 
window. Use this if 'debris' has beeo left behiod in the chart wiodow as a result of 
addi.ng, deleting, or moviog chart objects or text. 

Quiek Zoom lean Button 

This icon, located in the lower left corner of the screen, is a toggle switch that 
zooms out to display the fuU chart in the chart window wheo you click on it, and 
theo returns to actual size when you click oo it again. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



Page 14 

Explode Up and Down lcon Buttons 

These icons, located in the lower left corner of the screen, let you move between 
a chart object and a chart, text fUe, record, control table, or element that it has 
been previously linked to. 

Exit lcon Button 

This icon, located in the upper left corner of the screen, allows you to quit the 
application. You will be prompted to save the chart if any changes have been 
made. Y o u will also be pro m pted to save your preferred option settings. 

Chart Object lcons 

These icons, located down the left side of the screen, display the object types 
available for the current chart type. The object types displayed here correspond to 
those available in the Objects menu. You can select an object type to place either 
by using the Chart icons, or from an entry in the Objects menu. 

The Menus 

The ten pull-down menus located in the menu bar across the top of the screen list 
al! of the EasyCASE Plus commands available as follows: 

• File menu commands are for accessing projects; loading, merging, saving and 
exporting chart mes; printing; and exiting the program. 

• Edit menu commands allow you to copy, move, modify, delete, !abe~ and 
identify objects within the chart window. They also allow you to select a group 
of chart objects to manipulate. 

• Objects menu commands allow you to select symbols and connections for 
placement on a chart. 

• View meou commands affect the display of the entire chart, or objects on the 
chart. They also allow you to zoom in and out of areas of the chart. 

• Optioos menu commands let you set the appearance of the user interface, and 
the characteristics and defaults to use when creating a chart and adding 
objects to it. 

• Explode menu commands allow you to move between linked objects and 
charts. 
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• Analyze menu commands allow you to invoke Analysis Manager functions, if 
installed, including chart rule checking and leve! balancing. 

• Scbema menu commands allow you to invoke Schema Generator functions, if 
installed, including selecting the schema type and viewing schema fLies. 

• Utility menu commands allow yo u to access the supporting EasyCASE Plus 
programs, as well as DOS and externa! programs. 

• Help menu commands provide quick access information to enable you to use 
EasyCASE Plus effectively. 

The individual components of the user interface ar lW you use them are 
described in Chapters 2 and 3 of the Chart Editor e_ . r"s Guide. Chapter 2 
describes how to access commands from the puU-down menus and pop-up dialog 
boxes. Chapter 3 describes how to scroll and zoom the chart using the scrollbars, 
mouse and keyboard. 

Seb.1p Chart Editor Options 

Prior to beginning to work through the lessons in this tutorial, please take a 
moment to make sure your chart editor options are setup exactly as follows. lf 
they are not, you m ay not get exactly what is described in the tutorial steps. 

View Menu 

Drawing grid 
Display title block 
Double 1 bar on EROs 
Directed connects 
Open arrowheads 
Filled arrowheads 
Rounded corners 

Options Menu 

Default # arrowheads 
Font type 
Default symbol size 
Auto flow routing 
Default label to ID 
Auto redraw after edit 
Prompt for # arrowheads 

On 
On 
On 
Off 
On 
Off 
On 

One way single 
Helvetica 
Normal 
On 
On 
Off 
Off 
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Preferences (via Options Menu) 

Auto identify Off 
Auto label Off 
Allow place new label On 
Auto export to dBASE Off 
Auto export to SDF Off 
Auto export to HPGL Off 
Update label from DDE Off 
Aag deleted DDEs lOs Off 
Warning beep On • 
Create backup chart On 
Use named cbarts On 

Explode Menu 

Sbow explosions On 

NOTE: When a menu option is On in the View or Options menu, a checkmark 
appears to the left it. For Preferences, when an option is On, an 'X' appears to the 
left of it. 

Getting Help 

Whenever you are uncertain about the use of a command or procedure, try using 
the on-Iine Help facility. ln many cases, you can find the information you need 
here much more quickly than by referring to the EasyCASE Plus Chart Editor 
User's Guide. 

To access on-line Help: 

1. Click on the Help menu option or press the Fl key. 

A pop-up dialog box Iists the available help topics, as sbown in Figure 1.3. 
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ABOUT TIIE CIIART EDITOR t 
IECHNICAL SUPPORI 
FILE MENU 

NEW CHARI 
CHAHGE CHARI IVPE 
LOAD CHARI 
MERGE CHARI 
DELEIE CHARI 
SAUE BLOCK 
SAUE CHARI 
SAUE AS 
EXPORI CHARI 
PRIHI/PLOI 
PRIHIER SEIUP 
CHAHGE PROJECI 

Figure 1.3 Help Topics List 

2. Click on the 'Merge Chart' entry. 

A text box containing the help information for merging charts is displayed 
as shown in Figure 1.4. Since this information extends past the size of the 
text box, you can use the scroll bar at the right of the box to scroll forward 
and backward through the available help text. 

Help on MERCE CHART t-I --------,0 
Use thls c~nand to load another chart or chart fragnent, of 
the sane type, into the current chart. This is a tine 
saving nethod for conbining charts or for including a 
fragnent fron another chart into the currently loaded chart. 

lo nerge a chart: 

ll Choose the Nerge Chart connand frOM the File nenu. 

21 lf the current chart has been nodified since it was 
last saued, a dialog box will appear pronpting you to 
saue the current chart before it is cleared fron the 

Figure 1.4 Help Screen for Merge Chart Topic 

3. Press the ESC key or click the right mouse button to remove the help text 
box and return to the Help tapies list. 
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4. Press the ESC key or click the right mouse button again to remove the help 
tapie list box, and return to the chart. 

Selecting Single Objects on the Chart 

When you want to move, copy, delete, modify, or label an object, you need to first 
select the object. Chart objects are: 

• Symbols 

• Connections 

• Labels 

• Blocks 

• Text 

Selecting an object highlights it, and indicates to the chart editor that it is ready 
for a subsequent editing operation. 

The foUowing sections describe how to select a chart object. For additional 
information, refer to Chapter S of the Chart Editor User's Guide. 

Selecting a Symbol 

Selecting a symbol is as easy as simply clicking on it witb the mouse. To select the 
symbollabeled 'EasyCASE Plus' on the chart: 

l. Position the mouse pointer in tbe center of the symbol containing the text 
label 'EasyCASE Plus', as shown in Figure 1.5. 

2. Click tbe left mouse button. 

The object, and the text inside it, are bighlighted and surrounded by small 
boxes to indicate that it is selected. 
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Figure 1.5 Selected a Symbol 

To de-select the selected symbol: 

Click the right mouse buttoo, or click the left mouse buttoo elsewhere oo 
the screeo (aoywhere outside of the symbol). 

The symbol is no looger selected aod the highlight aod marker boxes are 
removed. 

Selecting a Connection 

A small box is displayed midway aloog the middle line segmeot of each 
conoectioo. This is the "haodle" you will use to select the coooectioo. 

To select the conoection labeled 'Display Data': 

l. Positioo the mouse pointer over the small box located oo the connection 
labeled 'Display Data' as shown in Figure 1.6. 

2. Click the left mouse button. 
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The connection, and the adjacent label, are highlighted. Small boxes are 
displayed at the start, end, corners, and mid-points of the connection to 
indicate that it is selected, as shown in Figure 1.6. 

: ........... : ........... __, 
• • • • o 

· ..... 
. " 

• • • • • • o • 

..... : ........... -. . 

~:is~l¡Y: O~t~ : : ¡ 
. . . . . . . . . 

o ••••••••• o •••••••• . . 

Figure 1.6 Selected a Connection 

To de-select the connection: 

Click the right mouse button, or click the left mouse button elsewhere on 
the screen. 

The connection is no longer selected and the highlight and marker boxes 
are removed. 

Selecting a Symbol Label 

Labels can appear inside symbols, and are selected as follows: 

To select the 'Video Display' symbollabel: 

l. Position the m o use pointer over the symbollabeled 'Video Display'. 

2. Click the left mouse button. 

The symbol and its label are highlighted. 

3. With the mouse pointer still positioned over the Video Display symbol, 
click the Ieft mouse button again. 
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The 'Video Display' label alone is highlighted and enclosed by a dashed 
bounding box as shown in Figure 1.7. The label is now selected for a 
subsequent operation. 

· .... 
. "" 

Figure 1.7 Selected a Symbol Label 

Setecting a Connection Labet 

Labels can also appear next to a connection, and are selected as follows: 

To select the 'Display Data' connection label: 

l. Position the mouse pointer anywhere over the 'Display Data' text. 

2. Click the left mouse button. 

3. The 'Display Data' label is highlighted and enclosed by a dashed bounding 
box as shown in Figure 1.8. The label is now selected for a subsequent 
operation. 
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Figure 1.8 Selected a Flow Label 
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To de-select the !abe!: 

Click the right mouse button, or click the left mouse button elsewbere on 
the chart (anywhere outside of the !abe! box). 

Selecting a Data Couple 

Data couples appear next to connections on structure charts. Before you can 
select a data couple you must first load a structure chart. 

To load a structure chart: 

l. Click on the "File' menu to pull it down. 

2. Click on the 'Change type' option. A list of available chart types will 
appear. 

3. Click on 'Structure Chart'. A blank structure chart named 
UNTITLED.STC will appear in the chart window. 

4. Click on the 'File' menu again to pull it down. 

5. Click on the 'Load chart' option. A list of available structure charts will 
appear. 

6. Click on the "Page-Jones Structure Chart" entry. 

7. Click on 'OK'; the chart willload. 

To select a data couple: 

l. Locate the data couple 'Customer P.O. Data' on the connection between 
function symbol "1.0 Fill Customer Purchase Order", and function symbol 
"1.3 Add Customer P.O. Record". You may need to scroll the chart one 
click to the left to access it easily. 

2. Position the mouse pointer over the small round base of the data couple. 

3. Click the left mouse button. 

The couple and its !abe! are highlighted and surrounded by small boxes 
that indicate it is selected ready for a subsequent editing operation, as 

shown in Figure 1.9. 
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Figure 1.9 Selected a Data Couple 

A couple label is selected in the same way as for a connection label by clicking on 
the label text. 

To return to the EasyCASE Plus Context Diagram, follow the instructions in 
steps 1 through 6 above, but choose Data Flow Diagram (Yourdon symbol set) in 
step 3 and EasyCASE Plus Context Diagram (ECPCONTX.DFD) in step 5. 
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Selecting a Group of Objects 

In addition to selecting single objects, you can select a number of objects together 
as a group or 'block'. Once selected, you can then perform the standard move, 
copy, delete or save operations, just as you would for single objects. 

To selecta group of objects visible in the chart window: 

l. Position the mouse pointer just outside the upper left comer of the 
external entity symbollabeled 'Keyboard.' 

2. Press and hold down the left mouse button. The mouse pointer will change 
into an icon in the form of a hand with a pointing fmger. 

NOTE: If yo u accidentally click on a symbol, just press ESC, or click the right 
mouse button, to cancel the operation. 

3. While still holding down the left mouse button, move the pointer one grid 
square down and to the right, as shown in Figure 1.10. 

A dashed box will appear; the top left comer of which is located at the 
mouse pointer position when the left button was pressed. 

¡------;,.'' '.' 
• • • o 

Keyboard 

. ' 

Figure 1.10 Drawing the Chart Object Group Selection Box 

4. Still holding down the left mouse button, move the mouse pointer down 
and to the right of the symbollabeled 'Microsoft Mouse'. The bottom left 
comer of the dashed selection box will follow the m o use pointer. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



Lesson 1 Starting to Use EasyCASE Plus 25 

Tbe dasbed box should encompass the 'Keyboard' and 'Microsoft Mouse' 
symbols, as well as their connections, as shown in Figure 1.11. 
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Figure 1. 11 Selecting a Group of Chart Objects 

5. Release tbe left mouse button. 

Tbe block of objects is highlighted and enclosed by a dasbed bounding box 
and is selected for a subsequent operation, such as move, copy, delete, or 
save block. 

To .,.;:.select the group of selected chart objects: 

Click the right m o use button or click elsewhere on the chart ( outside of 
the selection box). 
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NOTE: Wben you also want to include objects in your selection tbat are outside 
of tbe curren! cbart window ( on tbe cbart but not currently displayed), tbe cbart 
window will scroll as you hold the left mouse button and enlarge the selection box 
as it contacts tbe edge of the chart window. 

Scrolling 

Scrolling makes it possible for you to see portions of tbe cbart tbat are not 
curren ti y displayed in tbe cbart window. Tbe chart drawing are a is 32 rows by 32 
columns. Tbe cbart window displays 9 rows by 8 columns, or approximately 25% 
of tbe entire cbart. 

Tbe EasyCASE Plus screen has two scroll bars. Tbe one down the rigbt side of 
tbe screen scrolls tbe chart vertically. The one across tbe bottom of tbe screen 
scrolls tbe cbart horizontally. 

Scroll Arrow Buttons 

Tbe scroll arrows, located at eacb end of the scroll bars, move tbe cbart one row 
or column at a time. 

• • 
• 
• • 

• 
• 

Figure 1. 12 Right and Down Scro/1 Arrow Buttons 

To scroll down a few rows: 

Click on tbe down arrow, located at the bottom of tbe vertical scroll bar, 
several times. Tbe cbart window scrolls down tbe cbart one row at a time. 

To scroll rigbt a few columns: 

Click on tbe rigbt arrow, located at the rigbt end of tbe horizontal scroll 
bar, severa! times. Tbe chart window scrolls rigbt across tbe cbart one 
column at a time. 
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NOTE: In both cases, you can increase the scroll increment to 4, 8 or 16 columns 
or rows at a time by holding down the CTRL, ALT, or SHIFT key respectively while 
clicking on the scroll arrow. 

Scroll Boxes 

The scroll box, located between the scroll arrows on each scroll bar, moves the 
cbart window over the chart and allows for more rapid scrolling. 

To scroll toward the bottom of the chart: 

l. Position the m o use pointer over the scroll box on the vertical scroll bar. 

2. Press and hold down the left mouse button. 

The scroll box is outlined by a dashed box. This outline follows the mouse 
pointer along the scroll bar as you move the mouse. 

3. While holding down the left mouse button, drag the scroll box outline 
down to the end of the scroll bar. 

4. Release the left mouse button. 

The bottom area of the chart is now displayed in the chart window. 

You do the same type of operation with the scroll box on the horizontal scroll 
bar. 

Zooming 

The zoom feature enables you to quickly switch back and forth between macro 
and micro views of your chart. There are three zoom levels available ranging 
from actual size to a mode whereby you can see the entire chart on the screen. 

Y o u can zoom using any of the following approaches: 

• Click both mouse buttons simultaneously 

• Click on the Quick Zoom icon 

• Select the 'Quick Zoom' option from the View Menu 

• Press the CTRL+Z key combination 
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Tbe quickest way to zoom is witb tbe mouse buttons or Quick Zoom icon. 

To zoom using the mouse buttons: 

l. Press and hold down the right mouse button. 

2. Then, press the left mouse button also. 

3. Release both buttons simultaneously. 

4. Tbe full chart is reduced to appear in the chart window, as illustrated in 
Figure 1.14. 

5. Repeat Steps 1 througb 3 to zoom back to the actual size chart. 

6. Tbe actual size chart is re-displayed in tbe chart window. 

NOTE: The position of the mouse pointer when you dick the buttons determines 
what area of the chart will be displayed in the chart window when you zoom from 
full chart back to actual size display: 

To zoom using the Quick Zoom icon: 

l. Click on the Quick Zoom icon (located in the lower left corner of the cbart 
window) as shown in Figure 1.13. 

Figure 1.13 Quick Zoom /con 

2. The full chart appears in the chart window, as illustrated in Figure 1.14. 

3. Click on the Quick Zoom icon again to zoom back to the Actual Size 
cbart. 

4. The Actual Size chart is then re-displayed in the chart window. 
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Figure 1.14 Zoomed (Full) Chart 

NOTE: When you quick zoom from full chart to actual size using the Quick 
Zoom icon, CIRL+Z keys, or 'Quick Zoom' menu option, the chart window is 
centered on any selected object. lf an object is not selected, you are returned to 
the position where you were located when you previously 'quick zoomed' from 
actual size to full chart mode. 

Zooming Using the View Menu Commands 

The View menu commands, as shown in Figure 1.15, give you greater flexibility in 
choosing which part of the chart you want to display when you zoom. 

• The Full Cbart command displays the en tire chart witb all objects in reduced 
size. 

• Tbe Half Size command displays only the half of the cbart tbat you select. Tbe 
objects are easier to see than in full chart mode. 
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• The Actual Size command displays objects at normal size, so you can sec 
detail and work with the objects. 

IIJI§AI Opt ions Exp lode Ana lH:ze 

Actual size 
Half si:ze 
Full chart 

Redraw chart 
Quick :ZOOM 

.f Drawing grid 

Ctrl+R 
Ctrl+Z 

.f DisplaH title block 
':.:· .. '. ' ·: ~ :;.= 

.f Open arrowheads 
Filled arrowheads ~ 

.[ Rounded corners 

Figure 1.15 View Menu • 

Zooming between Actual Size and Full Chart 

Your chart should be displayed at actual size, thc sizc you used for crcating and 

modifying the chart. 

To zoom to the Full Chart display: 

l. Select the View menu. 

2. Select the Full Chart option. 

3. The entire chart is then displayed in the chart window, as illustrated in 

Figure 1.16. 

U se the same approach to m ove from Actual size to Half size view. While at 
Actual size view, choose the Half size option from the View menu. 

To zoom back to Actual Size display: 

l. Select the View menu. 
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2. Select the Actual Size option. 

3. A selection box is dis¡¡layed. The mouse pointer is positioned at the top 
left corner of this box. 

Figure 1. 16 Actual Size Zoom Selection Box 

4. Press and hold down the left mouse button. 

5. Use the mouse to drag the selection box over the area of the chart that you 
want to display in the chart window at actual size. 

6. Release the left mouse button. 

7. Y o u are pro m pted to verify that this is the selected area to zoom into. 
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,: t:s' [ Redo 1 [C4nce 1 l 

Figure 1.17 Prompt to Verify Zoom Action 

8. Click on 'OK' to accept your choice. 

NOTE: If you want to reposition the selection box, click on 'Re do' and reposition 
the selection box over the desired chart are a. Click on 'Cancel' or press the ESC 

key to cancel the operation and remain at full chart view. 

Zooming From Full Chart to Half Size 

Set the zoom leve! so the chart is displayed in Full Chart mode. 

To zoom to the HalfSize display from the Full Chart mode: 

l. Select the View menu. 

2. Select the Half Size option. 
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Figure 1.18 Chart Window Displayed in Half 'Oize Mode 

3. Use the same approach as described in steps 3 through 8 of the previous 
section to zoom from FuU chart to Half size. The selection box is larger 
because more of the chart can be seen at Half size than Actual size. 

Use the same procedure to move from Half size to Actual size view. Wbile at 
Half size view, choose the Actual size option from the View menu. 

Redrawing the Chart Window 

You can redraw (refresh) the chart window at any time simply by clicking on the 
Redraw icon located at the lower right corner of the chart window (between the 
right ar.' .jown scroll arrows), as shown in Figure 1.19. 
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·-·-·-· 
. . . . . . 

Figure 1.19 Redraw /con 

NOTE: You can also press the CTRL+ R key combination, or choose the Redraw 
Cbarl command from lhe Yiew menu, lo redraw lhe chart. 

Exiting EasyCASE Plus 

To exil EasyCASE Plus and relurn lo DOS, choose lhe 'Exillo DOS' commaod 
from lhe File meou. You are prompled lo save any changes made lo lhe curreot 
charl, if any. 

To exil EasyCASE Plus: 

l. Selecl lhe File meou. 

2. Click oo lhe 'Exillo DOS' oplion. 

3. If you have changed lhe currenl charl and ha ve yello save il, you are 
prompled lo save lhe changed file. 

4. Click oo lhe 'No' oplion lo discard any changes made. 

5. The exil dialog box is lheo displayed, prompting you lo verify lhal you 
wanllo exillhe program . 

• 
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t(~~ Exit PrograM 

.... 
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X Save Options . ,__ 
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T~ ·-

.. : 
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Figure 1.20 Exit Prompt 

The 'Save Options' sening allows you to choose to save your current 
options and configuration (these options are available in the View and 
Options menus). By default, the 'Save Options' setting is turned On. Leave 
it at this sening. 

6. Click on the 'Exit' option to exit the program. 

The EasyCASE Plus program is ended, and you are returned lo the DOS 
prompt. 

Alternatively, you can also exit EasyCASE Plus by clicking on the 'Exit' icon, as 
foUows: 

l. Position the mouse pointer over the 'Exit' icon button located at the top 
left corner of the screen, as shown in Figure 1.21. 

K: file 
- ·-~ . . 

. . 

. . 

Figure 1.21 Exitlcon 

2. Click the left mouse button on the icon. o 

3. Y o u are then pro m pted to save the current chart and option settings, j ust 
as when you e hose the 'Exit to DOS' command at the File menu. 
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Yo u can also exit by pressing the CTRL +X key combination. 

Alterriatives 

Starting EasyCASE Plus from the DOS Command Line 

To display a list of projects: 

• Use the /P switch. This switch displays a listing of projects and directories 
alter the welcome screen. 

The command is: 

EASYCASEjP 

This switch enables you to select an existing project directory, or en ter the 
name of a new project directory. When the product runs, you should se e a 
dialog box similar to Figure 1.22 from which you can access a project in a 
subdirectory or navigate through the drives and directory structure on your 
disk to a project directory located elsewhere. 

~~~ Select Project Drive & Directory :r---, 
ID:,TUT,ECPLUS3l'l 

[-A-J 
[-B-J 
[-C-J 
[-D-J 
[ .. J Accept 
SAMPLES 

Cancel 1 

Figure 1.22 Project Directory Ust 
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To display a list of available chart files of a specific type: 

o En ter a chart type after the project directory name to display a list of available 
cbarts of tbat type. For example: 

EASYCASE SAMPLES DFD 

displays a listing of the Data Flow Diagrams (DFD) available in the 
SAMPLES project directory. 

To bypass tbe U ser Name Entry screen: 

o Use tbe /N switch. This switch tells EasyCASE Plus to use tbe oame of the 
last user to log in to EasyCASE Plus. Tbe commaod is: 

EASYCASEjN 

Wbeo EasyCASE Plus starts, you are not prompted for your name. 
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LESSON 2 
CREATING A CHART 

Overview 

This lessoo covers: 

• Beginoiog a oew chart 

• Placing symbols oo it 

• Coonecting the symbols together 

• Labeling chart objects 

• Addiog a title to the chart 

• Saving the chart 

Before you start this lesson, you must have installed EasyCASE Plus with the 
Samples project. You should also be familiar with the material covered in 
Lessoo l. 

EasyCASE Plus should now be running. If it is not, follow the steps provided in 
Lesson 1 to run EasyCASE Plus and access the sample diagram. 

It should take you approximately 45 minutes to complete this lesson. 

Beginning a New Chart 

A project contains chart files that contain objects and data dictionary entries 
(storing the object definitions) in common. These chart files may also be linked in 
a hierarchical structure. Wbenever you create (and save) a new chart, the chart 
fües are added to the current project directory (in this case, the SAMPLES 
project). All of the components of a project are stored in this common project 
directory. 
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You use the 'New Chart' option in the File menu to create a new cbart, of the 
current type (in this case, DFD). 

A new, blank chart with the temporary file name of UNTITLED.DFD is 
displayed in the chart window. 

The title block, located initially at the top left of the chart window, displays 
current chart information, including its type, filename, user name and date. 

You will use this chart to create a new context diagram for a sample order 
processing system. This order processing system handles information for 
management, payroll, inventory, and customers. lt consists of a central data 
process, wbich defines the entire processing performed by the system; severa! 
externa! entities, which represent things externa! to the system, with wbich tbe 
system interacts; and severa! connections which carry data into and out of tbe 
system, between the central data process and the externa! entity symbols. A1l 
symbols and connections are labeled with text to describe their function. 

Adding a Symbol 

The first step in creating your chart is to add symbols to it. The types of syrnbols 
available for placement on this (data flow diagram) chart are listed textually in 
the Objects menu, and are represented graphically in the form of icons down the 
left edge of the screen. 

The vertical arder of the object icons displayed down the left side of the screen 
corresponds to the arder of object types listed in the Objects menu. 

For the Tutorial, you will use the default chart editor settings when creating the 
chart. 

In this lesson, you will first place all of the syrnbols befare proceeding to label and 
connect them together. 

NOTE: The default setting for a DFD determines that the Yourdon symbol set is 
used. At the end of this lesson, sorne of the available options are described. 

First, place a Data Process syrnbol: 

l. Select the Objects menu. 
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Objects View Options Explode 

Externa! Entity 
Data Process 
Data Store 
Split/Merge 
Multi-Data Process 

Data flow 

Data Interface 

Figure 2. 1 Objects Menu for a DFD 

2. Select the 'Data Process' object type entry. 

3. Position the mouse pointer in the center of the grid square located at 
column 4 row 5. 

4. Click the left mouse button. 

5. A circular data process symbol is displayed and appears selected 
(highlighted and enclosed by small boxes). This data process will represen! 
the processing unit for the en tire order processing system. 
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• •• 

. . . . . ... 

Figure 2.2 Data Process Placed and Selected 

Next, place some Externa! Entity symbols: 

Externa! entities are real world objects the arder processing system interacts with. 

l. Select the 'External Entity' object type entry from the Objects menu. 
Alternatively, select the Externa! Entity icon ( rectangle) displayed at the 
left of the chart window. 
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Figure 2.2a Object lcons for a Yourdon/Demarco DFD 

2. Position the mouse pointer near the upper left corner of the chart window. 

3. Click the left mouse button. 

4. A rectangular Externa! Entity symbol is displayed and selected. 
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. . 

•·M·· : . . . 
. . . . ' . . . . . . . . .. ' ......... . 

. . . . . . . . . ~ : . 

. .................................. ' 

........... : ........... : .. 

Figure 2.3 Externa/ Entity Symbol Placed and Selected 

5. Place three more Externa! Entity symbols, one each in the upper right, 
lower right and lower left corners of the chart window. Y ou do not need to 
choose the Externa! Entity object type again to place a symbol. Symbol 
placement is a repeatable command. 

When you have fulished, the chart window should look like this: 
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··u· . :. : .. :. : . :·· ·:· ·:. . . . . . . . . ' . . . . 
: ' : : : . : : : : 
. . . . . . . . . . .................. . . . . . 

.. ······: : ~: 

··o·--- . . . . . . . . . . . . . . . . . . . . . : . ' . . . . . . . . . . ' . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
- . . . . . . . . . . . 

' ' . . . . . ' . . . . . ' . . . . . . . . . 

..... o· ... . .: ... . . 

. . . . 

Figure 2.4 Chart with al/ Symbols P/aced 

NOTE: If you make a mistake and want to cancel an action (such as selecting an 
object), click tbe right mouse button. To delete an unwanted object, select the 
object and cboose tbe 'Delete Object/Group' option from the Edit menu, or press 
tbe DEL key. You will be prompted to verify the delete. 

Labeling the Symbols 

Having just positioned a number of syrnbols on the chart, you should tben label 
tbem according to their various functions. Y o u will use the Label Object 
command from the Edit menu. 

First, label the central Data Process syrnbol: 

l. Select the Data Process symbol by clicking on it (be sure to click near the 
center of the symbol). It wiU become highlighted. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



Page 46 

2. Select the 'Label Object' option from the Edit menu. 

3. A text entry window is displayed in the center of the screen for you to 
enter the label text. 

4. Type "Order Processing System". Press the El'ITER key between each word 
to place them on separate lines as shown in Figure 2.5 . 

• • • • o .... : 

~-~·>4 

.---...~: LABEL lt---., 
Order · 
Processing 
Systettl 

. . .¡ . : 1----------1 
• • • • • o • • • • • o • o o • • • • • • 

:. :. :. :. ~.:.:. :~.:. ~.:.:.:.:.:. ¡.:.:.:.: . 
•• •• 

1 

Figure 2.5 Symbol Label Text Entry Window 

5. Press the F3 key when you have entered the text. 

6. The label is displayed at the upper left of the symbol and selected 
(highlighted and enclosed within a dashed box). 

7. Position the mouse pointer over the dashed box, then press and hold down 
the left mouse button. 

A small hand icon is displayed, positioned automatically over the label. 
This indicates that you can move the label by moving the mouse while you 
are holding down the left mouse button, as shown in Figure 2.6. 
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Figure 2.6 Hand /con Positioned to Move Symbol Label 

8. While still holding down the left mouse button, use the mouse to drag the 
dashed box to the center of the symbol as shown in Figure 2.7. 

• • • • • • • • • • o • 

. .. . . : .... 

•• • 

Figure 2.7 Hand /con Moving Symbol Label 

9. Release the left mouse button. 

10. The text will move to that position, as shown in Figure 2.7a. 
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Figure 2.7a Final Symbol Label Placement 

NOTE: If you wanllo changc thc tcxt layout of your label, select the label, tben 
choose Label Object again. Y ou can edit the text as you wish. Remember thatthe 
label text editing operation is completed whenever you press F3. 

Next, label the Externa! Entity symbols: 

l. Select the upper left Externa! Entity symbol by clicking on it. It will be 
highlighted. 

2. Choose the Label Object command again. Alternatively, press the ALT+ L 

key combination. 

3. Type "Customer" in the label text box, then press the F3 key. 

4. Position the label in the center of the symbol, as you did for the Order 
Processing System data process symbol. 

5. Repeat Steps 1 to 4 for the remaining three Externa! Entity syrnbols 
labeling them as follows: 

(Upper rigbt) "Supplier" 

(Lower right) "Payroll" 

(Lower left) "Management" 
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NOTE: If you wish, you can use the arrow keys on your keyboard to position the 
label, rather than using the mouse. Press the ENTER key when you are fmished 
moving the dashed box to complete the operation. 

Wben you are fmished, your chart should look Iike this: 

EJ 
. 

. 
. 

.. 

. 

B 
.... . 

' . 
. 

...... EJ. . . .................... " ........ . 
. . 
- . . . . ' . . . . ' . . . 

: : : . . : : SUIPill: : ; . . . . . . . . . . . . . . . . . . . . . 
' . . . . . . . . ' . . . 

'""" ............ " . . . . . . 

···-····o···········-··· 
. . . . . . ..... . . 

: : · : : Piirol : : : . . .. ' . . .. ' ... . . 
' . . ' ' . . .. . . ..... ·- .... '- ·-· . . 

. :~: 

. -~. 

Figure 2.8 Chart with al/ Symbols Labelled 

Connecting the Symbols 

A number of symbols have been placed and labeled on the chart. The next step is 
to add connections between them. Todo this, you will use the Data Flow option 
from the Objects menu, or the data flow icon. 

To connect the "Order Processing System" and '"Customer'" symbols together: 

l. Select the 'Data Flow' option from the Objects menu. 
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2. Select the central data process syrnbollabeled "Order Processing System" 
by clicking on it (click near the center). 

This will be the source symbol for the data flow. A number of small boxes 
are displayed around the symbol, as shown in Figure 2.9. These represent 
discrete positions at which a connection can exit the symbol. 

[] 
. : ........... : . . [] ... . 

: Order .. : . . . 
Process i ng. 

System. 
. . . f'..· . 

Cl • . • v.s- . 
.... [J .• : ........... :. 

Cl • • 

Figure 2.9 Selected SourcJ Symbol for Data Flow to Begin 

3. Select the box half way down the left side of the symbol by clicking on it 
using the mouse. 

The small box that you selected remains displayed at this location, and the 
other boxes are erased (see Figure 2.10). This indicates where the 
connection willleave the symbol. 

o • o • • • • • • • o • • • • • • o • • • • • • • • • 

: : order: : 
: Processi na 
: . S!::lstern . 
. . 

• • o o o • • • o o • • • • • • • • • • • • • o • • • 

Figure 2. 10 Selected Origin for Connection Attachment 
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4. Select the External Entity symbollabeled "Customer" by clicking on it. 

This will be the target symbol for the data flow. A number of small boxes 
are displayed around this sym bol, as shown in Figure 2.11. These represent 
discrete positions at which a connection can enter the symbol. 

. . 
• • • • • • • • • • o o • • • 

i:ustomer: 
. f:::s.:: . 

• • • o ••••••••••• 

Figure 2. 11 F/ow Entry jExit Ports 

5. Select the box midway on the lower side of the Customer symbol by 
clicking on it, as shown in Figure 2.lla . 

• o o •••••••••• o • 

o o • • • 

-· 

............. ,;., . 

~: 

Figure 2. 11a Se/ect F/ow Entry Port for Customer Symbol 

A connection is then drawn automatically from the "Order Processing 
System" symbol to the "Customer" symbol, using a horizontal anda vertical 
line segment, and with an arrowhead at the destination end, as shown in 
Figure 2.12. 
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• • o • • o o • • • • • • o • • • • • • • • o o • • • o o • . . . 

• • • • • • • • • • • • • • • • • • • • • o • • • • o o . . 

: Order: ... 
: P~"ooessing : 
: S~:~stern . . : 

Figure 2. 12 fnitiaf Connection Placee/ 

6. Repeat Steps 1 to S using the "'Customer"' externa! entity as the source 
symbol and the "Order Processing System" data process as the target 
symbol. 

Route the connection from the right side of the "'Customer"' symbol to the 
top of the "Order Processing System" symbol, as shown in Figure 2.13. 

The completed data flow connections are displayed, connecting the two symbols 
at the points you have chosen. There is a data llow from the Order Processing 
System to the Customer, and a different data llow back to the Order Processing 
System. 

Y our chart should now look like this: 
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. . 
• • • • • • • • • • • • o • • • • • o o • • • • • • • • • • • o • • • • o • • o • • • 

: cusi:.oiner 

. . 

. -~ .. . . 
• • • • • • • o • o • o • . . 

: Order. : : · 
: P~"ocessing 
: S~stern . . 

o • • • o o • • • • • • • • • • • • • • • • • • o • • • . . 

Figure 2. 13 Data Flows Connecting a Data Process andan Externa/ Entity 

Next, place connections for the remaining symbols. Refer to the chart in Figure 
2.14 to complete your connections. Refer to the following table which shows the 
source and target symbols for the data flow connections: 

Source Symbol 

Customer* 

Order Processing* 

Order Processing System 

Supplier 

Order Processing System 

Payroll 

Order Processing System 

Management 

Target Symbol 

Order Processing System * 

Customer* 

Supplier 

Order Processing System 

Payroll 

Order Processing System 

Management 

Order Processing System 

Table 2. 1 Source and Target Symbols for Connections 

*Connections airead y placed in preceding sections. 
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: c..s.tom.i . ,--;----~ : $ ....... : . 

......... ..... ....... ......... ........... .. 

. . . r-.. . 

. . . """' 

'--'-+---1 : p.,;,ol : : ' 

Figure 2.14 Chart with al/ Connections Completad 

Adding Labels to the Connections 

So far, your cbart has all of tbe symbols labeled and connections placed. Tbe next 
task is to label tbe connections between the symbols. This procedure is similar to 
labeling symbols (see tbe previous section, ''Labeling a Symbol"). 

To label a connection: 

l. Select tbe connection flowing from the "Order Processing System" data 
process symbol to tbe "Customer" externa\ entity symbo~ by clicking on tbe 
small box ('bandle') on tbe connection. It will be bigbligbted and small 
boxes will be located at eacb end, and also at tbe corner and midpoint of 
eacb line segment. 

2. Choose tbe Label Object command from the Edit menu, or press ALT+ L. 
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3. Type "Statement" in the label text entry box that appears, as shown in 
Figure 2.15. 

~------~: LABEL ~r---------~ 
StateMentl 

Figure 2.15 Connection Label Text Entry Box 

4. Press the F3 key. 

5. The label is displayed inside a highlighted, dashed box next to the 
connection's 'handle'. · 

6. Using the m o use, position the connection label, as yo u did for the syrn bol 
labels, by dragging it so that it is located next to the connection, as shown 
in Figure 2.16. 

: Cusi:.oinet-- : : . ~--~~----~· . ·~---------
o • • • • 

. . . . . . . . . . . . 

. . 
• o o • • • • • • • • • • • o o • o • • o • • • • o • • • o • • • • o 

Figure 2. 16 Hand /con Positioned for Moving Connection Label 
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Repeat steps 1 to 6 above for each other connection on the chart, using Table 2.2 
as a guide to the label to use for each remaining connection. 

Refer to the following table and Figure 2.17 to label your connections. 

Source Symbol 

Order Processing 
System 

Customer 

Order Processing 
System 

Supplier 

Order Processing 
System 

Payroll 

Order Processing 
System 

Management 

Target Symbol 

Customer 

Order Processing 
System 

Supplier 

Order Processing 
System 

Payroll 

Order Processing 
System 

Management 

Order Processing 
System 

Connecting Label 
(used in next step) 

Statement• 

Payment 

lnventory Request 

Inventory Delivery 
Report 

Sales Commission 
Request Form 

Sales Commission 

Sales Report System 

Sales Quotas 

Table 2.2 Label Texr for Connections 

•connection already labeled in preceding section. 

U pon com pletion, the chart should loo k like the following: 
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" " ...... . 
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Figure 2.17 Chart with al/ Connections Labeled 

NOTE: As an alternative to using the 'Label' option from the Edit menu ( or press 
ALT+ L) to label an object after each is placed, you can automaticaUy invoke the 
Label text entry box. 

Todo this: 

l. Choose the Options menu. 

2. Select the 'Preferences' option. 

3. In the dialog box that appears, click on the 'Auto Label' entry so that an 'X' 
appears to the left of it, as shown in Figure 2.18. 
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.----1: Set Opt i ons ~.,..__----, 

• Auto ldent ify 
X Auto Label 
X Allow Place New Label 
• Auto Export to dBASE 
• Auto Export to SDF 
• Auto Export to HPGL 
• Update Label froM DDE 
• Flag Deleted DDEs IDs 
X Warning beep 
X Create backup chart 
X Use naMed charts 

[ OK J 

Figure 2. 18 Preferences Dialog Box Containing the Auto Label Option set to 
On 

4. Click on 'Cancel'. 

Adding a Title to the Chart 

Your chart should now be displayed with all symbols and connections labeled. 
You can add a title to describe the purpose of the chart if you like. Todo this, use 
the 'Text Block' option from the Edit menu. 

To add a title to the chart: 

l. Select the 'Text Block' option from the Edit menu, or press the ALT+T key 
combination. 

2. Position the mouse pointer in the upper right corner of the chart window, 
as shown in figure 2.19. 
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· · ·: :soloiQUQ<• · '------------&c:-;;.SbiAOiMIIFOniJ 
·::~ .. :r 

Figure 2. 19 Mouse Pointer Positioned to Place Text Block 

3. Click the left mouse button. This defines the location for the cbart title text 
block. 

4. A text entry box appears in the center of tbe screen, as shown in Figure 
2.19. 

5. Type "Sample Order Processing System" then press Ei'lo'TER. Then type 
"Data Flow Diagram (DFD)" as the title for your chart, as sbown in Figure 
2.19a. 
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rr======t~ TEXT BLOCK :1=======;'1 
Sanple Order Processing S~sten 
Data Flow Diagran (DFD)I 

Figure 2.19a Text Block Entry Box 

6. Press tbe F3 key to accept tbe title text. 

7. Tbe tille is displayed at the location you cbose previously (steps 2 and 3), 
as sbown in Figure 2.20. 

8. If you want to m ove tbe title, use the same procedures you used to position 
a label. That is, press the left mouse button, drag the text block outline to 
tbe desired location, tben release the mouse button to place the text block. 

9. Your completed chart should look like this: 
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Figure 2.20 Compleied Chart. 

NOTE: lf you want to change the text of your titlé, select the title then choose the 
Text Block' option again. You can edit the text as you wish. 

Saving the Chart 

lt would be a good idea to save the chart at this point. Use the Save As command 
from the File menu to do this using a new chart file name. 

l. Select 'Save As' from the File m en u. 

You are prompted for the new filename to use. 

2. Press the 'Delete' key to erase the curren! name (untitled.dfd). 

3. Type in "tutor!". You do not need to en ter a file extension, as it will default 
to the curren! chart type (DFD in the example), as shown in Figure 2.21a. 
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Sa.ve F ilena.Me : ILt_u_t_o_r_l_l ___ ....~ 

[ Ves l [ Ho l [Ca.ncell 

Figure 2.21a Filename Text Entry Box 

4. Click on ·y es: 

5. A listing of the current DFD chart file names is then displayed (see Figure 
2.21b) and you are prompted for the chart name to use. 

The name of a new chart defaults to its file name. The chart narne can be a 
longer (up to 32 characters) descriptive name for the chart and is entered 
into the data dictionary for later access . 

..------1: Se lect dfd HaMe :1-------, 

ID: jtutorlll 

DFD Objects (Gane & Sarson) 
DFD Objects (SSADM) 
DFD Objects (Yourdon/DeMarco) 
EasyCASE Plus Context DiagraM 
SaMple (EasyCASE Plus) DFD 
SaMple DFD 
SaMple Project Context DiagraM 
SaMple Project Level O DFD 
SaMple· Project Process 1 DFD 
SaMple Project Process 2 DFD 
Tutorlal Modlfy Chart 

[ OK l [Cancel] 

1 

Figure 2.21b Listing of Available Chart Names with the Current Name Shown 
in the Upper Text Entry Box 

6. Click on 'OK' to accept "tutorl" as the DFD chart name. 
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The chart me is saved in the SAMPLES project directory and the chart window is 
re-displayed. Notice that the Title Block information and status line is updated to 
reflect the new chart name and file name (tutorl and tutorl.dfd, respectively). 
You can now continue working on the chart you have created. 

Alternativas 

There are a number of options you can use to customize your chart creation 
process. The following are sorne options available in the Options and View menus 
that relate to this lesson: 

Default Symbol Set 

The default symbol set used for DFDs is the Yourdon/DeMarco set. For Data 
Flow Diagrams, your other options are the Gane & Sarson and SSADM symbol 
sets. When you choose one of these options, the appearance of the chart symbols 
changes. Try it by choosing the 'Change Chart Type' entry in the File menu, then 
click on the Gane & Sarson DFD option. The chart is redrawn using this symbol 
setas shown in Figure 2.22. Repeat the process to choose the SSADM symbol 
set, and then return to the Yourdon/DeMarco symbol set. 
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.~· 
: Cusloorooi . : s...;.o.. • : 

Figure 2.22 Gane & Sarson DFD Symbol Set 

Default Symbol Size 

The default symbol size is Normal, the size you have beeo using throughout this 
lessoo. You can chaoge this setting to Small, Large, Extra Large and Giaot. lf you 
do, each symbol you place subsequently will be drawn usiog the choseo size. This 
feature is accessed via the Default Symbol Size entry in the Options menu. 

Auto Label 

This setting determines whether or not you are automatically prompted to label 
an object wheo you create it. It is 'Off by default, allowing you to create all of the 
objects before labelling them. When it is 'On; the label text entry box will pop up 
automatically whenever you place a new symbol on the chart. This entry is fouod 
by choosing the Preferences eotry from the Options menu. 
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Allow Place New Label 

This option allows you to repositioñ a label after it has been placed using the 
mouse or keyboard. The default setting is 'On." When this setting is 'Off,' the label 
is placed inside a symbol, or adjacent to the selection marker for a connection, 
and you cannot adjust its position. To do so, you must use 'Move Object/Group' 
command after placing it. This option is found by choosing the Preferences entry 
from the Options menu. 

Automatic Flow Routing 

When you place connections, this option automatically chooses a routing between 
symbols that accounts for the proximity of diagram elements. This option is 'On' 
by default. When it is 'On,' only horizontal and vertical line segments are drawn 
between points on connections. When you turn it 'Off,' single, straight-line 
segments are drawn directly between points and connections. This option is found 
in the Options menu. 

Default # of Arrowheads 

All of the data flow connections you used were one-way single-headed 
connections. This is the default setting. However, you- can also use one-way 
double-headed, two-way single headed, two-way double headed, or no 
arrowheads on connections, by default. This feature is accessed via the Options 
menu. 

Open Arrowheads 

This setting is 'On' by default. When you turn it 'Off,' the connection arrowheads 
are closed in, but unfilled. This option applies to Jill connections on the chart. 
This is an option in the View m en u. 
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Figure 2.23 Diagram with Closed and Filled Arrowheads 

Filled Arrowheads 

Tbis setting is 'Off by default. When turned 'On,' this setting displays solid (filled 
in) connection arrowheads. This option applies to all connections on the chart. 
Tbis is an option in the View menu. 

Rounded Corners 

The corners on tbe connections you used were rounded, tbe default setting. 
Turning tbis setting 'Off produces sharp corners. Tbis option applies to all 
connections on tbe cbart. It is an option in the View menu. 

Display Title Block 

Turn this setting 'Off to suppress the display of the Title Block in the upper left 
cerner of the chart window. It is 'On' by default. This is an option in tbe View 
menu. 
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NOTE: The Title Block cannot be edited or deleted, however, it can be moved. 

Drawing Grid 

This option turns the drawing grid 'Off for a clear chart background as shown in 
Figure 2.24. It is 'On' by default. Even when turned ·off,' the grid is always active. 
This is an option in the View menu. 

c-.,... p....,.,, ~~'::'.".~ S-

S lit8'fTiil'l"''l ln....,IOI)' Oeio.~.,y Rtoon 

~·d .. 
[ 10Cf"55109 r S)lll•m 

Quoco Si.IHC CII'M'IS:J.ion RIO.IIISI Fonn 

... .,.. ....... ~t~:nft)()f1 li-. p., .. 

Figure 2.24 Chart with Drawing Grid Off 

Auto Redraw After Edit 

This option is found in the Options roen u and defaults to 'Off.' When it is 'On,' 
then wberever you use an editing command (sucb as Move or Delete 
Object/Group ), tbe screen will be redrawn automatically on completion of the 
edit operation. This re m oves the need for yo u to die k on the redraw icon ( or 
select Redraw chart from the View menu, or press CfRL+ R) to redraw the 
screen. Screen redraws m ay be necessary after an editing operation to remove 
any screen 'debris' resulting from the edit. 
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LESSON 3 
MODIFYING A CHART 

Overview 

For this lesson, you will start with a chart that is incomplete, contains sorne 
deliberate errors, and is in need of repair. In fiXing and completing the chart, you 
will use the foUowing functions: 

• Loading a chart 

• Moving a symbol 

• Copying a symbol 

• Deleting a symbol 

• Resizing a symbol 

• Moving a block of symbols 

• Copying a block of symbols 

• Deleting a block of symbols 

• Changing a symbollabel 

• Changing a symbol type 

• Changing connections 

• Moving the entire chart 

To complete this lesson, you will need to be familiar with the material covered in 
Lessons 1 and 2. 

This lesson sbould take you approximately 45 minutes to complete. 
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NOTE: You should be using the default settings for EasyCASE Plus. lf you have · 
changed any settings, restare the default values for the duration of this lesson. 
Otherwise, the results of the instructions may be different. 

Loading a Chart 

First you will need to load the chart to modify. Use the MODIFY.DFD chart 
stored in the SAMPLES project directory. This chart is a variation on the 
TUTORl.DFD chart you created in Lesson 2. 

To load the chart: 

l. Choose the Load Chart command from the File menu, or press CTRL +L. 

A dialog box is then displayed listing the data flow diagram (DFD) charts 
in the SAMPLES project directory that are available for loading. 

Select Nane of Chart to Load 

DFD Objects (SSADMl 
DFD Objects (Yourdon/DeMarco) 
Eas~CASE Plus Context Diagran 
Sanple ([as~CASE Plus) DFD . 

. SaMp le DFD 
Sanple Project Context Diagran 
Sanple Project Level O DFD 
Sanple Project Process 1 DFD 
Sanple Project Process 2 DFD 

· objectss .dfd 
objectyd.dfd 
ecpcontx.dfd 
eas~case.dfd 
sanple.dfd 
context.dfd 
sop _a. dfd. 
sop_l.dfd 
sop 2.dfd 

Iutoria.l Mod i fy Chart nod i fy. dfd ~ ~ 

[ Ok l [Cancel] 

Figure 3. 1 Listing of Availab/e DFD Chart Files 

2. Select the MODIFY chart entry (MODIFY.DFD) by clicking on it. 

3. Click on 'OK.' 

Alternatively, double click on the chart entry. 
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4. The chart is then loaded and disp layed in the chart window, as shown in 
Figure 3.2. 

Y ou will observe that there are a number of problems with the layout of this 
diagram, which you are about to corree! in the following steps. These 'corrections' 
will allow you to gain farniliarity with the methods available for manipulating 
existing chart objects. 

1...--f+.l ............ ·········· ············ 

•. E .. ~ .. ¡• 
. : 1'-------;-· • -· ---'---'V'ii 

Figure 3.2 Chart to be Worked On in this Lesson 

Moving a Symbol 

Among the problems yo u will notice on the chart is the placement of the symbols. 
Y ou wiU begin modifying the chart by moving the Order Processing System data 
process symbol to a more centrallocation. 

To move the data process symbollabeled "Order Processing System": 
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l. Position the mouse pointer over the data process symbollabeled "Order 
Processing System" (be sure to locate it in the center of the symbol). 

2. Press and hold down the left mouse button. 

The symbol is highlighted anda small hand icon is displayed (see Figure 
3.3). This indicates that the symbol is selected and you can move it by 
moving the mouse while you are holding down the left mouse button. 

Figure 3.3 Hand /con Positioned Ready to Move Symbol 

3. While still holding down the left mouse button, move the mouse to move 
the hand icon toward a centrallocation between the four surrounding 
(externa! entity) symbols. An outline of the symbol follows the m o use 
cursor. 

4. Release the left mouse button. 

5. The symbol will move to the new location. The connections and their 
associated labels are automatically redrawn for the new position, as shown 
in Figure 3.4. 

6. Cück on the Redraw icon at the bottom right corner of the screen to 
. refresh the screen and remove any "debris" resulting from the move. 
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Wben you bave finisbed, your cbart should look like this: 

ln...t.RorY : 

~.....---.....~ ........... . 

Figure 3.4 Chart with Moved Symbol 

Copying a Symbol 
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. " .. 

. "'. 

Besides moving symbols, you can also duplicate them. This feature can be very 
useful wben you are creating large and complex charts. 

In tbis section, you will use the Copy command from the Edit menu to make a 
copy of tbe Management externa! entity symbol as follows: 

l. Select the externa! entity symbollabeled "Management"" by clicking on it. It 
will be highlighted. 

2. Cboose the Copy Symbol/Group command from the Edit menu. 
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3. Press and hold down the left mouse button. A small hand icon is displayed 
in the selected (Management) symbol. 

4. While holding down the left ·mouse button, use the mouse to move the 
outline of the symbol toa position just below the original Management 
symbol as shown in Figure 3.5. 

1 ~f'f1COf)' . 

...... . L--....1 ........... .. 

-"'""*" ,-----..;--' 
J--.--'.." " . " . " . " . ' . " " . '---------'·.' ..... ' ... ' 

--~· . . . . 
. : . . . 

Figure 3.5 Copying the 'Managemenr Symbol 

5. Release the left mouse button. 

An exact copy of the ·Management symbol, and its label, is drawn at the 
new location. 
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Deleting a Symbol 

It is a simple procedure to remove an object from the chart. Although it was a 
useful example, the new Management symbol that you just created is not 
necessary in this diagrarn. 

In this section you will delete the symbol with its associated label and connection 
by using the Delete command from the Edit menu, as follows: 

l. Select the new Management symbol by clicking on it. It will be highlighted. 

2. Choose the "Delete Object/Group' option from the Edit menu, or press 
the DEL key. 

A dialog box is displayed in the center of the screen, prompting you to 
conftrm deletion of the selected symbol, as shown in Figure 3.6. 

r§ .•.. 
- .. ' . Et[' ...... ::: 

Do lat.e Se lactad Syftbo 1 7 1----., .. .. . . . . . 
. . . . 
' . . ' 1 VE\} [ Ha 1 

Figure 3.6 Prompt to Confirm Deletion of Se/ected Symbol 

3. Click on 'Y es', or press the Y key. 

4. The Management symbol along with its label, and the data llow connection 
to the original Management symbol, is deleted. lf yo u get a dialog box 
requesting you to confirm deletion also of the Management entity data 
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dictionary entry, click on the No option button or press the ESC key to 
remove it. 

5. Click on the Redraw icon to refresh the screen to remove any 'debris' 
resulting from the deletion. 

Y our chart should now look like figure 3.4 again. 

Resizing a Symbol 

Y ou m ay decide that your chart can be clarified by changing the sizes of the 
symbols. The Customer and Management externa( entity symbols are smaller in 
size than they should be. 

In tbis section you will resize these symbols by using the Change Symbol Size 
command from the Edit menu. 

To resize the Customer and Management symbols: 

l. Select the Customer symbol by clicking on it. It will be highlighted. 

2. Select the 'Change Symbol Size' option from the Edit menu. 

3. A pop-up list box containing the available symbol sizes is then displayed 
(see Figure 3.7). Available symbol sizes are: Small, Normal, Large, Extra 
Large, and Giant. The Small size entry is highlighted initially. 
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···········•~~················ ··•sa ............ . 

Figure 3. 7 Select 'Normal' Entry Symbol Size from List 

4. Select the Normal entry by clicking on it. 

The Customer symbol is then redrawn using this (larger) size. 

5. Repeat Steps 1 to 4 for the Management symbol. 

6. Click on the Redraw icon to refresh the screen. 
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Y our diagram sbould loo k like tbat in Figure 3.8 . 

. . . . : . . . . : 

Figure 3.8 Resized Symbol 

Changing a Symbol Label 

Y ou may need to cbange the label on a symbol. The procedure for doing so is 
similar to tbat used for creating a label, as you did in Lesson 2. Although the 
lnventory symbol is useful, it is wrong for this diagram. 

In this section, you will use the Label Object command from the Edit menu to 
cbange the lnventory label as follows: 

l. Click twice on the lnventory symbol to select its label, as shown in Figure 
3.9. 
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2. A highlighted, dasbed box is then displayed around the !abe! text 
("Inventory") showing tbat it is selected. If the syrnbol is selected, click on 
it again until only the !abe! is selected. 

. . . . . . 
~ 

. 

... - ... -- • 
..... 

~r.~_v~QtQrZ' 1 ,. ts: 
. 

Figure 3.9 Selected Symbol Label 

3. Select the "La be! Object" option from the Edit menu, or press AL T +L. 

4. A text entry box is displayed in the center of the screen containing the 
current !abe! for the syrnbol. 

5. Press crRL +Y to dele te the current line of text. 

6. Type in the new !abe! "Supplier" (see Figure 3.10) . 

7. Press the F3 key. 

.----1: LABEL :1---, 
Suppl ier 

Figure 3. 10 Label Text Entry Box 
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8. Tbe new text for tbe label will appear at tbe current label position inside 
tbe symbol, as shown in Figure 3.11. You do not need to reposition the 
label. Press the Ei\'fER key, or click the right mouse button, to accept tbe 
default label position . 

. . i-
. . . . 

,..._ Supplier. 

' "' 

Figure 3.11 Labe/ Positi01zed bzside Symbo/ 

Changing a Symbol Type 

Y ou can easily change the type of a symbol as you develop your chart. Y ou m ay 
have noticed that a Multi·Data Process symbol type has been (wrongly) used for 
tbe Order Processing System. This should be a regular Data Process symbol. 

In tbis section, you will use the Change Object Type command from the Edit 
menu to correct it. 

To cbange tbe symbol type for the Order Processing System: 

l. Select the Order Processing System symbol by clicking on it ( click near the 
center of the symbol). lt will be highlighted. 

2. Select the 'Cbange Object Type' option from the Edit menu. 

3. A list box will pop up in the center of the screen containing the available 
symbol types for the current (DFD) chart type, as shown in Figure 3.12. 
Tbe 'Multi-Data Process' entry is highlighted initially. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



External Entity 
Data Process 
Data Store 
Split/Merge 
Multi-Data Process 
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Figure 3.12 List of Avai/able Symbol Types for a DFD 

4. Select tbe 'Data Process' option by clicking on it. 

The symbol is redrawn using the new symbol type (without affecting the 
curreot label). 

Moving a Group of Objects 

Tbe Supplier and Payroll externa! entity symbols are both too close to the Order 
Processiog System symbol. Rather than moving these independently, you can 
m ove them both together as a single unit (group ). 

lo this section, you will use the Move command to move these symbols together 
as a group. 

To move the Supplier and Payroll externa! entity symbols together as a group: 

l. Select the Supplier aod Payroll symbols together as a group by drawiog a 
selectioo box arouod them, as described in Lessoo l. A dashed selectioo 
box appears arouod the Supplier and Payroll symbols, both of which wiii 
be highligbted. 

2. Positioo the mouse pointer over the selected group of symbols, inside the 
selectioo box. 

3. Press and hold down the left mouse button. A small hand icoo is displayed 
(see Figure 3.13). 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



Page 82 

• • • o • • o • • • • • • • • • • • • • • • • • . . . . .. : ........... : . : . : . : . : . : . : . : . : . : . : . :~r--. -. -. -.--
. ~ ~ : : : : : ~ : : : : su~1e~ 
. . : ..... : .... ~ .... . . . . . . . , 

....... ---r----t ........... . 
:~e:.:·. . J\ . 

: : : : : ( : o~der: : : 
· Processing . 
: . . . . . : SI:Jstern . . 

• • • • • o •• o ••• o ••• o •••••••••• . . . . . . . . . . . . 
• • • o • • • . . 
• • • o • • • . . 

• o • • • • o • • 

i-----~··············· 

. ¡ 
¡ 

) 

) 
) . 

~ ) . 
~ ) . 
:D·:.:.:.:.:. ~-: 
~ . . . . . ) . . . . . . . . 
~ . . . . . ; . 
1 • • . • • ) • 
. ........... ) .. 
1 ) 

¡ 
¡ 
¡ 

) 
) . 
) . 
) . 

r-------o 

....... ___ ---e ....................... ~ .......... ...,..,,.._.,~ . . 
• • • • o • • • • • • • • 

Figure 3. 13 Hand /con Positioned to M ove the Selected Group of Symbols 

4. While holding down the left mouse button, use lhe mouse lo drag the 
dashed box one column (grid square) to lhe right. 

5. Release lhe left mouse button. 

6. The group of selecled symbols is placed allhe new localion. Nolice lhal 
lhe associaled connections and labels are also relocated. 

7. Click the righl mouse button lo de-selecllhe Supplier and PayroU symbols 
and erase lhe seleclion box. 

8. If necessary, click on the Redraw icon lo re m ove any 'debris' resulling 
from movemenl of the selected symbols. 
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Your chart should now look like this: 

:~:: : . . .. 

. . . . . . .... , _ _.. lE------'---' Pw-o1 . 

···········'---.......... .__ _ __. .......... . 

Figure 3. 14 Chart with Moved Group of Symbols 

Copying a Group of Objects 

Earlier in this lesson, you duplicated a single symbol (using the Copy Symbol 
command). You can also duplicate a group of symbols, rather than creating or 
copying the symbols independently. This process is similar to the Move 
Object/Group procedure just described. 

In this section, you will use the Copy command. 

To copy the Supplier and Payroll symbols together as a group: 

l. Select the Supplier and Payroll symbols together as a group, just as you did 
for the M ove Block procedure (see steps 1 to 3 of "Moving a Group of 
Symbols"). A dashed selection box appears around the highlighted 
symbols. 
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Choose the 'Copy Symboi/Group' option from the Edit menu. 

Press and hold down the left mouse button. A hand icon appears (see 
Figure 3.15). 

. . . . . . . . . . . . . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . : .......... .:.._ 

. . ,. . jm," . . 
~ : : : : < s~~~e~ : ............ . . 

• • • • • o • • • • • . . .......... 
,.-------.· ........... : ...... . 

~---T"""'-,.( ........ . 
. 'r"- . 

· : o;...der: : : 
!--.-....;,..-e----\P.-ocessine . 

. . . . : S¡,¡stern . . 

·············~-----,..¡; 
l 

: . . . . . ~ 

: . . . . . ' 
l . . 
l . . 
l . . 

~ . : . : . : . : . : . ~ ........... ~ . : . : 
~ l 
~ • • o o • ) • • ........ 

. . . ~ . . . . . i . . 
. ~ . . . . . ) . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . ............•. ' ......... l ... . . . . 

,...------..··············· 

,. . . . . . -..... 

• l 
~ ) . . 
r: ) o • 

l . . 
. . . l . . 

···············~---..,; 

. .. "" 
'----.....--! ........... : ........... : ........... ~ ........ .,....,.........f 

. . . . . . . ......... . 

Figure 3. 15 Hand /con Positioned to Copy Symbol Group 

4. Use the mouse to drag the dashed selection box two columns (two grid 
squares) to the right of the symbols' current position. 

5. Release the left mouse button. 

6. A copy of the two selected symbols is placed at the new location. 

7. Click the right mouse button to de-select the Supplier and Payroll symbols. 
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Wben you have fmished, your chart should now loo k like this: 

i:uttorM.: ... 
'---r---' ...... 

. . 

""""[S]" ' . . . . . . . . 
- : . : : P--"oi : : 

. . . . . . . . 
. . . . . ' . - . 
... ..... .. .......... '-----' 

Figure 3. 16 Chart with Copied Group of Symbols 

Deleting a Group of Objects 

Any modifications you can make to a single object, you can also make to a group 
of objects. This is also the case for delete operations. Rather than incorporating 
the extraneous, duplicate Inventory and Payroll syrnbols into the chart, or deleting 
them individually, delete both of the new syrnbols in a single operation. 

In this section, yo u will use the Delete G roup command. 

To delete the new (right-most) Supplier and Payroll symbols together as a group: 

l. Select the Supplier and Payroll syrnbols together as a group Gust as you 
did for the Move Group and Copy Group procedures). 
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2. Select the 'Delete Object/Group' option from the Edit menu, or press the 
DEL key. 

3. You are prompted to verify that you want to delete any Data Dictionary 
Entries (DDE) associated with the symbols as they are deleted. 
EasyCASE Plus automatically displays this prompt wbenever you delete a 
symbol or group of symbols, whether or not there are existing Data 
Dictionary En tries for the symbols. At this point in the tutorial, you have 
not yet Iinked cbart objects to entries in the data dictionary. Hence, this 
dialog box is irrelevant at this point. 

~--~: Delete DDEs ? :~----~ 

> Do NOT Delete DDEs 
o Delete DDEs, ConfirM 
o Delete DDEs, NO ConfirM 

'•·. :· [Cancel] 

Figure 3.17 Prompt for Deletion of Associated Data Dictionary Entries 

4. Click on the 'Do NOT Delete O DEs' option. 

5. Click on 'OK.' 

6. Tbe selected symbols, and their labels, are erased from the chart. 

Your chart should now look Iike figure 3.14 again. 

Modifying Connections 

Whenever the logic for the diagram changes, you can change the data llow to 
accommodate it. EasyCASE Plus gives you a number of ways to modify 
connections: 

• Change the direction of a connection 
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• Change the end point positions of a connection (i.e. where it connects with a 
symbol) 

• Reroute the connection (i.e. changing the path of the connection) 

• Change the destination andfor source symbols for a connection 

• Delete a connection 

• Change the number of arrowheads or symbols on the end(s) of a connection 

Every connection has a small box at the mid-point of a line segment. This is the 
"handle" you will use to select the connection. When a connection is selected, a 
marker is displayed at each corner and mid-point of the line segments that 
constitute the connection, as well as at each end. These markers function in two 
ways: 

• As a select point to grab and m ove the connection line segments 

• As a select point for removing and possibly rerouting sections of the 
connection 

The following exercises will illustrate how to modify connections. 

Changing the Direction of a Connection 

Changing the direction of a data flow is quick and easy. For example, the 
dir,ection of the connection between the Order Processing System symbol and the 
Customer symbol is incorrect and needs to be reversed. 

In this section, you will use the Change Direction command from the Edit menu 
to reverse the direction of the connection, as follows: 

l. Select the data flow connection that originales from the Order Processing 
System symbol and enters the Customer symbol ( click on the connection's 
han die). The connection is highlighted and markers are visible at various 
positions on it. 

2. Select the 'Change Direction' option from the Edit menu. 

3. The data flow is reversed so that it represents a flow of data from the 
Customer externa! entity symbol into the Order Processing System data 
process symbol. 
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Wben you are fmished, the Customer and Order Processing connections should 
look like this: 

. . :. :. :. :. :. :. :. :. :. :. :. :. : ··:.:.:.:.:.:.:.: .......... ~ 
.... , ..... 

. . . . . . " Supplie.- . 

. . . . . . ' ..... 
o • • • • • r--------[ .................. . . ............ 1------t 

tustomer: 
¡..__~.,-.-~ ........... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . ............ 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . ... . . . . . . 
r-----t·:.:.: ~::. ~.:. ···············;-----i 

: : ~ar.aseiner.t: ~ · · · · · : 
...... 

·.,. 
. . . . -

L----...t ........... : ........... : ........... '------t . . 
•••••• o ••• o •••••••• 

Figure 3.18 Chart with Flow Direction Changed 

Deleting a Connection 

You can delete a connection justas you would a symbol. As an illustration, delete 
one of tbe connections to the Supplier symbol. 

You will use tbe Delete command from the Edit menu to accomplisb this. 

To delete tbe connection: 

l. Select tbe lower of the two data flow connections terminating in the 
Supplier symbol. The connection is highlighted and markers appear along 
it. 

2. Select the 'Delete Object/Group' option from the Edit menu, or press the 
DEL key. 
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30 A dialog box pops up in the center of the screen requesting you to conflrm 
deletion of the selected symbol (see Figure 3019)0 

........................ 
o • . . . . . . . . . . . . . . . . . . o o o.: ....... o. o.: o o ......... : o o o o ... o ... : .. o o o o ... o~ 

o o : . . . . o : o . . . . : . . . . -

o o ~ : : : : : : ; : : : • : : : : • :_ S~p~l~e~ : 
o o o :o .... : o o. :. ~o .. r------. o .......... : . o . . . . . . . : o .. '1\r. . .. '-. ----l ..... . 

o • 

tultomer: : : : : : : : : : : : : : 
'-----T-r-----1: De lete Co~nection 7 ~1-------. 

[ YES ] [ No l 
·'-

............. 
L-----------------------------~ 

...... o o . o ... o . ;.-.-----i .... o o 

................. 
'------t ........... :-- .. o •••••• :- ... o o • o ••• L-.----1 .... .. 

o o 

•••••••••••••••••• o 

Figure 3o 19 Prompt to Confirm Deletion of Selected Connection 

40 Click on the 'Y es' button, or press the Y keyo 

5o The connection is erased from the chart (see Figure 3o20)o 
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.. 
.. . .. .. . .. . .. .. .. .. .. . .. ....... ;.· . ~..:...:· ·..:...:· ·...:....· ·~· -~· --:--:--:-:~ 

1....--,_...-..t . " .. " " " 

. . . . : · : o;.der: : : 
!---~-----~)¡..\P"ocessi ng . 

. . . . . . : s.,stelll .. 

" ...... " " '----...-1 

....... 

. . . . . . . 

............................ . . . . . . . . 
o ••••• o •• o • o 

• ••••••••• o • . . . . . . . . . . . . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

: : : ':"--,--~ : : : . . . . . . . . . . . . . . . 
• • o •••• . . .... 

. . . . ..... . 
............... 

. . 
• •••• o o . . . . . . . . . . . . . . . . . . . . 

.. " .. " " .. " . i-------; 

·, 
... , 

'-----....1 ........... : ........... : ........... ~--~--....l . . 

..... :::: ~:: . . 

Figure 3.20 Chart with Connection Deleted 

Changing the End Point for a Connection 

Y ou can relocate the end of a connection, or even both ends, to a different point 
on the symbol, or evento another symbol. In the example diagram, the end points 
for the connections between the Order Processing System symbol and the 
Supplier symbol are wrong at the Supplier end. In this section, you will change 
the connection's end points on the Supplier symbol to a slightly different position 
on the perimeter of that symbol to clarify the data flow. 

"'..;. .. 

" .. ·~ . . . . 
• • o • 

Figure 3.21 Poor Connection End Point at Symbol 
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To change the connection end point at the Supplier externa! entity symbol: 

l. Select tbe data flow connection that is an input to tbe Supplier symbol. 
Tbe connection is highlighted witb aU of its markers displayed. You will be 
accessing one of the markers at the end of the connection. 

. . .......................... ,....-----.... . . .... . . . . 
"' 1'\.. . : : : "'Supp ll er 

• o : • • • • • • • • • • •••••••••••• h-~~~-~-t 

. . . :a: ...... • • o • • • o • • • • • • • o • • • • o • • • • • o • 

~ : arder: : : 1 . 
,_, p,..ocessi ns 
. : S~:~stell'l . 

' ' 

Figure 3.22 Selected Connection 

2. Click on the marker box located at the connection's end point, coincident 
with tbe Supplier symbol as shown in Figure 3.22. 

3. The preceding section of the connection is removed (from the selected end 
point back to the last change in direction). The marker moves to the new 
end point, as sbown in Figure 3.23. 
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. . .. : ........... : ........... ,------r 

o • • • • • • o • • • • 

• • • o o • • • • • • • .. .. .. .. .. .. .. .. .. .. .. .. ....... ~~--~-t 
• • • • o • o • • • • • • 

. . . . . . . . . . . . . 

. . . . 
• ••••••••••••••••••• o •••• o • . . :e:.:.: .. 

• • • • • • • • • o • • 

. . . . . . . . . . . . . . 
• • • • • • o • • • o • 

• • • • • • • • • • • • • • • • • o ••••••••• . . . 
• • • • • • • o • • • • o . . . 

Figure 3.23 Connection with Last Segment Removed 

4. Click the righl mouse buuon once lo remove the other line segmenl. 

5. Selectthe Supplier symbol by clicking on il. 

6. The allowed end points for connection on the perimeter of the symbol are 
indicated by markers, as shown in Figure 3.24. 

. . . . . . . . . . . . . . . . . . : . . . . . . . . . . . : . . . . . . . . . . . r-e.--e--e--e--~:r-r: 
. . . . . . . . 

.. .. .. .. .. .. . ~¡.,..e..-s--.¡¡.....¡;t.-t 

. . . . . . . . . . . 
o • • • • • o . . 
. . 
••• o ••••••••••••••• o ••••••• . . . . . . . . 

• • • • • • o • • • o • . . . . . . . . . . . . . . . 
• • • • o • • • • o 

•••••••••• o o •••••••••• o o ••• . . 
• • • • • • o • • • • • • o 

Figure 3.24 Available éntry Ports at Destination Symbo/ 

7. Click on the marker located half way down lhe lefl side of this symbol. 
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8. The connection is then rerouted to this new end point. 

. . . . 
Supplier. · ..... 

Figure 3.25 New Placement of Flow 

Rerouting a Connection 

Although connections between symbols are automatically routed, sometimes the 
routing used for a connection may conflict with other chart objects. To illustrate 
this, you will add a new External Entity symbol just below the Order Processing 
System symbol. You will then reroute the affected data llow inputs for the 
Management and Payroll symbols so that they no longer pass through the new 
symbol. 

First, add a new externa) entity symbol that conflicts with the Management and 
Payroll data llows as follows: 

l. Choose the 'Externa) Entity' option from the Objects menu. 

2. Click on the grid square midway between the Management and Payroll 
external entity symbols, as shown in Figure 3.26. 

3. An externa) entity symbol is placed at that position on the chart, on top of 
the connections between the Order Processing System syrnbol and the 
Management and Payroll symbols, as shown in Figure 3.26. 

EasyCASE Plus Version 3.1 Beginner's Tutorial 



Page 94 

. . . . . . . . . . . . . . . . . . . .... . . . . . . . . . . 
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. . . : : . { : o;..der: : : 
~-__;_-e----~~\P,..ocessing. 

. . . . . . : S~sl:.e111 . . . . 

............. !--~--....( 

....... . . ........................... . . . . . . 
• • • • • o • o • o ••• 

~ ~ : : : : ~ : : : : : ~ : . . . . . . . . . . . . . . . . . . 
••••• o ••••••••• o •••••••• o. • ••• o •••••••••••••••••••••• o •••••••• . . . . . . . . . . . . . . . . . . 

• • o • • o • • . . . . 
. . 
••• o ••• 

• • o •• o 

1

/ • " ~ "p p p >¡i-:-p:a-!:1;...-oJ.-1:-i¡· . : 

. : . : . : . : . ..J-.--~-.---~. •........... L-: ------t . ~ 

Figure 3.26 Placement of Extra Externa/ Entity 

Next, reroute the affected Management and Payroll connections: 

l. Select the Payroll data flow (die k on the smaJI box or "handle" located on 
the connection). The connection is highlighted and its markers are 
displayed. 

2. Click the left mouse button on the connection end point marker at the 
Payroll symbol end. 

The last line segment is removed from the connection at the selected end 
and the end point marker m oves to the new end point position, as shown 
in Figure 3.27. 
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. . : e: 
. i : Order: . 

r---7'' p,-.ocessi ng 
. "' . : S~::~s:t.ern . 

t 

1'" 
·~ 

Figure 3.27 Connection with Line Segment Removed 

3. Click the right mouse button, or press the BACKSPACE key, once only. 

Tbe remaining line segment is removed from tbe connection. There are no 
line segments left on the connection. 

4. Click the left mouse button inside the Payroll symbol. 

Markers are displayed around the Payroll symbol to indicate allowable 
entry positions for the connection. 

5. Click on the marker located midway along the top of tbe Payroll symbol. 

The connection is rerouted to tbe new end point, avoiding the external 
entity symbol, as sbown in Figure 3.28. 
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: . . . 1 

:e:.:.: .. 
· : o;...der: : 

P,..ocessins 
: S~:~stem . 

• • • o • • • • • • • • • . . 
o o • • • • o • • • o o • . . . 
• • • • • • • • • o • • • • • • o • • • • • • • • o o 

• • • • • • • o • • 

• l • • 
: r . . • . : . . . . . : 
. . . . . . . . . . . . . . . . 

. . 
o ••• o ••• o •••• o • o •• o ••• o • o • o •••••• o • . . . 

. \lt . 

~~~~--~ ........... ~----~--~ 

-Figure 3.28 Payro/1 Symbo/ with Connection Moved 

6. Repeat Steps 1 through 5 for the Management data flow. 
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The resulting connections should look like this: 

'[]'"""""" ' . . . ' ' . . . . ' -

. . 
' . . . . . . 

- . . . . . . . " . . . " -

,....--"---i ............ .. 

'P.~ol . 

Figure 3.29 Manually Rerouted Connections 

Changing the Destination Symbol for a Connection 

Besides changing a connection's end points on a particular symbol, as you did for 
the Supplier symbol, you can change the deslination symbol for a connection. In 
this section, you willtry this by moving the destination for the data llow input 
connectioo from the Payroll symbol to the new symbol. 

To change the destination of the data llow from the Payroll symbol to the new 
symbol: 

l. Select the Payroll data llow ( click on the small box or "handle" located oo 
the coonection). The conneclion is highlighted and all of the markers are 
displayed. 

2. Click on the connection end point at the Payroll symbol end. 
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The lastline segment is removed from the connection. 

3. Click the right mouse button, or press the BACKSPACE key, once only. 

Another line segment is removed from the connection, as shown in Fig•--e 
3.30. 

. . 
• • • • • • • • • • • • • • • • • o ••• o • o •• . . 

. 1 

. . 
• • • o • • • • • • • • • o • • • • • o • • • • • o 

. f'-_: . . J-i 

: . ¡:----, ........... r-:--Pa_y_r-_o_l_l :___. 

1-.-.-~~-.....C ................... ~-~~......t 

Figure 3.30 Connection with Line Segment Removed 

4. Click the left mouse button inside the new symbol. 

The end points are displayed by marker boxes. 

5. Click on the end point marker located on the top of the new symbolthat is 
directly below the source end point on the Order Processing System 
symbol. 

The connection is rerouted to the new symbol destination, as shown in 
Figure 3.31. 
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.... ' ' ... ' L_.;.__;_;_¡ 

' t· ' ' ti . 
· · · Ord.i : . 
'----'-+-----c~\IProc;H~. 

S¡,o;st..,. 

·.:g: 
L---.....1. .. ' ' c=_j 

Figure 3.31 Rerouted Connection Destination 

Changing the Number of Arrowheads on a Connection 

You can change the number of arrowheads used for a specific connection, or for 
all connections. The Default # Arrowheads setting in the Options menu affects 
all connections. Y ou use the Change # Arrowheads command in the Edit menu 
to change the number of arrowheads for a particular connection. 

To change the number of arrowheads for the connection between the Supplier 
externa! entity and Order Processing symbols: 

l. Select the connection between the Supplier and the Order Processing 
System symbols by clicking on its "handle." 

The connection is highlighted, and its markers are displayed. You will 
observe that this connection currently has a single arrowhead on it at the 
Supplier end. 
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2. Select the 'Change # Arrowheads' option from the Edit menu. 

3. 

A dialog box is displayed listing the available arrowhead characteristics, as 
shown in Figure 3.32 . 

.....-~: Se lect lt Arrowheads :t----. 
o Ho Arrowheads --------
o One-Wa!:J Single -------> 
o One-Wa!:J Double ------>> 
o Two-Wa!:J Single <------) 

Two-Wa!:J Double <<---->> 

[ O k ] .. •'• .. ·.······· 
~: . ::_ :·- ·: •' ,: . 

Figure 3.32 Number of Arrowheads Options Dialog Box 

Click on the 'Two-Way Double" setting. 

4. Click on the 'OK' button. 

5. The Supplier connection is drawn with double arrowheads at each end of 
it. 

• • o • • • • • • • • • • • . . .. : ........... : ........... .-------r 
. . . . 

: : : : : : .. _,. ....::----:~ ).:0:::_:)::.1 ~U~Pli~r : 
o • o • • • 

.. .. .. .. . . .. .. .. .. .. .. .. . 1-...-~~~....t 

. : . . . . \ 1 : . . . . . : : . 

. : . . . . ' '¡ : . . . . . : . 

. : . :~:.:.:.:.:.:.:.:.:.:.:.:.:.: 
. /0 .... :-... ..... : ..... : . 

Figure 3.33 Connection Drawn with Double Arrowheads at Each End 
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Moving the Entire Chart 

While you are developing a chart, you need not be overly concerned about its 
position in the chart window. You can easily change this by moving alJ of tbe 
chart objects together as a single unit. For example, the only remaining problem 
witb tbe MODIFY chart is its position in relation to the Title Block. 

In tbis section, you will use the Move Chart command to reposition the chart. 

To move tbe entire chart as a unit: 

l. Select tbe Move Wbole Cbart command from the Edit menu. 

l!t!UI Objects IJlew Optlons 

Delete object/group Del 
Move object/group Alt+M 
Copy syMbol/group 

Change object type .. . 
Change syMbol size .. . 
Change 1 Arrowheads .. . 
Change direction 

Select group Ctrl+G 
Hove whole chart 
Text block ... Alt+T 

Label object... Alt•L 
Identify object ... Alt•l 

Figure 3.34 Edit Menu containing the Move Whole Chart Command 

Tbis automatically zooms the chart window to full chart mode. The entire 
cbart is visible and selected, shown by a dashed box outlining all of the 
objects ( except the tille block) on the chart. 

2. Press and bold down the left mouse button. 

3. Still holding down the left mouse button, drag the selection box one grid 
square down and to the right of the chart's present position (as shown in 
Figure 3.35). 
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Block Uiew Objects Options Explode Utility 

n 

Figure 3.35 Selection Box 'Dragging' Chart Outline to New Location 

4. Release the left mouse button. 

5. A dialog box pops up in the center of the screen, prompting you to conflrm 
the placement of the chart. 

6. Click oo the 'OK' option button to confirm the oew position and re-display 
the chart at Actual size. 
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Your chart is now complete and, aside from possible spacing differences, should 
look like this: 

........... >·~ 

. l .. . . 

• : 1 . 
. ,J¡ 

,..-'----l>)j s.,..,.;., . 

. o 
O•d..- .. . 

Proc.ung . .. . 
- S)I!Siem . -

:g .. c=_j_ 

Figure 3.36 Chart Re-positioned in Chart Window 

This coocludes the current lessoo. 
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In addition to the Data Flow Diagram (DFD) chart type, EasyCASE Plus also 
offers severa! other chart types: 

Chart Type 

Transformation Graph 

Structure Chart 

Entity Relationship Diagram 

State Transition Diagram 

Data Structure Diagram 

Data Model Diagram 

Entity Life History 

Logical Data Structure 

Creating a New Chart 

File Extension 

.TRG 

.STC 

.ERD 

.STO 

.DSD 

.DMD 

.ELH 

.LOS 

For further practice, you may want to create the following ERO chart: 

r-----,··"""" 

. . 

:-+- i:ust.O.er-: ProdUct . 

'--""T""--' '---,--< .......... 

. p;...,o~w : 1---' 

r-----t ......... . j--....:L.--¡ .......... 

p~= 

'------,'-----~ i....,i,. : 

Figure 3.37 Alternative ERD Chart 
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You use the Change Type command from the File menu to access a different 
chart type as follows: 

l. Select the 'Change Type' option from the File m en u. If necessary, press the 
ESC key to bypass the 'Save chart?' dialog box if it appears. 

A listing of the supported chart types and symbol sets is displayed in the 
form of a pop-up list box, as shown in Figure 3.38. 

Data flow - Yourdon/DeMarco (dfd) 
Data flow - Gane & Sarson (dfd) 
Data flow - SSADM v4 <dfd) 
TransforMation graph - Yourdon (trg) 
TransforMation graph - Gane & Sarson (trg) 
State transition diagraM (std) 
Structure chart (stc) 
Entity relationship - Chen (erd) 
Ent i ty re lat ionsh ip - BachMan (erd) 
Entity relationship - Martín (erd) 
Data Model diagraM - Bachnan (dnd) 
Data nodel diagran - Martin (dnd) 
Data structure diagran (dsd) 
Entity life history- SSADM v4 (elh) 
Logical data structure- SSADM v4 (lds) 

Figure 3.38 Listing of Supported Chart Types and Symbol Sets 

2.. Click on the 'Entity Relationship Diagram-Bachman (ERO)' entry to 
select it. 

3. The EasyCASE Plus chart window screen is cleared and the Title Block 
and screen information updated for the new chart "UNTITLED.ERD". 

F'roíeci: 0:\T8T\ECPLU:S31\SAMPLES\ : : : : 
Chc¡rt ~ . . :. . . . . . : . . . . . : . . 
E)lenacne.: U nlltl~d .. erd . . : . . . . . : . . 
c;hc¡rt c:re.at~d :on : . . . . : . . . . . : . . 
bJ.' !J~~~d· ·t: • d : .... ' ... ' .. : ' .......... : .... . 

Last mo 111e Pn.: . . . . : . . . . . : . . 
bY !JSer ~ . : . . . . . : . . . . . : . . 

Figure 3.39 Changed Title Block 
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4. Notice the changed object type icons displayed to the left of the chart 
window. These represen! available chart object types for an ERO. The 
entries in the Objects menu are similarly updated. 

<1'- . . . 
·'IV . 

Figure 3.40 Bachman ERD Objects lcons 

If necessary, refer to the procedures in Lesson 2 and this lesson to create a chart 
based on the sample that you have chosen. 

For More lnformation 

See "Selecting, Placing & Manipulating Chart Objects" in Chapter 5 of the 
EasyCASE Plus Chart Editor User"s Guide. 
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LESSON 4 
OTHER CHART FILE OPERATIONS 

Overview 

This lesson covers: 

• Saving a selected group of objects to a new chart 

• Merging a saved chart into a currently loaded chart 

• Deleting a chart 

For this lesson, you will use the TUTORl.DFD chart you created in Lesson 2. 

This lesson should take you approximately 15 minutes to complete. 

Saving a Group of Chart Objects 

Rather than always saving the complete chart, you m ay only want to save a 
selected part of a chart. You can do this with the Save Block option in the File 
menu. 

To save the Order Processing System, Supplier and Payroll symbols area of the 
chart: 

l. Select the Order Processing System, Supplier and Payroll symbols with 
their associated connections as a group, following the procedure provided 
in Lesson 1, as shown in Figure 4.1. 
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Figure 4. 1 Selected a Group of Char1 Objects 

2. Select the 'S ave Block' option from the File menu, or press CfRL +B. 

3. A dialog box pops up prompting you for the fllename to use for saving the 
selected block, as shown in Figure 4.2. The default fllename is 
FRAGMENT.DFD. 

Save F ilenal'le: 1 fragment.dfd 1 

[ 'les ] [ Ho ] [Cancel] 

Figure 4.2 Prompt for Chart Filename to Save Selected Object Group 

4. Click on the 'Y es' option to save the selected chart object group to a new 
chart using this default filename. 
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5. A second dialog box then pops up prompting you for the name to use for 
the new chart, as shown in Figure 4.3. The default chart name is 
"fragment". 

Select dfd Nane 

ID : 1 fragnentB 

DfD Objects (Gane & Sarson) 
DfD Objects CSSADMl 
DfD Objects (Yourdon/DeMarco) 
EasyCASE Plus Context Diagran 
Sanple CEasyCASE Plus) DfD 
Sanple DfD 
Sanple Project Context DiagraM 
Sanple Project Level B DfD 
Sanple Project Process 1 DfD 
Sanple Project Process 2 DfD 
Tutorial Modify Chart 
tutorl 

[ OK J [Cancel] 

Figure 4.3 Prompt for Fragment Chart Name 

6. Click on 'OK' to accept the default chart name presented. 

1 

7. The selected chart area is saved to file FRAGMENT.DFD in the current 
project directory. 

Tbe saved block of objects is still selected. Leave the block selected for the next 
(Merge Chart) operation. 
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Merging a Chart 

Y o u might want to merge a saved cbart into tbe current cbart. Tbis procedure 
could save you time if you plan on using the same cbart structure on more tban 
one cbart. 

To merge tbe FRAGMENT chart you just saved into tbe current chart: 

1. Choose the "New chart" command from the File menu. 

ldrgM Edit Objects Uiew 

New chart... Ctrl•H 
Change type ... Ctrl•C 
Load chart ... Ctrl+L 
Merge chart .. . 
De lete chart .. . 
Save block ... Ctrl•B 
Save chart Ctrl+S 
Save As... Ctr 1 +A 
Export chart .. Ctrl+E 

Print/Plot. . . Ctrl +P 
Pr i nter setup ... 

Change project ... 

About ... 
Exit toDOS ... Ctrl+X 

Figure 4.4 File Menu 

2. An empty chart is displayed. 

3. Select the "Merge Chart' option from the File menu. 

4. A listing of the DFD charts available in the current project directory is 
t!Íen displayed, as shown in Figure 4.5. 
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5. Click on the FRAGMENT chart entry (the chart object group that you 
previously saved). 

Select NaMe of DFD Cbart to Load 

DFD Objects·(Yourdon/DeMarco) 
E4syCASE Plus Context Di4graM 
SaMple (EasyCASE Plus) DFD 
SaMple DFD 
SaMple Project 
SaMple Project 
SaMple Project 
SaMple Project 
Tutorial Mod 

Context DiagraM 
Level O DFD 

1 DFD 
2 DFD 

objectyd.dfd 
ecpconbc.dfd 
easycase.dfd 
saMple.dfd 
context.dfd 
sop O.dfd 
sop-l.dfd 
sop-2.dfd 
Madi .dfd 

[ Ok l [Cancel] 

Figure 4.5 List of Charts Available to Merge 

6. Click on the 'OK' option button. 

7. A dialog box pops up to conlirm merge of the FRAGMENT.DFD chart, 
as shown in Figure 4.6. 

~----------~: Merge chart ? :~----------, 

[ YES ) [ Ho ] ~ 

Figure 4.6 Prompt to Confirm Merge Chart 

8. Click on the 'Y es' button. 

9. Position the mouse pointer in the upper left comer of the chart window as 
shown in Figure 4.7. 
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... . . 
·f\. ... 
-~--

Figure 4. 7 Mouse Pointer Positioned to Merge Chart 

10. Click the left mouse button once. 

Tbe FRAGMENT.DFD chart is then merged witb the blank cbart at the 
original position of the saved block, as shown in Figure 4.8. 
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-~- .. . . .. . . . . 

. . . . . . . . . '------r-----' 

. •s_ . 
........... L.----l ...................... .. 

Figure 4.8 Merged Chart 

Deleting a Chart 

You no longer need the FRAGMENT.DFD chart containing the saved block of 
objects, so delete this chart, rather than using up storage space as follows: 

l. Select the 'Delete Chart' option from the File menu (see Figure 4.4). 

2. A listing of the available DFD charts in the curren! project directory is 
displayed. 

3. Click on the FRAGMENT chart entry. 

4. Click on 'OK.' 
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5. You are then prompted to verify that you want to delete the 
FRAGMENT.DFD chart, as shown in Figure 4.9. 

Delate chart file fragnent.dfd? 

( YES ] [ No ] 

Figure 4.9 Prompt to Confirm Deletion of Selected Chart File 

6. Click on "Y es." 

7. Y o u are then pro m pted to verify that yo u want to delete the data 
dictionary entry associated with the deleted chart, as shown in Figure 4.10. 

Delate Object Entry fron Data Dictionary 7 

Object Type : dfd 
ldent i f ier : fragment 

( YES J [ No 1 

Figure 4. 10 Prompt to Confirm Deletion of Deleted Chart's Data Dictionary 
Entry 

8. Click on 'Y es.' 

The data dictionary entry for the FRAGMENT chart is marked for 
deletion, and the FRAGMENT.DFD chart is deleted. 

NOTE: To permanently remove an identifier from the data dictionary, use the 
Pack command in the Data Dictionary and Reports Manager (DDRM) utility. 

For More lnformation 

See "Selecting, Placing & Manipulating Chart Objects" in the EasyCASE Plus 
Chart Editor User's Guide. 
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LESSON 5 
DESCRIBING CHART OBJECTS TO THE DATA 
DICTIONARY 

Overview 

This lesson covers: 

• Overview of chart object identilication 

• Identifying objects 

• Data Dictionary Entry (DDE) screen access 

You should now have a working knowledge of the skills covered in Lessons 1 
through 4. The exercises in the following lessons build on these fundamental 
skills. 

To save time, certain operations are mentioned but not the mechanics of how to 
achieve them, as these have been covered in prior lessons in detail. 

For example, rather than directing you to load a chart and specifying the steps 
involved, you are simply directed to load the chart. Refer to the appropriate parts 
of the previous lessons if you need to refresh your memory. 

This lesson should take you approximately 15 minutes to complete. 

You will need to use the TUTORl.DFD chart you created in Lesson 2 to 
complete the exercises in this lesson. If this chart is not currently loaded, you will 
need to load it now, as described in Lesson 3. 

The Data Dictionary 

The data dictionary stores information about chart objects and consists of 
"entries" or groups of attributes delining an object. Each entry in the data 
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dictionary has a unique identifier. However, multiple cbart objects can be 
identified by a single entry in the data dictionary. 

NOTE: In the EasyCASE Plus documentation you will see data dictionary entries 
referred to by the acronym DDE. 

Sorne of the attributes that you specify in the data dictionary enable you to 
establish functional relationships or ''links" to associated charts or text files, or to 
defme data structures (such as records and elements). You willlearn how to use 
these features in Lesson 6. 

When you created objects in the Basic Skills Tutorial the objects were simply 
graphic symbols that you could modify or delete without affecting anything else in 
the diagram or project. They were not identilied in the data dictionary and so did 
not have any potential for "real" functional relationships, and were not re-usable 
elsewhere in the project. 

It is as though to be operable, each object has to have the equivalen! of a Social 
Security number to uniquely identify it and that enables it to develop recognized 
associations with other data. The key word is "data". An object has to ha ve a data 
componen!, its unique name in the data dictionary, befare it can be a functional 
member of the chart. 

By identifying chart objects and delining them in the data dictionary, you begin to 
tap the full potential of EasyCASE Plus. 

ldentifying Chart Objects 

Throughout the Basic Skills Tutorial you created and modilied objects that were 
not identilied in the Data Dictionary. This is the main method of developing 
charts. When you have completed a chart, you can then go back and "manually" 
identify each object. This method is good for quickly prototyping charts, without 
having to be concerned with the underlying functional aspects. You can also 
manually identify objects immediately after you place them. 

Manually ldentifying Chart Objects 

Having created the TUTOR l.DFD chart without identifying any of the objects 
(symbols and connections), you can now identify them as follows: 

l. Select the data process symbollabeled "Order Processing System". 
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. . . : 
• 

... ~-
drdi:-r: . : 
P.ro~essiQg . 
S_ystem . . 

: ... 
• 

Figure 5. 1 Selected Data Process Symbol 

2. Select the 'Identify Object' option from the Edit meo u, or press AL T +l. 

3. The identifier dialog box for the symbol is displayed, with the cursor 
located in the text entry box at the top of the dialog box, as shown in 
Figure 5.2 . 

.-------1: Select Data Process NaMe :1-----. 

ID: Llm _________ __. 

a D 
a.a 
1 
1.2 
1.3 
1.4 
1.5 
1.6 
2 
2.0 
2.2 
2.2.3 

[ OK J [Cancel] 

Figure 5.2 ldentifier Dialog Box 
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Any identifiers for any other Data Processes already defined in tbe data 
dictionary for the Sample project are listed below the text entry box. 

NOTE: If tbe symbol was airead y identified, the identifier would appear in tbe 
text entry box and bighlighted in the list. 

4. Type "Order Processing System" in the text entry box, as sbown in Figure 
5.3. Tbis will be the symbol's identifier. 

,---_,: Select Data Process NaMe lr-----~ 

ID: lorder Processing SysteMI 1 

o o 
0.0 
1 
1.2 
1.3 
1.4 
1.5 
1.6 
2 
2.0 
2.2 
2.2.3 

[ OK 1 [Cancel] 

Figure 5.3 Symbolldentifier in Text Entry Box 

5. Click on the 'OK" button. 

6. Tbe symbol's Data Dictionary Entry data entry screen is displayed as 
sbown in Figure 5.4. The top two lines of the dialog box sbow the name 
(Order Processing System) and type (Data Process) of tbe selected symbol 
you just identified. 
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r------tl Chart Objec; r. DDE Sereen :1--------. 
DDE Nane: Order Proeessing SysteM 
DDE Type: Data Proeess 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 
Objeet Explodes To : 

Type:EJ 
Nane:EJ 

Alias: 
Mise tl1: 
Mise tl2: 
Misetl3: 

.... :-:·: :.:; [Defin] [Deser] 

Feb-19-1992 
Feb-19-1992 

lFí leJ 

[ Ok ] [QuitJ 

Figure 5.4 Data Dictionary Entry Screen · 

Notice the current attributes defined for the chosen object: 

• The Name field shows the identifier for the symbol (cannot be edited). 

• The Type field indica tes the type of the symbol ( cannot be edited). 

• The Last Mod (modified by) attribute is the name of the person who last 
modified the Data Dictionary Entry for this symbol ( cannot be edited) and the 
date tbe modification was made. 

• The Creator ( created by) attribute is the name of the person who created the 
DDE for this symbol (cannot be edited) and the date of creation. 

• The [Label) button allows access to the existing label for the object. Although 
you can edit the label, do not do so at this time. It is the same label as the one 
you entered by choosing the 'Label Object' option from the Edit m en u after 
you placed tbe object on the chart. 
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NOTE: Do not be concerned with the other options displayed at this point. We 
will address those in Lesson 6. 

7. Click on the 'OK' button or press F3 to return to the chart. 

Both the symbol and its label are selected. 

8. Press the El'.'TER key to leave the label positioned at its original position. 
You have just defined the selected chart object in the data dictionary. 

9. Repeat steps 1 to 5 for the Customer, Management, Supplier and Payroll 
externa! entity symbols, entering identifiers of '"Customer", "Management", 
"Supplier", and "'Payroll" for each respectively. 

Automatically ldentifying Chart Objects 

lf you prefer, rather than creating your objects then going back and identifying 
them, you can choose to have EasyCASE Plus automatically prompt you to 
identify objects when you create them. Although this adds sorne time to the chart 
creation process, you do not have to return to the chart later to finish defining the 
objects in the data dictionary. 

As a convenience, you can set the 'Auto Identify' option On. In this case, 
EasyCASE Plus will prompt you to identify each object as it is placed on the 
chart. This saves you the step of invoking the Identify command from the Edit 
menu after placing an object on the chart. 

To set the 'Auto Identify' option to On: 

l. Select the Options menu. 

2. Select the Préferences entry. 

A dialog box will pop up listing a number of available options, as shown in 
Figure 5.5. 

3. Click on the 'Auto Identify' option to set it to On. When it is On, an 'X' will 
appear to the left of this option's text. 
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.-------1: Set Opt ions ~t----, 

Auto ldentify 
• Auto Label 

Allow Place Hew Label 
• Auto Export to dBASE 
• Auto Export to SDF 
• Auto Export to HPGL 
• Update Label froM DDE 
• flag Deleted DDEs IDs 

Warning .beep 
• Create backup chart 
• Use naMed charts 

[ OK l 

Figure 5.5 Preferences Dialog Box 

4. Click on the 'Cancel' button. 

NOTE: There are a number of options in this dialog box that control the 
operation of the chart editor. These are described fully in the Chart Editor User's 
Guide. 

Additional lnformation 

You would use the same approach for identifying connections on any chart type, 
and for couples on structure charts. 

NOTE: You do not strictly have to identify chart objects. If you do not however, 
you will be unable to link them to other charts, text files or data definitions as 
described in Lesson 6. 

For More lnformation 

See "Describing Chart Objects to the Data Dictionary" in the EasyCASE Plus 
Chart Editor User's Guide. 
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LESSON 6 
LINKING CHART OBJECTS VIA THE DATA 
DICTIONARY 

Overview 

This lesson covers: 

• The Data Dictionary Entry (DDE) screen 

• Establishing a link to another chart 

• Using the Explode commands lo access the linked chart 

• Establishing a link to a text file 

• Using the Explode commands to edit the linked lext file 

Before beginning this lesson, you should be familiar with the material covered in 
Lesson 5, in which you simply identified severa! chart objects and brielly accessed 
the corresponding Data Dictionary Entries (DDEs). You did not actually add lo, 
or modify, any of the DDE informalion. 

You will need to use 1he TUTORl.DFD chart you crealed in Lesson 2 (and 
updated in Lesson 5) to complete the exercises in lhis lesson. lf this chart is not 
currently loaded, you will need to load il as described in Lesson 3. 

This lesson should take you approxima1ely 1 hour lo complete. 

In previous lessons you assigned the fundamental attributes for your Data 
Dictionary Entries. The objects you identified can now be used to establish 
relationships: functionallinks to other charts or lext files to create a hierarchy for 
your project files as described in the following seclions. 
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Linking a Chart Object to Another Chart 

In this section, you will use the Data Dictionary Entry for the "Order Processing 
System" Data Process symbol as an example and link it to another chart. 

Access the DDE for the "Order Processing System" data process symbol as 
follows: 

l. 

., 
~. 

3. 

Select the "Order Processing System" data process symbol. lt will be 
highlighted. 

Select the 'ldentify Object' option from the Edit menu, or press ALT+ l. 

The identifier list box is displayed with the identifier "Order Processing 
System" in the text entry box, as shown in Figure 6.1. A highlight bar 
appears over that entry in the list indicating that the identifier is assigned 
to the selected chart object. 

Select Data Process Nane 

ID:,Order Processing Systen 

SOP 1 
SOP 1.1 
SOP 1.2 
SOP 1.3 
SOP 1.4 
SOP 1.5 
SOP 1.6 
SOP 1.7 
SOP 2 
SOP 2.1 

[ OK l [Cancell 

Figure 6. 1 ldentifier List Box with Object /dentifier Highlighted 
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4. Click on 'OK' to retain that identifier. 

5. The DDE screen is displayed for the selected "Order Processing System" 
Data Process symbol, as shown in Figure 6.2 . 

.-----~: Chart Object DDE Screen :1----------, 
DDE Nane: Order Processing Systen 
DDE Type: Data Process 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 
Ohject Explodes Io : 

Type:[i 
Nane:[i 

A 1 ias: 
Misetll: 
Mise tl2: 
Mise tl3: 

=:.::-:i .: .. ::.:. [Definl [Deserl 

Feh-19-1992 
Feb-19-1992 

lfileJ 

[ Ok l [Ouitl 

Figure 6.2 DDE Screen Displayed for Selected Object 

Note that the Explodes To Type and N ame attributes are blank indicating that 
the selected chart object has not (yet) been linked to any other child object. 

In this section, you will create a link from the "Order Processing System" data 
process symbol to the MODIFY.DFD chart (another DFD chart in the 
SAMPLES project directory). 

The link associates a specific chart object with another chart. You then use the 
'Explode Down' function to load the linked chart. 

To specify the name and type of the chart to link to: 

6. Click on the up/down arrow icon next to Object Explodes To- Type field. 
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7. A dialog box, listing the available child chart types, data defmition types, 
and text fLle types is displayed, as shown in Figure 6.3 . 

.....----~~ Chart Object DDE Screen }1-------. 
~ Ch i ld Object Type ~1--~ 

DDE Hane: 
DDE Type: o dfd 
Last Mod: o trg 
Creator: o erd 
Object E o stc 

Type: o std 
Hane: o dsd 

Alias: 
Mise 11: 
Mise 112: 
Mise tl3: 

o dnd 
o elh 

·o lds 

[ Ol< 

o Record 
o Elenent 
o Control Jable 

o txt. 
o doc 
o pps 
o cts 
o epd 

] [Cancell 

b-19-1992 
b-19-1992 

r i leJ 

[Quitl 

Figure 6.3 Dialog Box Listing Available Child Object Types 

8. Click on the 'dfd' button to select it. 

9. Click on the 'OK' option button. 

The text 'dfd' appears immediately to the right of the Object Explodes To
Type field indicating that a link is being established between the selected 
data process symbol on the curren! DFD to another data flow diagram. 

Next you will specify which particular DFD, by name, you want to link to. 

10. Click on the up/down arrow icon next to the Object Explodes To - Name 
field. 

A dialog box appears listing the names of all existing, available data flow 
diagrams so far described in the data dictionary, as shown in Figure 6.4. 
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Select dfd NaMe 

ID=Ilutorial Modif~ Chart 1 
DD 
DD DFD Objects (Gane & Sarson) 
La DFD Objects (SSADMl 992 
e DFD Objects (Yourdon/DeMarco) 992 
o EasyCASE Plus Context DiagraM 

SaMple (EasyCASE Plus) DFD 
SaMple DFD 
SaMple Project Context DiagraM 
SaMple Project Level (J DFD 

M SaMple Project 1 DFD 
M SaMple Project 2 DFD 
M 

[ ] 

[ OK ] [Cancell 

Figure 6.4 Dialog Box Listing Available DFD Charts 

11. Select the 'Tutorial Modify Chart' entry by clicking on it. 

12. Click on 'OK.' 

13. The Data Dictionary Entry screen for the Order Processing System is 
redisplayed as shown in Figure 6.5. N atice the en tries in the Object 
Explodes To- Type and Explodes To- Name fields are those youjust 
chose from the lists. In this example, the DDE screen shows that the data 
process named "Order Processing System" has been linked to another data 
flow diagram ( dfd) named "Tutorial Modify Chart." In the next section you 
will traverse the linkage and access the named 'child' chart. 
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.-------ti Chart Objeet DDE Sereen :1---------. 
DDE HaMe: Order Proeessing SysteM 
DDE Type: Data Proeess 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 
Objeet Explodes To : 

Type :[)lfd 
HaMe:DTutorial Modify Chart 

Alias: 
Mise 11: 
Mise lt2: 
Mise lt3: 

Feb-20-1992 
Feb-19-1992 

·. ;. : ';' ::·-
'• : .. :· ... -: 

[Labell [Definl [Deserl [ Ok l [Quitl 
es 

Figure 6.5 DDE Screen with Linked Chart Entry 

14. Now click on the '[Descr)' button. 

A text entry box pops up, overlaying the DDE screen, as shown in Figure 
6.6. This text entry box allows you to add a short description about the 
selected data process. 
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DDE Nane: 
DDE Type: 
Last Mod: 
Creator: 
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Chart Object DDE Screen 

Order Processing Systen 
Data Process 
John R. Hopkins 
John R. Hopkins 

Feb-20-1992 
Feb-19-1992 

..------ll SHORT DESCRIPTION lt------. 
1 

[Labell [Definl [ Ok l [IJuitl 

Figure 6.6 Short Description Field Text Entry Window 

15. Type the following short description for the Order Processing System 
entry: "Process representing the en tire Order Processing System". 

16. Press the F3 key to complete entry of the short description. 

17. Click on 'OK' to return to the chart. 

The object label is highlighted along with the selected symbol. 

18. Click the right mouse button, or press the ENTER key, to accept the 
curren! position for the symbollabel. 

When you accessed the DDE screen in this example, you defined a link between 
the selected chart object and another chart via the data dictionary ( chart of type 
DFD named 'Tutorial Modify Chart'). You can now 'explode' down from the 
selected data process to the designated chart, as described in the next section. 
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Exploding To and From a Linked Chart 

Once you bave establisbed a link to a chart, it is a simple matter to "explode" 
down to tbe Child chart, automatically loading it into tbe chart window ready to 
be worked on. Todo this, you select the object linked to tbe .:hart, tben use the 
'Down' option from the Explode menu. 

To explode to tbe linked chart from tbe Order Processing System data process: 

l. Select tbe data process symbollabeled "Order Processing System" by 
clicking on it. The symbol is highlighted. 

2. Select the 'Down a Leve!' option from the Explode menu, or press 
crRL +o, or click on the explode down icon located in the lower left corner 
of tbe cbart window. 

Explode Analyze ScheMa 

Iop level Ctrl+I 
Up a level 
Down a level 

Ctrl+U 
Ctrl+D 

Define top level ... 
Update explosions 
Show explosions 

Figure 6. 7 Explode Menu 

If tbe current chart has changed sin ce it was last saved, yo u are pro m pted 
to save tbe chart. Todo so, click on the 'Y es' button. 

3. Tbe linked (child) chart (MODIFY.DFD) is loaded and displayed in the 
cbart window ready to be worked on, as shown in Figure 6.8. 
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· ; OrOtr: · 
,Ptocess"" 

. : SYStecn . 

........... .__ _ ___. 

.,_r_:_ ··········· 

~---------'· ....... . IEl .......... . 
. :~ 

Figure 6.8 Child Chart Displayed in Chart Window 

You can explode back to the parent chart (TUTORI.DFD) by using the 'Up' 
option from the Explode menu, as follows: 

l. Select the 'U p a Leve!' option from the Explode menu, or press CfRL +u, 
or click on the explode up icon located in the lower left corner of the chart 
window. 

2. The parent chart (TUTORI.DFD) is loaded and displayed in the chart 
window. 

Only one chart can be loaded at a time. However, exploding fromfto a chart is a 
quick and easy way to m ove between linked charts. 
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Linking to a New Chart 

Y ou bave just defined a linkage from a existing chart object to another chart via 
the data dictionary. However, the chart that you wish to link to need not already 
exist. The new chart is created as you complete the link by attempting to access it. 

Todo this, you will use the 'Down a Leve!' option from the Explode menu. 

l. Select tbe "Customer" externa! entity symbol by clicking on it. 

2. Select tbe 'Down a Leve!' option from the Explode menu, or press 
CTRL +o, or click on the explode down icon located in the lower left corner 
of the chart window. 

3. Y o u will be asked if yo u wish to save the chart if it has been modified sin ce 
it was last saved. 

Click on 'Y es' to save the chart. 

4. A dialog box is displayed and lists the available child object types ( charts, 
text files, data definitions), as shown in Figure 6.9 . 

• 
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o dfd 

. ~bJec~. Type ~ ......... . 

o Record · · · · · · · · · 
o trg o Ele,.ent 

o Contro 1 To.b le o erd 
o stc .1---.--l.· 

o std o txt 
o dsd o doc 
o d,.d o pps 

r..L r· :,;:: :::: '"~" m· 
.. . .... L-. ________ __J 

~:: 

Figure 6.9 Available Child Object Types 

5. Click on the 'erd' entry to choose an Entity Relationship Oiagram as the 
child chart type you want to link to. 

6. Click on 'OK.' 

7. A dialog box is displayed containing the identifiers forERO chart types in 
the curren! project. The text entry box at the top of the dialog box is empty 
and ready for text entry. 

8. Type "Customer Operations" in the text entry box, as shown in Figure 6.10. 
This is the name of the ERO to link to. 
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........... L...--

ID: jeustllfter Operatlonsl 

Data DictiDMf\1 Entries 
Data Flow Dlogran 
ERO Objects 
ERD S!Jftbols 
Sa11p le (Bachllon) ERD 
Sa11ple Olartln) Datahase 
Sa11p le Chen ERD 
Sa11ple Elr~asrl & Hovathe ERD 
Sallple SOP ERD (Bachnanl 
Sa11ple SOP ERD (Chenl 
Sar~ple SOP ERD (Martinl · 
Sallp le Schl aer41e llar ERD 

[ OK 1 [Cancell 

.:.:.:. ·:·. ~": 

Figure 6.10 Child ERO ldentifier in Text Entry Box 

9. Click on 'OK.' 

10. A dialog box then pops up and you are prompted to verify that you want to 
create the specified child chart entry in the data dictionary, as shown in 
Figure 6.11. 
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[ Yes J 

·a·· . . . . 
. :P.-.ai : : 
. . . . . . 
' . . . . . . . .. '----'·····""" 

Figure 6. 11 Prompt to Create Child Chart Entry in the Data Dictionary 

11. Click on 'Y es.' 

12. You are prompted to enter the lilename to use for the ERO chart lile, as 
shown in Figure 6.12. 

13. Type "CUSTOPS.ERO" in the text entry box, to be used as the filename 
for the child ERO chart. 
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' ..... . .. r ...• ·ni·~~. 

Ch ild r ilena"e: ILc_us_r_o_PS_._ER_DI _________ ~ 

[ 'les l [ No ] [Cancell 

B. . tJ . . . . .., ........ 
. : . . . . . . . : ... EJ ... : ............... . 

. . ~ .. 

Figure 6. 12 Text Entry Box for ERD Chart Fi/ename Entry 

14. Click on 'Y es.' 

15. You are prompted to verify that you want to create the new ERO chart, as 
shown in Figure 6.13. 
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¡-----; ·········· 

Ff ¡_··--·-JI ~r~ta ~ C~r~ 7:1~~~~~..,·-······· ··········· 
:. : .. :IL--_[ Yes l _ ____.l.: .. 

. 1 .. 
..¡¡ .. 

. " . " " " . .___ _ __. m 
. . . 

. . 

. . 

~ .. r=:-l " " . " ...... . 
.d \ .. : ·.: ...... " " 

Figure 6.13 Prompt to Confirm Creation of New Chart 

16. Click on 'Y es.' 

17. The new CUSTOPS.ERD chart is then created, and a blank chart is 
displayed in the chart window, ready for you to work on, as shown in 
Figure 6.14. 
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. r:.t• . 

Figure 6. 14 New ERD Chart 

18. Select the 'Up a Leve!' option from the Explode menu, or press CfRL+ u, 
or click on the explode up icon, to move back to the parent chart 
(TUTORl.DFD). 

19. You are asked to conf~rm ifyou want to save the new chart. Click on the 
'No' option or press the ESC key. 

You have just established a link between the Customer externa! entity on the 
original diagram to an ERO. 
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Establishing a Link to a Text File 

A text file can also be specified as a child object. This allows you to explode a 
chart object to a note file, primitive process specification, or control specification 
in textual form. A text file is an ASCII file with extension .TXT, .DOC, .PPS, or 
.CTS. When you explode from a chart object to a text file, a text editor is also 
loa de d. 

This approach will also enable you to access an externa! documentation too) 
rather than a text editor, such as a flow charter, and pass the name of a file to it. 
This is described in more detail in Chapter 9 of the Chart Editor User's Guide. 

Befare yo u can explode down to a text file yo u m ust first select the default text 
editor as foUows: 

l. Choose the "Set Default Editor" option from the Options menu. 

2. If a text editor has airead y been chosen, its name will be displayed on the 
prompt line at the bottom of the screen, in the form of a full pathname 
and fllename. 

A text entry box will appear on screen, as shown in Figure 6.21, and 
contains the specification ( drive, pathname and filename) of the currently 
chosen text editor, if any. Initially it will be blank. 

3. Assuming that you intend, for this example, to use the default text editor 
EDLIN.EXE, supplied with your version of MS-DOS, enter the text: 

C:\DOS\EDLIN.EXE 

into the text entry box and then click on the 'Y es' option button. 

Now, whenever you explode down toa text lile, this (primitive) text editor 
will be used. 
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TeKt Editor: IL·---------------.J 
....... : .! [ Yes l [ Ho ] CCancell 

.......... ,--~--; 

Figure 6. 15 Enter Path to Text File Editor Dia/og Box 

Alternatively, you can specify your own particular favorite text editor such 
as Brief, the DOS 5.0 editor, etc., or even the name of your word 
processor. For fu~ther details on how todo this, refer to Chapter 9 of the 
Chart Editor's User's Guide. 

Text Editor: IC:\dos,edlin.exel 

[ Ves l [ Ho ] [Cancell 

Figure 6. 16 Enter the Path to the Text Editor Executable File 
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To link a chart object lo a lext me, use lhe Explodes To attribule fields in lhe 
data dictionary enlry screen of lhe objecl jusi as you set up a link lo a charl me 
previously. 

Load the TUTORl charl, if il is nol already loaded. 

To sel up a link lo a lext file: 

l. Select 1he externa! enlily symbollabeled ''Managemenl". 

2. Choose lhe 'ldenlify Object' option from 1he Edit menu. You will be 
prompled for an ID for lhe objecl, which will be 'Managemenl' by default. 
Click on the 'OK' oplion lo use lhal iden1ifier, as shown in Figure 6.17. 

~--1~ Se lect Externdl Ent i ty Hane l1----. 

ID: IManagenent~ 

Brake 
Clutch 
Credit Card Conpany 
Custoner 
Drive Shaft 
Driver 
Engine 
Fuel Tank 
Gearbox 
Inventory on Hand 
Payroll 

·. Supplier 

[ OK ] [Cancel] 

Figure 6.17 Entered Chart Object N ame in the Text Entry Box 
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3. Tbe DDE screen will appear. The Object Explodes To (Type, Name) 
fields wiU be blank. 

4. Select the Object Explodes To- Type attribute field by clicking on tlie 
up/down arrow icon, as shown in Figure 6.18 . 

.--------1: Chart Objeet DDE Sereen :1---------. 
DDE HaMe : ManageMent 
DDE lype: External Entity 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 
Objeet Explodes lo : 

lype :~ 
HaMe :[f 

Alias: 
Mise 11: 
Mise 12: 
Mise 13: 

[DefinJ [Descr] 

Feb-20-1992 
Feb-20-1992 

rr i le1 

[ Ok J [IJuitJ 

Figure 6.18 Cursor Poised over the Explodes To- Type Field 

A dialog box wiU appear containing the list of valid child types, as shown in 
Figure 6.3. 

5. Choose the 'txt' entry by clicking on it, then choose 'O K.' The text 'txt' wiU 
appear immediately to the right of the Explodes To- Type field name. 

6. Select the Explodes To- Name attribute lield by clicking on the up/down 
arrow icon next to this lield. 

7. A dialog box will appear containing a list of available text fUe entries as 
shown in Figure 6.19. Type in "Management" as the identifier for the text 
fUe, then choose 'OK.' 
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.-------t: Chart Objeet DDE Sereen :1------, 
DDE HaMe: Managenent 
DDE T~pe: Externa! Entit~ 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 
Object Explodes To : 

T~pe:Dt.xt 
NaMe:DManagenent 

Alias: 
Mise tn: 
Mise 12: 
Mise 13: 

[Labell [Definl [Deserl 

Feb-2El-1992 
Feb-20-1992 

[ Ok l [Quitl 

Figure 6. 19 Selected Child Object Type and Name in DDE Screen 

8. The text file name will appear immediately to the right of the Explodes To 
- Name field. 

9. Select the (OK) button in the data dictionary screen to exit. 

10. Press ENI"ER to place the label for the Management external entity. 

Yo u ha ve just finished describing the link to the child chart object (a named text 
fUe) in the data dictionary .!!Q! the text file na me itself. 

To provide a fUename for the text file to be entered in the data dictionary: 

l. Tbe chart object should still be selected. lf it is not, re-select it by dicking 
onit. 

2. Select the 'Down a level' command from the Explode menu. 

3. A dialog box will appear prompting you to save the chart. If so, choose the 
'Y es' option. 
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4. A dialog box wiU appear prompting you to conflfm creation of the data 
dictionary entry for the text file as shown in Figure 6.20. Choose the 'Y es' 
option . 

.------1: Crea te new chi Id object DDE 7 :1-----. 
Object lype: txt 
ldentifier : ManageMent 

[ Yes l 

Figure 6.20 Prompt to Crea te DDE for Text File 

5. A dialog box wiU appear prompting you to conflfm creation of the new text 
fUe. Choose the 'Y es' option. 

6. A dialog box will appear prompting you for the name of the text file. En ter 
"Mgmt.txt" as shown in Figure 6.21, then choose the 'Y es' option. 

Enter Chart FilenaMe: IMgAt.txtl 

[ ~es l ~ [ Ho l [Cancell 

Figure 6.21 Enter Text Filename 

7. Tbe chosen editor will be run and you will be able to access the text file 
named MGMT.TXT. 

8. To return to the chart editor, ex.it or quit from your text editor. 
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Establishing a Link to a Record 

Wben a chart object is to be associated with a data structure defmition, you link it 
to a Record definition that allows you to define a data structure. 

When you establish a link to a record, you need to establish a data dictionary 
entry for the Record, just as yo u did for chart objects and text files. The 
components of a record are the specific data fields and are represented by 
elements. 

In this section, yo u will load the TUTOR l.D FD chart and establish a link to a 
record used for information about Payroll. The components of this record define 
data such as the Employee Number, Name, Position, and so on. 

To establish a link to a Record: 

l. Load the TUTORl.DFD chart. 

2. Select the externa! entity symbollabeled ""Payroll"" by clicking on it. 

3. Select the 'Down a Leve!' option from the Explode menu, or press 
crRL +o, or click on the explode down icon. 

4. A dialog box pops up listing available child object types as shown in Figure 
6.9. 

5. Select the 'Record' option by clicking on it. 

6. Click on 'OK.' 

7. A dialog box is displayed listing the identifiers for Record object types in 
the current project data dictionary. 

8. Enter "Payroll" as the Record identifier in the text entry box at the top of 
the dialog box, as shown in Figure 6.22. 
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··.: .. S1~~ 

Coftponent 
Coftponents Use4 
CustDNir 
Product 
Product l.oc4tlon 
Sales RepresentatlYB 
lransactlon 
lransactlon Data 11 

[ OK l 

P,epcit : 

[C&ncell 

····~ .. ······ 

Figure 6.22 Entered Linked Record Name 

9. Click on 'OK.' 

So far you have established a link from the chart object to a named Record 
data dictionary entry. Next you will create the DDE and then access it. 

10. A dialog box pops up prompting for confirmation to create the Payroll 
Record data dictionary entry, as shown in Figure 6.23 . 

.------4! Create new child object DDE 7 !1------. 
Object Type: Record 
ldentifier : Payroll 

[ \les l 

Figure 6.23 Prompt to Crea te Record DDE 
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11. Click on 'Y es.' 

12. Tbe Record definition data entry screen is tben displayed, as sbown in 
Figure 6.24. 

Record DDE Screen 
Object Hane: Payroll 
Object Iype: Record 
Last Mod: John R. Hopkins 

Creator: John R. Hopkins 
Defn: 
Iable Hane: lB 
1 ndex Hane : 
M BHF Conponent nanes: 

1 
2 .+ 
3 + 

4 + 

S + 
6 + 
7 + 

8 + 

[List] [[Mplode] [Descr] 

Feb-20-1992 
Feb-20-1992 

Type(REKFll 
BHF 

1 E 
1 E 
1 E 
1 E 
1 E 
1 E 
1 E 
1 E 

1 OccsJ 
[ Ok ] [QuitJ 

Figure 6.24 New Record Definition Screen 

You bave just defined a link between a chart object and a Record and bave 
created a new record definition whicb is ready to be worked on. Take a few 
minutes to understand tbe fields associated with the Record definition data entry 
screen. Tbe Object Name, Object Type, Last Mod, Creator, Defn, Table Name, 
and lndex N ame fields should be familiar to you from the chart object data 
dictionary entry screen. 

Tbe remaining fields are used to define the record components. A record can 
contain up to 128 such components, each of which is defined in detail by linking it 
in turn to an Element entry in the data dictionary. 
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Backus-Naur Operators 

Tbe Backus-Naur operator fields are the first and third fields (on either side of 
the componen! field). You can use these operators to specify how the record 
components are related. Allowable entries are;+(*{[ (left side) and 1]} 0 )+ 
(right side). 

Component 

This field defl.nes a particular record component. The componen! name ca.n be up 
to 32 characters in length. This is the name of an element defined in the data 
dictionary . 

. #Occs 

Tbe # Occs (Number of Occurrences) field determines how many times a 
particular componen! is to occur in the record. The default number of 
occurrences for all components is one. 

Type 

The Type field specifies the type of componen!. The available componen! types 
are indicated by "(REKF)". These letters identify the following componen! types: 

a Record 

a Element 

a Key Field (an Element) 

a Foreign Key Field (an Element) 

The default type for all components is (E)lement. 

The numbers down the left side of the Record Definition screen show that you 
can specify up to 128 components for a Record. 

To enter the record components: 

l. Click on the first position in the Componen! field, or press the ENTI:R key. 
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2. Type "Employee Number". This number will uniquely identify each Sales 
Representative. 

3. Click on the Type field, or press the ENTER key three times. 

4. Type "K" to replace the default entry of "E." The Employee Number 
component will be a key field. 

5. Press ENTER lo move to the next record component field (row #2). 

-
6. Use Figure 6.25 to specify_ the remaining Record component definitions. 

Record DDE Screen 
Object Hane: Pa~roll 
Object Iype: Record 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 

Defn: 
Table Hane: 
lndex Hane: 
1 BHF Conponent nanes: 

1 Enplo~ee Hunber 
2 + Enployee Hane 
3 + Enplo~ee Positionl 
4 + 

S + 

6 + 

7 + 

8 + 

[List] [Explode] [Descrl 

Feb-2El-1992 
Feb-2El-1992 

TypeCREKF)l 
BHF 

1 K 
1 E 
1 E 
1 E 
1 E 
1 E 
1 E 
1 E 

1 OccsJ 
[ Ok ] [QuitJ 

Figure 6.25 Completed Record Definition 

At the bottom of the Record DDE screen are selection boxes to save or cancel 
the definition, as well as additional functions. The 'OK' and 'Quit' selections 
should airead y b~ familiar to you. The remaining functions are described below: 
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Ust 

The List button accesses a list of any record components already defmed in the 
data dictionary. Click on the [List) button to display the list as shown in Figure 
6.26. 

Obj 
Obj 
Las 

Cr 
Def 
Tab 
lnd 
1 B 

1 
2 
3 
4 
5 
6 
7 
B 

:t.'. 

Descr 

Select EleMent NaMe 

ID:,EMployee Position 

Extended Price 
First NaMe 
Freight Charge 
HoMe Phone 
Last NaMe 
List Price 
Location 
Modal NuMber 
Net AMount 
Phone NuMber 

[ OK J [Cancel] 

Figure 6.26 Display Element DDEs Using the [List] Option 

1 
92 
92 

)1 

] 

K 
E 
E 
E 
E 
E 
E 
E 

The Descr button pops up a text entry box for you to entera short description (up 
to 254 characters) of the purpose of the record. ·' : 

l. Click on the (Descr) button to display the text entry. box. 
- '. ~ 

2. Enter "This record contains the employee number, name, and position." in 
the record description field as shown in Figure 6.27. 
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3. Press the F3 key to exit the description field. 

Record DDE Screen 
Object Hane: Payroll 
Object Iype: Record 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 

Defn: 
Iable Hane: 

feb-20-1992 
· feb-20-1992 

In..-----1: SHORI DESCRIPIIOH :.._----,)
1 D Ihis record contains the enployee nunber 

1 , nane, and position.B E 
2 [ 
3 [ 
4 [ 
5 [ 
6 [ 
7 [ 
BD + 1 [ 

D OccsJ 
[Listl [[xplodel .:. :.::.:::.:.: [ Ok l [Quitl 

Figure 6.27 Text Entry Box for the Record Short Description 

Explode 
' -

The Explode button enables you to create a data dictionary entry for a record 
componeot, koowo asan Element, aod access the data dictionary entry screen for 
that Elemeot. 

To defme the record components as Elements in the data dictionary: 

l. Click oo the "Employee Number· component. 

2. Click on the [Explode] button. 

3. You may be prÓ~pted to verify that yo u want to crea te a data dictionary 
entry for the Element type component named Employee Number, as 
showo in Figure 6:28. 
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·: ' ~- ··, ! :' 

..-----4: Create Hew Eler~ent DDE '? :1-------. 
Object Type: Elenent 
ldentifier : Er~ployee Hunber 

[ No l 

Figure 6.28 Prompt to Confirm DDE Creation for Chosen Element 

4. If'so, click on 'Y es.' 

5. The data dictionary entry screen for the Element named "Employee 
Number" is displayed as shown in Figure 6.29 . 

.--------1~ E lenent DDE Screen ~1--. ------. 

DDE Nane: Enployee Nunber 
DDE Type: Elenent 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 

· Length: lB 
Type:[J 

Constrnt:[J 
Nane: EMPLOVEE HUMBER 

Miscftl: .... 
Mise ft2: 

Fornat: 

[Definl [Descrl 

-::-r., 

.. ' ! 

Feb-29-1992 
Feb-29-1992 

[ Ok 1' [Quitl 

Figure 6.29 Data Dictionary Entry Screen for an Element 

6. Click on the 'Length' field and e~ter ;~ ... 

This means that the Employee Nunii)Jr can be up to 4 characters in 
length. 
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7. Click on tbe 'Type' field and·type "Numeric" .. 

Tbis means that tbe data type for the Employee Number is a number in 
tbe range of Oto 9999. 

8. Click on the 'Constraint' field and type "NOT NULL." 

9. Click on the 'Format' field and type "9999". 

10. 

Tbis is tbe format in which the data would be ente red ( digits only). 

Click on the Definition field and type "A number uniquely identifying an 
employee". ~hen press tbe F3 key. 

.'., 
:,: .1 

Tbis defmes the purpose of the Employee Number elemeqt. 

- . - -·--
11. Click on tbe 'N ame' field and type "EMP _NUM". This assigns a field name 

for tbe Employee Number field. 

r--------I.Record DDE Screen }1--
1
------.-.1 

EleMent DDE Screen ,~------, 

DDE HáMe: EMployee HuMber 
DDE Type: EleMent 
Last Mod: John R. Hopkins 
Creator: John R. Hopkins 

Length: 4 
Type:l)fuMeric 

Constrnt:l)fOT HULL 
HaMe: EMP HUM 

Mise 111: l1 
Mise 112: 

ForMat: 

[DefiT1l [Descrl 
'o 

.: ' .~ 

Feb-20-1992 
Feb-20-:-1992 

[ Ok l [Quitl 

:·~· .. ¡; 

Figure 6.30 Complet~ Employee Number Element Definition 
' . i 1 _¡ ' • ' 

. -- ,• J 

1 
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11. Click on 'OK.' 

Tbe data dictionary entry for'the Empldyee Number element is saved, and 
the Record defmition screen is redisphÍyed. ·'· · 

12. Click on 'OK' to return to the chart editor. 
:í:.: _: L .'..; 

' - • ·.J. • • - :...· ,-~- / ; t 

Wben you have finished, you can then explode down to the coínpleted Payroll 
record from the Payroll symbol. 

To éxplode down to the Payroll re¡;o_r.d from the Payroll object: 

l. ''Thé PayrÓII'~ymbol should-~till be selected. If not-;·select itby clicking on it. 
Select the 'Down a Leve)' option from the Explode:menu,•or press '·' 
CI"RL+D, or click on the explode down icon. 

2. Y ou are prompted to save the current chart (if it has changed since tbe last 
save ). lf so, Click on 'Y es.'. · '· · .:·' .. · 

,, 
'· 

3. Tbe Payroll Record data entr'y screen is displayed. This willlook tbe same 
as it did when you entered it as shown in Fig. 6.25. 

1'! ~ .:;·, ( ·~r 

4. Click on 'Quit' or press ESC to remove the record definition screen and 
return to the chart editor. 

Alternatives 

Explode menu 

Top Level 

Select tbe Top Leve) command to explode up to the highest leve) chart in a linked 
set of cbarts (orto the chart assigned as the top level chart, using the Defme Top 
Leve) command). 

For example, if yo u linked an object on the MODIFY cbart to the ECPCONTX · 
cbart, you could select tbe Top Leve) command to explode up to tbe TUTORl 
cbart. 

t¡.]i·;,·_ ,:;_!: ·-· !' 
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Define Top Level 

You can .. defme any o f. ~e c)lart~ i!l ·a ,linked set of charts to be the top leve! chart. 
This will then be the chart yo u expl_ode up tq when youselect, the Top Leve! 
command. · · 

For example, you could define.the MODIFY,chart,to be the top leveréhart, 
rather than the TUTOR! chart (the default, highestlevel chart). 

Show Explosions ·_-, 

¡ 

• 

Select the Show Explosions command to indicate the object(s) on the TUTORl 
chart for which~you hav,e defmed a link. This helps you to remember which 
objects are linked. The objects that have a déflned link will he' highliglited . 

. '.'l 

Update Explosions 
• I,J. 

The Update Explosions command updates t!Íe display of linked objects when you 
have the Show Explosions option turned on. This is useful when you define new 
linked objects and want to ~ha ve them shciwn ~s such. 

-. ' 

For More lnformation 
, -.. _.::, ... O 

See "Chart Linking and Decomposition'' in the EasyCASE Plus Chart Editor 
User's Guide. 

_, J ~ 

·.·. 

-. 

/ ,IJ . ·.• 
. . 
. . :·! 1 • ' ' '.,..; ¡:.:. ;·' '"' ) ;_ 

.'.! ~~::~: •• :

• j, .~::::·:.:~~-y· 

EasyCASE Plus Version 3.1 Beginner's Tutorial 
· .; ·:5-''.Jv;.~~::J 

. ' 



Paga 156 

Coogratulations! You have just finished the EasyCASE Plus Beginner's Tutorial. 
You have used the basic functions .of the EasyCASE Pfus chart editor program to 
create and .modify charts, describe chart objects to the data dictionary, and link 
chart objects to child charts, records and text files. EasyCASE I'lus has many 
more functions than could be covered in this begiíuléó tutorial. For more 

: information about the Chart Editor; ·please refer to the Chart Editor U ser's 
Gu.ide.. · -~- _ 

If yo u warit to use the product to ·assist you in the design of relational database · 
systems, using entity relationship diagrams (ERDsrand the data dictionary, it is · . 
re~ommended that you use the opÚonal Scherria Generator product to produce .: 
the resulting schemas. How to do this; in the form of a moré advanced tutorial, is ·. 
provided in the Schema Generator User's Guid_e an9 _Tutorial. ó 

- . : .. · 

Tbe data dictionjl.ry stores the desi:riptions you gave to the charts, chart objects, 
records, etc. You can manipulat~Jhis data outside·óf th'e chart editor by using 
the supplied Data Dictionary and Reports Manager (ODRM). utility program. 
Yo u .can also generate specific charf and data dictionary reports using the 
DDRM .. The DDRM can be accessed via the ch·art editor's Utility menu, or run 
the as a stand·alone application. For more· information about the Data 
Dictionary and Reports Manager, please refer to the Data Dictionary and 
Reports Manager (DDRM) User's Guide. 

You can use the optional Analysis Manager program to check and verify your 
charts and data dictionary. This utility program allows you to check your diagrams 
against a set of methodology, usage, and layout rules. 'It also allows for leve! 
balancing linked diagrams, checking record and element definitions, and even 
provides a "where used" analysis capability. For more information, please refer to 
the Analysis Manager U ser Reference. 

To effectively use EasyCASE Plus, you should first be familiar with the software 
design methodologies supported by this ·cASE-too!. EasyCASE Plus does not try 
to teach you about methodologies. However, it does supply the means whereby 
you c1u(iipplem.ent the most common, widely documented, well established 
methodoJogies. For more information abouúhe methodo\ogies, diagram types 
and symbólogi~s.sup~orted by EasyCASE Plus,pleasecrefercto the provided 
Methodology Guide; which also containsa bibliography of popular software 
design methodologybooks. · 
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